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Foreword

S) you want to start a podcast? Well, good news! Everyone that has ever
started a podcast has found fame, fortune, and success. Hollywood calls
with infinite interest, ad nauseam, at all the new and original projects that are
out there. Celebrities fall all over themselves to make appearances on podcasts,
just waiting for the beckon call of the shows’ hosts. Awards are awarded,
parties are partied, and recognition and praise are rained down on you daily.

Really? No, it isn’t really like that, but we can dream can’t we?

I'll be the first to tell you that it isn’t all cotton candy clouds and graham
cracker streets, but what you can expect is, if you stick with it and make
something that is interesting or entertaining, people will come. It takes time
to build, but a podcast can be much more than just a cold or stoic mp3 and
an RSS feed sitting on a server. They are seeds, seeds for a community.

Podcasting introduced me to individuals, cultures, and personal experiences
from all over the world as a podcaster and as a listener. People that I
wouldn’t have otherwise met, from online friends to others I have met in per-
son and consider true friends (starting with the guys that wrote this book),
all wound up connecting with me through this exciting medium.

Also expect your venture into podcasting to be a personal learning experi-
ence, not just a social one. I have found that by being yourself, being honest,
and opening up to your listeners that these complete strangers will relate to
you and become engaged. Those listeners will (generously) give you feed-
back. When you do start to get feedback from listeners, they will routinely
present you with a new perspective on subjects you talk about, confirm
things you already know, and even take you into directions you never
considered.

There is a lot that you will not expect in your new podcasting adventure and
that is where this book comes in. Podcasting For Dummies is written by three
lovable and knowledgeable dummies who have been down that long and
winding road. They will help you side step and overcome hurdles that will
ultimately enable you to have fun podcasting . . . and that is what it’s all
about. That, you can expect.

* Personal Note: As is evident in the pages that follow, I have taught Tee, Evo,
and Chuck a lot about podcasting, and it shows. Wax on, Wax off.

by Kreg Steppe
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Introduction

M aybe you’ve been casually surfing the Web or perusing your newspaper

when the word podcasting has popped up. Steadily, like a building wave
that would make champion surfers salivate with delight, the term has popped up
again and again — and your curiosity continues to pique as the word podcasting
echoes in your ears and remains in the back of your mind as a riddle wrapped in
an enigma, super-sized with a side of fries and a diet soda to go.

Podcasting For Dummies, 2nd Edition, is the answer to that super-sized riddle-
enigma combo, and it even comes complete with a special prize. Beginning
with the question at the forefront of your mind — What is podcasting? — this
book takes you through the fastest-growing technological movement on the
Internet. By the time you reach the end of this book, the basics will be in
place to get you, your voice, and your message heard around the world —
and you can even have a bit of fun along the way.

About This Book

“So what are you up to, Tee?”

“I'm currently making a podcast of my first novel, a swashbuckling tale that
carries our heroes . . .”

“Uh . .. what is a podcast?”

Asked by best friends and lifetime technologists, this question continues

to crop up over and over again, immediately after the word podcast lands in a
casual conversation. Just the word podcasting carries an air of geekiness about

it — and behold, the habitual technophobes suddenly clasp their hands to their
ears and run away screaming in horror lest they confront yet another technical
matter. Too bad. If they only knew how technical it really isn’t. When you peel
back the covers and fancy-schmancy tech-talk, it’s a pretty simple process to
make your own podcast. You just need someone pointing the way and illumi-
nating your path.

This is why we’re here: to be that candle in the dark, helping you navigate a
world where anyone can do anything, provided they have the tools, the drive,
and the passion. You don’t need to be a techno-wizard or a super-geek — you
need no wad of tape holding your glasses together, and your shirt tail need
not stick out from your fly. Anyone can do what we show you in this book.
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Anyone can take a thought or an opinion, make an audio file expressing that
opinion, and distribute this idea worldwide. Anyone can capture the attention
of a few hundred — or a few thousand — people around the world through
MP3 players hiding in computers, strapped around biceps, jouncing in pockets,
or hooked up to car stereos.

Anyone can podcast.

Podcasting, from recording to online hosting, can be done on a variety of budgets,
ranging from frugal to Fortune 500. You can podcast about literally anything —
including podcasting for its own sake. As blogging gave the anonymous, the
famous, the almost-famous, and the used-to-be famous a voice in politics,
religion, and everyday life, podcasting adds volume and tone to that voice.

Podcasting is many things to many people — but at its most basic, it’s a
surprisingly simple and powerful technology. What it means boils down to

a single person: you. Some liken it to radio (at least online radio), but it can
do — and be — so much more. Podcasting is a new method of communication,
transmitting your voice and its message around the world without using public
airwaves, connecting the Global Village in ways that the creators of the Internet,
RSS, and MP3 compression would probably never have dreamed. It is the
unique and the hard-to-find content that can’t find a place on commercial,
college, or public access radio.

You're about to embark on an exciting adventure into undiscovered territory,
and here you will find out that podcasting is all these things and so much more.

How to Use This Book

Podcasting For Dummies, 2nd Edition, should be these things to all who pick up
and read it (whether straight through or by jumping around in the chapters):
v A user-friendly guide in how to listen, produce, and distribute podcasts

v A terrific reference for choosing the right hardware and software to put
together a sharp-sounding podcast

v The starting point for the person who knows nothing about audio edit-
ing, recording, creating RSS feeds, hosting blogs, or how to turn a com-
puter into a recording studio

+* A handy go-to “think tank” for any beginning podcaster who’s hungry for
new ideas on what goes into a good podcast and fresh points of view

v A really fun read

There will be plenty of answers in these pages, and if you find our answers too
elementary, we give you plenty of points of reference to research. We don’t claim
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to have all the solutions, quick fixes, and resolutions to all possible podcasting
queries, but we do present to you the basic building blocks and first steps for
beginning a podcast. As with any For Dummies book, our responsibility is to
give you the foundation on which to build. That’s what we’ve done our level
best to accomplish: Bestow upon you the enchanted stuff that makes a pod-
cast happen.

This book was written as a linear path from the conceptualization stages to
the final publication of your work. However, not everyone needs to read the
book from page one. If you've already gotten your feet wet with the various
aspects of podcasting, jump around from section to section and read the
parts that you need. We provide plenty of guides back to other relevant chap-
ters for when the going gets murky.

Conventions Used in This Book

When you go through this book, you’re going to see a few 38 symbols, the
occasional =, and even a few things typed in a completely different
style. There’s a method to this madness, and those methods are conven-
tions found throughout this book.

When we refer to keyboard shortcuts for Macintosh or Windows, we desig-
nate them with (Mac) or (Windows). For Mac shortcuts, we use the funky
cloverleaf symbol, (found on the Command key) and the corresponding
letter. For Windows shortcuts, we use the abbreviation for the Control key
(Ctr]) and the corresponding letter. So the shortcut for Select All looks like
this: 38+A (Mac) / Ctrl+A (Windows).

If keyboard shortcuts aren’t your thing and you want to know where the com-
mands reside on menus, we use a command arrow (=) to help guide you through
menus and submenus. So, the command for Select All in the application’s menu is
Edit>Select All. You first select the Edit menu and the Select All.

When we offer URLs (Web addresses) of various podcasts, resources, and
audio equipment vendors, or when we have you creating RSS feeds for pod-
catchers such as iTunes, iPodder, or iPodderX, we use this particular
typeface.

Bold Assumptions

We assume that you have a computer, a lot of curiosity, and a desire to pod-
cast. We could care less about whether you’re using a Mac, a PC, Linux, Unix,



4

Podcasting For Dummies, 2nd Edition

or two Dixie cups connected with string. (Okay, maybe the two Dixie cups
connected with string would be a challenge; a computer is essential.) In
podcasting, the operating system just makes the computer go. We'’re here to
provide you tools for creating a podcast, regardless of what OS you’re running.

If you know nothing about audio production, this book can also serve as a
fine primer in how to record, edit, and produce audio on your computer, as
well as accessorize your computer with mixing boards, professional-grade
microphones, and audio-engineering software that will give you a basic look at
this creative field. You can hang on to this book as a handy reference, geared
for audio in podcasting. Again, our book is a starting point, and (ahem) a fine
starting point at that.

With everything that goes into podcasting, there are some things this book is
not now, nor will ever be, about. Here’s the short list:

v We're not out to make you into an ibergeek in RSS or XML (but we give
you all you need to make things work — even get you iTunes-ready).

1 We figure that if you get hold of Audacity, GarageBand, Audio Hijack Pro,
Soundtrack, or Audition, you can take it from there (but we give you
overviews of those programs and a few basic editing examples).

v We're not out to teach you how to use an MP3 player such as an iPod, an
iRiver, or a Zen Micro product.

For that matter, to dispel one of the biggest misconceptions of podcasting,
you will not be told to run out and get an iPod. You do not need an iPod to
podcast — or to listen to podcasts for that matter.

If you are looking for a terrific start to the podcasting experience, then — in
the words of the last knight guarding the Holy Grail in Indiana Jones and the
Last Crusade — “You have chosen wisely.”

How This Book Is Organized

The following sections give you a quick overview of what this book has to
offer. And yeah, we’re going to keep the overview brief because we figure
you'’re anxious to get started. But the fact that you're reading this passage
also tells us you don’t want to miss a detail, so here’s a quick bird’s-eye view
of what we do in Podcasting For Dummies.
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Part I: Podcasting on a
Worldwide Frequency

Part I goes into the bare-bones basics of how a podcast happens, how to get
podcasts from the Internet to your computer, and how to host a podcast
yourself — ending up with a few places online that offer podcast feeds you
can visit to sample the experience and (later on) to let the world know “Hey,
I've got a podcast, too!”

Part I also helps you pick out the best hardware and software you need to
start podcasting.

Part II: The Hills Are Alive with
the Sound of Podcasting

Consider this part of the book Inside the Actor’s Studio — part Tech TV, and
part WKRP (with your host, Dr. Johnny Fever . . . boooouuugaaar!!!). This is
where we offer some techniques the pros use in broadcasting. Podcasting
may be the grass-roots movement of homespun telecommunications, but
that doesn’t mean it has to sound that way (unless, of course, you want it to
sound that way). From preshow prep to setting your volume levels to the
basics of audio editing, this is the part that polishes your podcast.

Part I1I: So You've Got This Great
Recording of Vour Voice. Now What?

The audio file you've just created is now silently staring at you from your
monitor (unless you're listening to it on your computer’s music player, in
which case it’s just defiantly talking back at you!), and you haven’t a clue what
your next step is. We cover the last-minute details and then walk you through
the process of getting your podcast online, finding the right Web-hosting pack-
ages for podcasts, and getting a good working handle on the RSS and XML used
in podcast feeds.

5
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Part JU: Start Spreadin’ the
News about Vour Podcast

“I wanna beeee a part of it. Podcasting, babeeeee . . .
If I can get on Daily Source,
Then I'll have no remorse for pod—cast—in . . . podcasting . . .”

Sorry. Sinatra moment.

Anyway, you have the podcast recorded, edited, and online, but now you
need to let people know you have this great podcast just waiting for them —
and that’s what we explore in Part I[V. With the power of publicity — from
free-of-charge word-of-mouth (arguably the most effective) to investment in
Google AdWords (arguably the most coverage for your dollar), you have a
wide array of options to choose from when you’re ready to announce your
presence to the podcasting community.

Part U: Pod-sibilities to
Consider for Vour Show

The question of why one should podcast is as important as how to podcast.
We cover some basic rationales that many folks have for sitting behind a
microphone, pouring heart, soul, and pocket change into their craft each and
every day, week, or month. These questions have no right or wrong answers,
but our hope is that this part offers pointers to convey you safely through
the thought process behind podcasting.

Part Ul: The Part of Tens

Perhaps the toughest chapters to write were these: the For Dummies trademark
Part of Tens chapters. So don’t skip them because we’ll be liber-miffed if you fail
to appreciate how hard we busted our humps to get these chapters done!

Right — so what do we give you in our Part of Tens? We give you a list of the
ten people who made (and/or currently make) podcasting the hottest com-
munications trend to come down the pike since the invention of the Internet.
We also offer suggestions for the beginning podcaster — such as what kind of
podcasts should be on your MP3 player, just to give you an idea of what’s out
there, how they sound, and how you can benefit from them. Finally, our Part
of Tens closes with the great debate: Podcasting versus Radio. Is radio dead?
[s podcasting just another fad? Read . . . and then you decide.
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About the Companion Podcast

In some cases, a For Dummies book comes with a companion Web site hosted
by the good people at www . dummies . com. This book comes with a companion
podcast. Go to your browser and surf to www . dummies . com/go/podcasting
£d and follow the instructions to get free weekly audio commentary from Tee
Morris and Chuck Tomasi about concepts in this book explored in greater detail,
from the difference between good and bad edits, when too much reverb is too
much, and the variety of methods you can use to record a podcast.

Icons Used in This Book

3

So you're trekking through the book, making some real progress with devel-
oping your podcast, when suddenly these little icons leap out, grab you by
the throat, and wrestle you to the ground. (Who would have thought pod-
casting was so action-packed, like a Connery-Bond movie, huh?) What do all
these little drawings mean? Glad you asked.

When we're in the middle of a discussion and suddenly we have one of those
“Say, that reminds me . . .” moments, we give you one of these tips. They're
handy little extras that are good to know and might even make your podcast
sound a little tighter than average.

If the moment is more than a handy little nugget of information and closer to a
“Seriously, you can’t forget this part!” factoid, we mark it with a Remember icon.
You're going to want to play close attention to these puppies.

Sometimes we interrupt our train of thought with a “Time out, Sparky . . .”
moment — and this is where we ask for your completely undivided attention.
The Warnings are exactly that: flashing lights, ah-ooga horns, dire portents.
They’re reminders not to try this at home because you’ll definitely regret it.

These icons illuminate the “So how does this widget really work . . . ?” moments
you may have as you read this book. The Technical Stuff icons give you a
deeper understanding of what the wizard is doing behind the curtain, making
you all the more apt as a podcaster. But if you want to skip the nitty gritty
details, that’s perfectly fine, too.

/
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Where to Go from Here

At this point, many For Dummies authors say something snappy, clever, or
even a bit snarky. We save our best tongue-and-cheek material for the pages
inside, so here’s a more serious approach. ...

We suggest heading to where you’re planning to record your podcast, or just
plant yourself in front of a computer, and start with Chapter 1 where you're
given a few links to check out, some suggestions on applications for down-
loading podcasts, and directories to look up where you can find Tee’s and
Chuck’s (many) podcasts, and other podcasts that can educate, inspire, and
enlighten your ears with original content.

Where do we go from here? Up and out, friends. Up and out . . .
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Podcasting on
a Worldwide
Frequency

The 5th Wave By Rich Tennant
[¢]

il

“Hold on, Barbara., T'm going through my old
episodes of the ‘I Love Boas’ podcast.”



In this part . . .

Depending on who'’s describing it, podcasting is either
taking the world by storm or providing an interest-
ing diversion. If neither of those, it falls somewhere in
between. Whatever it is, we like it, and we think you will
too. In this first part, we peel back the covers and go
beyond the hype to talk about what this technology is and
exactly what you need to do to become involved with it —
from soup to nuts.




Chapter 1
Getting the Scoop on Podcasting

In This Chapter

Finding out what podcasting is
Creating a podcast
Finding and subscribing to podcasts

S)metimes the invention that makes the biggest impact on our daily lives isn’t
an invention at all, but the convergence of existing technologies, processes,
and ideas. Podcasting may be the perfect example of that principle — and it’s
changing the relationship people have with their radios, music collections, books,
education, and more.

The podcasting movement is actually a spin-off of another communications
boom: personal Weblogs, commonly referred to as blogs. Blogs sprang up
right and left, providing non-programmers and designers a clean, elegant
interface that left many on the technology side wondering why they hadn’t
thought of it sooner. Everyday people could chronicle their lives, hopes, dreams,
and fears, and show them to anyone who cared to read. And oddly enough,
people did care to read — and still do.

Podcasting combines the instant information exchange of blogging with audio
and video files that can be played on a computer or portable media device.
When you make your podcast publicly available on the World Wide Web, you are
exposing your craft to anyone with a computer and a broadband Internet con-
nection. To put that in perspective, some online sources report the global online
population is over 1.2 billion users. In the United States, broadband connections
are now more popular than dialup among the 235 million Internet users. And to
top it all off, portable players are surging in popularity, with over 22 million adult
owners.

This chapter is for the consumers of the content (the audience) and those
who make the content (the podcasters) alike. We cover the basic steps to
record a podcast and lay out the basics of what you need to do to enjoy a
podcast on your media player.
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If you're starting to get the idea that podcasting is revolutionary, ground-
breaking, and possibly a major component of social upheaval, great. But not
all podcasts are so deep. In fact, many of them are just plain fun!

Deciding Whether Podcasting Is for Vou

Technically speaking, podcasting is the distribution of specially encoded mul-
timedia content to subscribed personal computers via the RSS 2.0 protocol.
Whew! Allow us to translate that into common-speak:

Podcasting allows you to listen to stuff you want to hear, whenever and
wherever you want.

Podcasting turns the tables on broadcast schedules, allowing the listener to
choose not only what to listen to, but also when. And because podcasts are
transferred via the Internet, the power to create an audio program isn’t lim-
ited to those with access to a radio transmitter.

The simplest reason to podcast is that it’s just plain fun! We’ve been podcast-
ing since the beginning, and we’re still having a blast, continuing to get out
messages to our worldwide audiences and challenging ourselves with new
tricks and techniques in creating captivating media. So, yeah, for the fun of it.
Heck of a good reason.

The following sections cover other reasons podcasting is probably for you.

VYou want to deliver audio
content on a reqular basis

Sure, you can include audio content in your blog if you have one. Many bloggers
record audio segments and insert them as links into the text of their blog posts.
Readers of the blog then download the files at their leisure. However, audio blogs
require the readers to manually select the content they want to download. What
sets podcasting apart from blogging is that podcasting automates that process.
A listener who subscribes to your podcast is subscribed to all of your content,
whenever it’s available. No need to go back to the site to see what’s new!
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You want to reach beyond
the boundaries of radio

In radio, the number of people who can listen to a show is limited by the power
of the transmitter pumping out the signal. Podcasting doesn’t use radio signals,
transmitters, or receivers — at least not in the classic sense. Podcasts use the
World Wide Web as a delivery system, opening up a potential audience that
could extend to the entire planet.

No rules exist (yet, anyway) to regulate the creation of podcast content. In
fact, neither the FCC nor any other regulatory body for any other government
holds jurisdiction over podcasts. If that seems astounding, remember that
podcasters are not using the public airwaves to deliver the message.

Just because the FCC doesn’t have jurisdiction, you’re not exempt from the
law or — perhaps more importantly — immune to lawsuits. You're personally
responsible for anything you say, do, or condone on your show. Additionally, the
rules concerning airplay of licensed music, the distribution of copyrighted mate-
rial, and the legalities of recording conversations all apply. Pay close attention to
the relevant sections in Chapter 4 to avoid some serious consequences. When it
comes to the legalities, ignorance is not bliss.

\NG/
S

What's in a name, when the name is podcasting?

As with most items that make their way into
the conventional lexicon of speech, the pre-
cise origins and meaning behind podcasting
are somewhat clouded. Although the domain
podcast.com was originally registered back
in 2002 (nothing was ever done with it, as far
as we know), and Ben Hammersley suggested
that and many other terms in February 2004
(www . guardian.co.uk/media/2004/
feb/12/broadcasting.digital
media), it's generally accepted in the podcast
community that the first person to use the term
as a reference to the activity we now know as
podcasting was Dannie Gregoire on September
15, 2004 (http://groups.yahoo.com/
group/ipodder-dev/message/41).

Although some assert the name has conno-
tations to the popular iPod device created by
Apple, Dannie didn't have that in mind when
the phrase was coined. Regardless of the inten-
tions, the term has been backronymed (that is,
treated like an acronym and applied to a variety
of plausible existing meanings). Of all the pos-
sibilities, we prefer Programming On-Demand
casting (not broadcasting), which shortens
nicely to podcasting. But of course, you can
choose whichever one makes sense to you.

Granted, the podcasting phenomenon was in
part fueled by the wildly popular iPod portable
media device, but no evidence suggests that the
two were related when the name was coined.
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Narrowcasting (the practice of delivering content to a select group) distinguishes
podcasting from traditional forms of broadcast communication, such as radio.
Where a radio station broadly casts its signal to anyone who happens to be
within the radius of the signal, podcasts narrowly cast content to people who
have made the overt decision to listen.

You have something to say

As a general rule, podcasters produce content that likely holds appeal for only
a select group of listeners. Podcasts start with an idea, something that you have
the desire and knowledge, either real or imaginary, to talk about. Add to that a
bit of drive, do-it-yourself-ishness, and an inability to take no for an answer. The
point is to say what you want to say, to those who want to hear it.

Podcasts can be about anything and be enjoyed by just about anyone. The
topics covered don’t have to be earth-shattering or life-changing. There are
a few rules and guidelines in common practice, but there may be times when
you find it necessary to bend the rules. (That can be a lot of fun in itself!)

Some of the most popular podcasts are created by everyday people who sit
in front of their computers for a few nights a week and just speak their minds,
hearts, and souls. Some are focused on niche topics; others are more
broad-based.

You want to hear from your listeners

We’ve heard more than one podcaster comment on the fact that they get,
well . . . comments. Podcast listeners are more likely to provide feedback for
the podcasts they listen to than radio show listeners are likely to e-mail their
thoughts to the show host. That’s probably traceable to the personal nature
of a podcast. Podcasts offer their listeners — and makers — more control,
options, and intimacy than traditional broadcast media can. Of course, the
radio is much harder to talk back to than a computer with an Internet
connection and e-mail.

When you ask for feedback, you're likely to get it — and from unusual places.
Because geography doesn’t limit the distance your podcast can travel, you
may find yourself with listeners in faraway and exotic places. And this feed-
back isn’t always going to be “Wow, great podcast!” Listeners will be honest
with you when you invite feedback.
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Creating a Podcast

There are two schools of thought when it comes to creating a podcast: The 7
need the latest and greatest equipment in order to capture that crisp, clear sound
of the broadcasting industry” school of thought, and the “Hey, my computer came
with a microphone, and I've got this cool recording software already installed”
school of thought. Both are equally valid positions, and there are a lot of
secondary schools in-between. The question is how far you're willing to go.

But allow us to dispel a few misconceptions about podcasting right off the
bat: You're not reprogramming your operating system, you're not hacking
into the Internal Revenue Service’s database, and you'’re not setting up a
wireless computer network with tinfoil from a chewing gum wrapper, a shoe-
string, and your belt — regardless of whether MacGyver showed you how.
Podcasting, as mentioned earlier, is not rocket science. In fact, here’s a quick
rundown of how you podcast:

1. Record audio and convert it to a download-friendly format.
2. Create a simple but specialized text file that describes your audio file.
3. Upload everything to the Web.

Yes, yes, yes, if it were that simple, then why is this book so thick? Well,
we admit that this list does gloss over a few details, but a podcast — in its
most streamlined, raw presentation — is that simple. The details of put-
ting together a podcast start in Chapter 2 and wrap up in Chapter 7; then
Chapters 9, 10, and 12 walk you through all the geek-speak you need to
accomplish the podcast.

Looking for the bare necessities

You need a few things before starting your first podcast, many of which you
can probably find on your own computer:

+* A microphone: Take a look at your computer. Right now, regardless of
whether you have a laptop or desktop model, Windows or Macintosh,
your computer probably has a microphone built into it — or a jack for
plugging in an external mic, and maybe even an included external mic
packaged somewhere with the manuals, cables, and such.

Position the microphone in a comfortable spot on your desk or table.

If you’re using a laptop, it should be somewhere on your desk that
allows for best recording results without hunching over the computer
like Young Frankenstein’s Igor (That’s EYE-gor.) Check the laptop’s
documentation to find out where the built-in microphone is located in
the unit’s housing.
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v Recording software: Check out the software that came with your computer.
You know, all those extra CDs that you filed away, thinking, “I'll check
those out sometime.” Well, the time has arrived to flip through them.
You probably have some sort of audio-recording software loaded on
your computer, such as Recordlt (PC) or GarageBand (which comes
pre-installed with many new Macs).

<P If you don’t already have the appropriate software, here’s a fast way to
get it: Download the version of Audacity that fits your operating system
(at http://audacity.sourceforge.net), shown in Figure 1-1. (Oh,
yeah ... it’s free.)

v An audio card: Make sure your computer has the hardware it needs to
handle audio recording and the drivers to run the hardware — unless, of
course, you have a built-in microphone.

3 Some desktop computers come with a very elementary audio card built
into the motherboard. Before you run out to your local computer vendor
and spring for an audio card, check your computer to see whether it can
already handle basic voice recording.

For tips on choosing the right mic and audio accessories, be sure to check
out Chapter 2. Chapter 3 covers all the software you need.
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Recording your first podeast

When you have your computer set up and your microphone working, it’s
time to start recording. Take a deep breath and then follow these steps:

1. Jot down a few notes on what you want to talk about.

Nothing too fancy — just make an outline that includes remarks about
who you are and what you want to talk about. Use these notes to keep
yourself on track.

All this — checking your computer, jotting down notes, and setting up
your recording area — is called preshow prep, discussed in depth in
Chapter 4 by other podcasters who have their own ways of approaching
preshow prep (all of which can give you some starting points).

2. Click the Record button in your recording software and go for as long
as it takes for you to get through your notes.

We recommend keeping your first recording to no more than 20 minutes.
That may seem like a lot of time, but it will fly by.

3. Give a nice little sign-off (like “Take care of yourselves! See you next
month.”) and click the Stop button.

4. Choose Filew>Save As and give your project a name.

Now bask in the warmth of creative accomplishment.

Compressing your audio files

Nearly all portable media devices and computers can play MP3 files as a
default format. Some play many other formats, but MP3 is used as a common
format. If your recording software has the ability to output straight to MP3
format, your life is much simpler. In Audacity’s case, you need to download
an add-on file. If you can’t export directly to MP3, check out Apple iTunes at
www.apple.com/itunes. (The iTunes window is shown in Figure 1-2.) It
does many things for the podcaster, including converting a wide variety of
audio file formats to MP3. Yes, it’s from Apple, but the Apple folks made sure
to create a version for Windows also.

After you install iTunes, follow these steps to convert your audio file:

1. Choose File=>Add File to Library.
Or you can press 8+0 (Mac) or Ctrl+O (Windows).
2. Browse for the audio file you want to convert and then click Open.

Your file is now in the iTunes Library.

17
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3. Find the audio file in the iTunes Library and click to select it.
4. Choose Advanced->Convert Selection to MP3.

Your file is converted to the MP3 format. Figure 1-3 shows the progress
screen that indicates your file is being converted.

The default file format for iTunes file import is AAC. If your menu doesn’t have
a Convert Selection to MP3 option, go to iTunes Preferences (Filer>Preferences
on a Mac, or Edit=>Preferences in Windows), under the Advanced tab,
Importing tab, and change the Import Using option to MP3 Encoder. The
Settings should be at least Good Quality (128 kbps). Now your files will be
imported and converted to MP3.

Congratulations — you just recorded your first audio podcast! Easy, isn’t it?
This is merely the first step into a larger world, as Obi-Wan once told Luke.

Transferring your audio to the Web

An audio file sitting on your desktop, regardless of how earth-shattering the
contents may be, is not a podcast. Nope, not by a long shot. You have to get
it up on the World Wide Web and provide a way for listeners’ podcatcher
software to grab that tasty file for later consumption.
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If you already have a Web server for your blog, company Web site, or personal
site, this process can be as easy as creating a new folder and transferring your
newly created audio file to your server via your FTP client of choice.

If that last paragraph left you puzzled and you're wondering what kind of
mess you've gotten yourself into . . . relax. We don’t leave you hanging out in
the wind. Chapter 10 covers everything you need to know about choosing a
Web host for your podcast media files.

Note that we called your audio a podcast media file. Podcasting isn’t just about
audio. On the contrary, you can podcast any sort of media file you like, even
video. Although this book focuses on audio files, you can use all the tips we
give here to handle other types of media files.

After you post the media file, you need to create a specially formatted text
file, known as an RSS file (Really Simple Syndication), explained in detail in
Chapter 12, and move it up to your Web server. This file describes where to
find the media file you just placed on your Web server. This is your podcast
feed. People who listen to your podcast can subscribe to your show by plac-
ing a link to this podcast feed in their podcatching client.

Yes, we know . . . this sounds really complicated. But we assure you it’s not.
Some hosting companies such as LibSyn (www.1libsyn.com) specialize in
taking the technological “bite” out of podcasting so you can focus on creating
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your best-sounding show. With LibSyn (shown in Figure 1-4), moving your
audio files to the Web server is as simple as pushing a few buttons, and the
creation of the RSS 2.0 podcast feed and even the accompanying Web page
are automatic.

If you want to take more control over your Web site, podcast media files, and
their corresponding RSS 2.0 feed, look at Chapters 10 and 12. In those pages,
we walk you through some essentials — not only how to upload a file but
also how to easily generate your RSS 2.0 file using a variety of tools.
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Grabbing listeners

With media files in place and an RSS 2.0 feed ready for podcatcher consump-
tion, you're officially a podcaster. Of course, that doesn’t mean a lot if you're
the only person who knows about your podcast. You need to spread the
word to let others know that you exist and that you have something pretty
darn important to say.

Creating show notes

Before you pick up a bullhorn, slap a sandwich board over yourself, and start
walking down the street (virtually, anyway), you have to make sure you're des-
criptive enough to captivate those who reach your Web site. First, you're going to
want to describe the contents of your show to casual online passers-by in hopes
of getting them to listen to what you have to say.
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You can easily glance at a blog and get the gist of a conversation, but an audio
file requires active listening to understand, and it’s quite difficult to skim. In
effect, you're asking people to make an investment of their time in listening to
you talk, read a story, or play music. You need some compelling text on a Web
page to hook them.

Descriptions of podcast episodes are called show notes, and they're designed
to quickly showcase or highlight the relevant and pertinent contents of the
audio file itself. A verbatim transcript of your show isn’t a good idea, but we
do recommend more than simply saying “a show about my day.” Chapter 11
discusses ways to create your show notes and offers tips and tricks to give
them some punch. (Refer to Figure 1-4 for an example of what show notes
look like on a Web browser.)

Getting listed in directories

When you have a ready media file and a solid set of show notes, you're ready
to take your podcast message to the masses. You can get listed on some
directories and podcast-listing sites, such as iTunes, Podcast Alley, Podcast
Pickle, Zune Marketplace, and Digg.com (explained later in this chapter).
Potential listeners visit literally dozens of Web sites as they seek out new
content, and getting yourself listed on as many as possible can help bring in
more new listeners to your program.

A huge listener base is a double-edged sword: More demand for your product
means more of a demand on you and the resources necessary to keep your
podcast up and running. We recommend working on your craft and your skills,
as well as getting a good handle on the personal and technological require-
ments of podcasting, before you embark on a huge marketing campaign. When
you're ready, Part [V has more details about marketing.

Part IV spends a lot of time talking about the various ways you can attract
more listeners to your show and ways to respond to the ideas and feedback
that your listeners inevitably provide. Many podcasters are surprised at the
sheer volume of comments they receive from their listeners — but when you
consider how personal podcasting is (compared to traditional forms of media
distribution), that’s really not surprising at all.

Catching a Cast with Your
Podcatching Client

So you have the MP3 file, some XML, and accompanying show notes. You're
all set, but ask yourself, “How do podcasts get from the Web to my computer?”
To access all this great, new content, you need a podcatcher, an application
that looks at various RSS feeds, finds the new stuff, and transfers it from the
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Internet to your computer automatically. In this section, we take a look at

some of the different podcatching clients available for your listening/viewing
needs.

You may think you need an iPod for all kinds of reasons, but you really don’t
need one to podcast. Allow us to state that again: You do not need an iPod

to listen to or create a podcast. As long as you have an MP3 player — be it an
application on a Mac, an application on a PC, or a portable device you can
unplug and take with you — you possess the capability to listen to podcasts.
Depending on the MP3 player, you may even be able to create your podcast
on the device as well — but to listen, all you need is a device that can play
audio files.

The catcher that started it all: Juice

Juice (shown in Figure 1-5) started life as a product called iSpider, then was
branded as iPodder, and later became iPodder Lemon. In November 2005, as
if searching for a new identity in the community, the package was rebranded
as Juice. It was inspired by a script written by Adam Curry (yes, the former
MTV VJ and no, we’re not kidding). It promotes itself as an open-source (free
to use) application that downloads audio files from RSS feeds of your choice
directly to your Mac or PC. You can then sync your portable player with your
computer’s media player, and now you're podcasting-on-the-go.
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[ comedydcast #123 Zen There, Done That  Skipped 6.0 hitp:/fwwnpodrac. com/pts/rediect mp3Phitp: A, comedydcast com/podcasts/comedpdcast123.mp3

() comedydcast #121: Get Packing Skipped 7.7 it/ podtsc, compls reditect mpXPhites /e, comedydoast. cam/podcasts/ comedydcast-1 21 mp3

() comedyAcast #120: That's just Hoover Skipped E.0 hitp://wwwipoclrac. com/pts/redirect mp3?hiips 2w, comedydcast com/podoasts/ comedp4oast-120.mp3

[ comedyfcast #113: Danny Hilrests Mearly .. Skipped B5 ilp:/ /sy podtac. com/plsredirect mpXPhilps /7w, comedydoast com/podcasts. comedydcast-113.mp3 -
Hextun:
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Download Juice from http://juicereceiver.sourceforge.net. After
you install it, subscribing to feeds is a simple process. Follow these steps if
you don’t have a specific podcast in mind:

1. Click the Podcast Directory tab.

Juice comes preloaded with a variety of the more popular directories of
podcasts.

2. Navigate through the directory structure.

Click the name of the directory to see the choices offered. In some
cases, you may need to click through to a subdirectory to see additional
podcasts.

3. Double-click the name of a podcast.

You can also single-click the name of the podcast and then click the Add
button near the top.

4. Click Save.
That’s it! You've just subscribed to your first podcast with Juice.

Of course, you don’t have to navigate through the list of podcasts. Follow
these steps if you have a specific podcast in mind:
1. Click the Subscriptions tab.

2. On the Subscriptions panel, click the little green button with a plus
symbol on it.

The Add a Feed window opens.

3. On your favorite podcast Web site, look for a small icon, typically
orange, that says RSS, RSS 2.0, or something similar.

The icon may not even say RSS, but simply be a symbol like the one in
the margin.

4. Right click the icon to copy the link location.

5. Paste the copied information into the URL field of the Add a Feed
window.

Or, type it in — just be very careful with your typing! If you get it wrong,
you won'’t get your downloads.

Congrats! You now know how to use Juice to subscribe to any podcasts you
happen to come across in the future.
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The 800-pound gorilla called iTunes

With the launch of iTunes version 4.9 in June 2005, podcasting went from
what the geeks were doing in the basement of the Science Building to the
next wave of innovation on the Internet (which was, of course, developed by
the geeks in the basement of the Science Building). As always, a step into the
mainstream market brought some dismay; the hardcore, independent pod-
casters considered this a sad day for podcasting as corporate entities (spon-
sored by Disney, ESPN, BBC, and so on) dominated the iTunes Music Store
podcast directory (shown in Figure 1-6). What about the indie podcasts —
the ones that started it all? Would they be forgotten? Go unnoticed? Languish
unsubscribed? Well, at first, it seemed that many of the original groundbreak-
ers that the podcasting community knew and loved (The Dawn and Drew
Show, Career Opportunities, The Catholic Insider, GrammarGirl) might get lost
in the stampede. But not yet, as it turns out.

Apple’s iTunes (available for download at www . i tunes . com) works as a pod-
catching client. It lends an automatic hand to people who don’t know where
to find aggregators, where to find blogs that host podcasts, and which pod-
cast directories list the shows that fit their needs and desires — now they
too can enjoy a wide range of podcast choices.
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With iTunes, podcasting reached into the mainstream markets around the
world. (And if that doesn’t make you go “Wow!” consider this: On August 4,
2005, iTunes launched in Japan. Within four days, the iTunes Music Store had
I million downloads. Sony’s own MP3 download service averages less than
500,000 downloads a month.) Instead of dealing with third-party applications,
Apple iTunes is a one-stop shop for all your podcasting needs.

It gets even better: Subscribing to a podcast with iTunes is just as easy, if not
easier than with Juice. Follow these steps to do so:

1. In the iTunes Music Store, click the Podcasts link located in the top
section of the left column.

You can also click the Podcasts icon on the top left of the main iTunes
screen and the Podcast Directory icon in the lower right. Or search for
a podcaster or a podcast using the Search bar in the upper-right of the
iTunes interface.

2. Find the podcast of your choice.
You can do that by

e Clicking the Browse link to browse through all the podcasts in
iTunes

¢ Searching by clicking the Power Search link

Both of these links are located in the Quick Links section on the right
side of the Podcasts page in the iTunes Music Store.

3. When you get to the podcast page (and available podcasts) in iTunes,
click the Subscribe button.

If you're using iTunes for the first time to subscribe to a feed, you get a
confirmation message. You can select the Do Not Ask About Subscribing
Again option to avoid this message.

After your podcast finishes downloading, you can find the new episodes by
going to the Podcasts section in the left column of iTunes. The new episodes
are marked to let you know that you have fresh content waiting for you, and
iTunes remembers where you left off in a podcast if you pause or zip over to
another podcast or playlist.

Options, options, and more options

Of course, everyone’s tastes and styles are different, and there are plenty
more options for podcatching clients. Maybe you’re using Mac, Windows, or
an entirely different operating system. Maybe you don’t want to install any
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new software on your system, or maybe you just like to be different. Hey,
that’s okay! You too can be a podcast listener:

v Doppler: Designed exclusively for the Windows platform, Doppler (http://
dopplerradio.net) has a strong contingent of dedicated users who are

perfectly happy with the features it offers. Additionally, it seems to be a
pretty rock-solid piece of software, and it’s available for free.

v Songbird: Songbird (www.softpedia.com/get/Multimedia/Audio/
Audio-Players/Songbird.shtml) is another Windows-only application

that takes an interesting approach to podcatching (and music) with its

Web browser look and feel. The default interface is a bit dark, but it can

be customized if you have a little savvy with that sort of thing. Although the
software is stable, it was a bit confusing at first to subscribe to podcasts —
a little digging through the help provides two options. The product idea is

sound, but needs a little maturity as of this writing.

+* Podcast Ready: In some ways, Podcast Ready (http://podcastready.
com) is similar to iTunes. It combines simple-to-use software and an

easy-to-use Web interface to find and download podcasts. Using a book-
marked link, you can quickly subscribe to podcasts via Podcast Ready’s

site from any Web page with an RSS feed. Using MyPodder software, you

can sync your Podcast Ready subscription list with your iPod. MyPodder

is available for Windows, Mac OSX, Linux, and more, and is available to
download right from the Podcast Ready site.

v Zune Marketplace: Zune Marketplace (http://zune.net) is the com-
panion software to the Zune portable media device. The marketplace

contains lots of choices for music and podcasts. It is currently available

only for Microsoft Windows — which makes sense because Microsoft

makes the Zune. Using categories or a search, you can quickly find con-
tent that interests you. Many podcasters have the Zune icon on their Web

sites to make it easy to get their content with a single click of the mouse.

v PodNova: PodNova (http: //podnova.com) is a service that tracks
podcast content, yet doesn’t require you to download any software to
your desktop. You have the option to download some software so files
can be transferred to your MP3 player, but it’s nice to know that some
services don’t require this step. The service is pretty intuitive with a
decent search and allows you to set up lists of your favorite shows so
you can keep them handy.

This is only a starting point for getting access to podcasts. Any attempt at a

comprehensive list here would be instantly obsolete. Podcasting continues to

grow in popularity, and new podcatching clients and players are coming out
all the time. Don’t think podcast listening is limited to your computer or MP3
player — you can even listen to podcasts on your phone or TiVo.



Chapter 1: Getting the Scoop on Podcasting 2 7

For more information and product comparisons, we suggest heading over to
PodcatcherMatrix (http://podcatchermatrix.org) and exploring more
podcatching clients. Bottom line: At this point, you should easily be able to
subscribe to the podcasts of your choice.

Quest for Podcasts

A\

Now that you have your podcatching client, it’s time to take a good listen to
what’s happening in the podcasting community. If you’re going to podcast
(and with you picking up this book, it’s a safe assumption that the interest is
strong), it’s a good idea to take a look around the podcasting community and
see what other podcasters are doing.

Many podcatching clients have internal directories of podcasts, and you can
access their listings from another directory or listing site maintained elsewhere
on the Internet. Other aggregators maintain their own lists based on how many
listeners have used their podcatcher to subscribe to particular shows.

We give you a few other places to get started in the following sections —
directories, podcast-listing services, and even podcast-specific search
engines. (Check out the various sources mentioned in Chapter 18 as well.) So
where are these directories? Fire up your browser and, as Edgar Winter says,
“Come on and take a free ride. . .”

There are so many directories for podcasts that Rob Walch of Podcast411 has
put together a “directory of directories” (http://podcastdll.com/page?.
html). As of this writing, 161 different directories are listed!

iTunes

For the time being, iTunes is king of the hill when it comes to podcast direc-
tories. The directory includes not only show information, searchable in a myriad
of ways, but also the ability to listen to specific episodes, subscribe to a podcast
with one click, visit the show’s Web site, leave comments, and see the podcast
picks of other people who share an interest in the show you’re viewing — and
all that is tied in to the same free, friendly software you use to sync your iPod!
When your podcast gets legs and starts running, and it comes time to post
your name in the directories, make sure you put iTunes near the top of the
list. From a public relations standpoint, it’s pretty impressive to say “My pod-
cast is listed in Apple iTunes.” Many Web sites even have a link directly to
their iTunes podcast page and one-click subscription. You have to admit, the
people at Apple are always trying to make things simpler.
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Podcast Pickle

Gary Leland and the crew at Podcast Pickle (http: //podcastpickle.com)
take a slightly different approach for listeners to find the podcasts they’re look-
ing for. Their best innovation, in our opinion, is the Favorites listing. Rather
than rely on voting as a measure of popularity, the Pickle allows registered
members to mark as many shows as they like as their favorites. The more
people who have marked a show as Favorite, the higher up on the Favorites
list a podcast is. And unlike Podcast Alley’s fairly unwavering top 10 list, Podcast
Pickle periodically takes its top ranked podcasts and moves them to the “Hall
of Fame” to allow others to show up in the top listing. A neat idea!

Yes, it’s a lot like a popularity contest; you have no way to judge how well
you might like a show just because a bunch of other people do. That’s why
Podcast Pickle also allows you to browse by category or search for relevant
keywords that mean something to you. Like Podcast Alley, it also has an
active forum section where you can see what other folks are saying about a
particular podcast before you subscribe.

Podcast Alley

Podcast Alley (http://podcastalley.com) quickly became the first place
to boast, brand, and generally beat your chest about your show. With incred-
ibly active forums, detailed descriptions of podcasts, and individual episodes —
plus the majority of all podcasters clamoring to get their listeners to “VOTE FOR
ME ON PODCAST ALLEY THIS MONTH!” — it’s no wonder that Podcast Alley is
one of the most active podcast listing and ratings service to date.

Zune

Apple has the iPod and Microsoft has the Zune (www . zune . net). Like many
things before, Microsoft wasn’t the first to the table when it came to podcast-
ing. The company took a “wait and see” approach for the first couple years,
but eventually got on board with its Zune product family. As of now, the Zune
is supported only on Windows platforms.

Like the iPod, the Zune supports audio — including podcasts — and video.
Although you can’t search for podcasts from the main Web page, you can search
from within the Zune software. Click the Podcasts link in the Marketplace section
in the upper left of the screen to get started searching and subscribing.
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Digg.com

Digg.com is a site originally known for its innovative way of getting news to the
masses by having its news stories get noticed by peer selection, a process they
call digging. In 2006, a podcast directory was added to the mix (www.digg.com/
podcasts). As more people digg a show (or episode), the more popular it gets
and the higher it moves in the digg.com list. That’s right, Gracie — another popu-
larity contest. Like other sites, digg.com has its share of “fanboys” of certain shows
that garner the lion’s share of the diggs that can leave some pretty good content
unnoticed. As a directory, its information is well laid out and pretty easy to find.

Other Podcast Resources

It goes without saying that this book is a snapshot in time, and you will likely
want to keep up on the latest news and information of the podcasting world.
We have a few suggestions to get you started. Perhaps, as you gain experi-
ence in podcasting, you’ll share some of your pearls of wisdom with the com-
munity by contributing back to the vast universe of podcasting that many
people like to call the podosphere. We recommend trying out these:

” Blogger and Podcaster Magazine: If you're looking for a great resource
of information from the people who live and breathe new media, look to
Blogger and Podcaster Magazine (http://bloggerandpodcaster.
com). Founded in 2007, the online magazine uses a graphical reader
application that makes you feel like you're reading a real magazine! You
can also pick up audio clips — and yes, it’s even available in a print ver-
sion sent to your door.

1 Podcast User Magazine: Podcast User Magazine (http://podcastuser
magazine.com) is a monthly PDF publication exclusively about pod-
casting. As producer Paul Nichols says, “[it] is precisely what it says on
the tin — a magazine about podcasting.” The publication is targeted at
everyone from the professional producer to the complete novice. Topics
cover a wide spectrum, including business, education, news, reviews,
tips, and tricks from the veteran podcasters.

+ New Media Expo: Some have compared podcasting to a religion. As in
many religions, podcasters are drawn to a central gathering place. The
New Media Expo (www . newmediaexpo.com), or NME, is the annual
“Mecca” for podcasters and one of our favorite podcast gatherings. Started
by Tim and Emile Bourquin in 2005, the expo is a great way to network
with other podcasters, vendors, and attend focused conference sessions.
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If you're watching your budget, there’s a fee to attend the conferences,
but the expo floor is free of charge. Of course, like many cons and expos,
a lot of the fun happens after hours. In 2008, the New Media Expo moved
from sunny southern California to “sin city,” Las Vegas. (Just remember —
what happens at the NME, stays at the NME.)



Chapter 2

Getting the Gadgets That
Make a Podcast Go

In This Chapter

Choosing the microphone that’s best for you
Getting the right mixing board

Accessorizing your studio

N ow that you’re effectively hip as to what podcasting is and what it’s all
about, you need to start building your studio. This studio can come in
a variety of shapes, sizes, and price tags. What you’re thinking about doing —
podcasting — is like any hobby you pursue. If it’s something to pass the time,
then keep your setup simple. A modest setup with little to no investment is
ideal if you want to see whether you like playing with audio. If, on the other
hand, you find yourself tapping into a hidden passion or (even better) talent,
you might want to upgrade to the audio gear that’s bigger, better, and badder
than the basics.

If you suddenly decide you — yes, you — have a message you want to share,
your next plan of action will be one of two options: picking up a digital
recorder, reading the instruction manual, and then downloading some free
audio-editing software; or watching the DIY Network for methods of sound-
proofing the basement and looking at industry-standard equipment that
might require some extra homework to master.

This is the beauty of podcasting. In the long run, it doesn’t matter whether
your podcasting studio is an iPod with a plug-in microphone or comprised

of the latest mixing boards, audio software, and recording equipment. Both
approaches to podcasting work and are successfully implemented on a variety
of podcasts.

So which one works best for what you have in mind? That’s what we take a
look at in this chapter, discussing the options, advantages, and disadvan-
tages of each setup.
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Finding the Right Mic
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It’s easy and affordable to make your computer podcast-capable. Your first
order of business is to find the right mic. If you already have a microphone
built into your laptop (and you don’t mind starting out basic), you can just
download Audacity (described in Chapter 3) and take advantage of the fact
that it’s free. That’s all there is to it! (For openers, anyway.)

However, if your desktop computer didn’t come with a mic (or you're just not
happy podcasting Quasimodo-style), you're going to want to shop around.
While microphone shopping, consider the following criteria:

1 What’s your price range? In many cases, especially with “cheap” mics,
you get what you pay for in quality of construction and range of capabili-
ties. You want the most affordable model of microphone that will do the
job for you and your podcast.

+* Do you plan to use the mic primarily in the studio or on location? A
high-end shockmounted model isn’t the best choice for a walk in the
park, and a lapel mic might not provide you with the quality of sound
expected for an in-studio podcast. Before you purchase your mic, con-
sider your podcasting location needs.

There are many different types of microphones and microphone connec-
tions (or jacks). Some mics are meant to plug in to mixers, some directly
to your computer’s USB port, and still others to portable recorders. If
you’re thinking of starting with an inexpensive mic, you may not be able
to plug it in to your “upgraded” rig later on. Depending on your needs,
you may find yourself upgrading more than just your microphone down
the road.

+* What do you want this mic to do? Record sound? Yeah, okay, but what
kind and in what surroundings? Some mics offer ease of handling for
interviews. Some are good at snagging specific outdoor sounds. Others
may be better at capturing live music. You need to consider multipur-
pose mics, guest mics, and on-location recording devices, or any kind of
condition your podcast provides for you.

Even after narrowing your options, there are so many microphones on the
market. After a while, the manufacturers, makes, and models all start to give
you that kind of brain-freeze you get when you eat ice cream too quickly. The
sections that follow give you the lowdown on the mic that’s right for your
budget and even make a few sound recommendations along the way.

Say, did you know there’s a companion podcast for this book? Yeah, it’s
Podcasting For Dummies: The Companion Podcast. In Season Two, Tee hosts
several episodes concerning microphones, including one where he and pod-
caster Phil Rossi (http://philrossi.net) test four mics, comparing and
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contrasting the sound of each. To find out more about microphones, gadgets,
and concepts, listen to Podcasting For Dummies: The Companion Podcast avail-
able at www . dummies.com/go/podcastingfd.

Mics on the cheap

Most of the economical microphones on the market use USB (Universal Serial
Bus) hookups. Figure 2-1 shows two types of USB plugs, which you may have
used for attaching a digital camera or an MP3 player. You can go online to
any of the computer equipment retailers and type USB microphones in their
respective search engines. Make sure you include USB, because a search for
microphones can bring up many more alternatives, including video cameras,
high-end mics (which we talk about next), and other devices that might be
way out of your budget.

You don’t have to sacrifice your retirement fund to get started with a USB
microphone. Prices start under $20 for a simple desktop microphone. The
phase “you get what you pay for” doesn’t always apply in podcasting either.
We've heard some pretty amazing sounds out of very inexpensive microphones.

When shopping for microphones, you’ll hear a lot of terminology like omnidi-
rectional and unidirectional. These multisyllabic words may look cool to type
and are impressive to say, but when you read them or they’re spoken to you,
they can be a little intimidating. In the next two sections, we demystify these
terms and explain how effective these various mic types are for podcasting.

USB Ports

USB Device

33
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Omnidirectional mics

Most microphones that come preinstalled in laptops are omnidirectional —
they pick up sounds from all directions at once. The iPod accessory iTalk
Pro (from Griffin Technologies, priced at around $50 on www.griffin
technology.com/products/italkpro) is an omnidirectional microphone.
Omnidirectional mics pick up your voice, along with the television in the
background, the traffic outside, the rustling of clothes, the ceiling fan . . .
basically, if it makes noise and is within range of the mic, it’s recorded.

Although omnidirectional mics are ideal for sound-seeing tours such as Tokyo
Calling (http://tokyocalling.org) or CitizenReporter.org with Bicyclemark
(http://citizenreporter.org/category/audio/), they may not be ideal
for all in-studio podcasting because they don’t capture your sound in detail —
even when your mouth is so close that your lips brush against the mic’s screen.
They tend to add a sharp, tinny quality to your voice and cut out on harsh,
sudden sounds such as consonants (especially ps and fs). That’s partly because
basic omnidirectional mics vary widely in quality and partly because of the
limits imposed by their construction. The built-in models, for instance, are
sometimes crammed into leftover nooks in their devices, where they’re
awkward to use and can pick up internal noise.

One omnidirectional desktop mic that we recommend is the eMic (www.gembird.
us/html/emic.htm). It currently retails for about $16 and is compatible with
both Mac and Windows platforms. There are also omnidirectional mics that come
with headphones. Logitech’s ClearChat Pro (headset), priced at $50, offers
you the ability to record and monitor yourself as you do so.

One advantage headsets have over a desktop microphone is that your mouth
is always the same distance away from the actual part of the microphone that
picks up sound. If you're an animated podcaster like your authors, this may
be useful. On the other hand, they can be very sensitive to breathing sounds.
If the mic boom is in the wrong position, the slightest breath from your
mouth or nose will sound like an F5 tornado.

Although purchasing a USB headset is a monetary plus because you're getting
both headphones and mic together with one purchase, this isn’t all you need
to monitor yourself as you record. To self-monitor your recording, you need
software that offers you an on-screen mixer, a mixing board, or the option to
monitor the incoming audio signal.

Installation for these inexpensive investments is a breeze. Find a USB port on
your Mac or PC, plug in your new headset or microphone, and set up your
audio preferences in your recording software. You're ready for recording.
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Unidirectional mics

Unidirectional mics, unlike their omnidirectional brethren, pick up sound from
only one direction: the direction they’re pointing in. What makes unidirec-
tional mics a good choice for podcasting is in how they by design filter out
surrounding sounds, reproducing only the sound directed to it. For in-studio
podcasting, interviews, and quality recording, unidirectional microphones
are the best option.

If you want to know exactly what a unidirectional mic is and what it can do, take
a look at the Brian DePalma film, Blow Out. John Travolta plays a Foley Artist, a
guy who collects random sound effects and then enhances them for particular
moments in whatever film he’s working on. One night, he takes a stroll through
the park with a gun microphone, a unidirectional mic that picks up only sounds
located where it is pointing. This microphone is so particular that it concentrates
on recording along the line of sight — so it records not only the sound of a tire
blowing out, but also the gunshot that causes it to happen.

If you're out shopping for a unidirectional microphone, watch for the term
cardioid. It relates to the pattern and sensitivity of the microphone. It’s also
one of those buzzwords that will make you sound more intelligent!

Investing in a high-end mic

Say, however, you really want a cleaner sound for your podcast, and the $50
(or cheaper) microphones just aren’t cutting it for you. As you shop, you see
mics ranging in price from an inexpensive $70 and reaching up to $3,600! (No,
you’re not seeing a typo involving an extra zero.) So what defines a microphone?
Price? Manufacturer? Look?

What truly defines a microphone is how you sound in it and how it reproduces
the sound coming in. Based on how mics work, prices vary, but as you can
see from our recommendations, plenty of high-quality microphones that are
out there can pick up nuances and details and still remain in the range of
affordability.

When you purchase a higher-end microphone, keep in mind that you probably
will receive no additional cables for hook up, a jack that does not fit into your
computer, and no stand. That’s because you're upgrading to professional
equipment. The manufacturer is assuming that you already have the tools,
bells and whistles, and extra do-dads to make this mic work for you. For the
lowdown on what accessories you need to hook up your new mic to your
computer, check out the “Accessorize! Accessorize! Accessorize!” section
later in this chapter.
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Remember those three questions a few pages back? Question #2 — Do you
plan to use the mic primarily in the studio or on location? — helps narrow
your search even more for the microphone that’s the right investment for
you. At this level, there are two kinds of mics you will hear people talk about:
dynamic and condenser mics.

Although dynamic microphones are marketed more for on-location recording
and condenser mics are considered best for in-studio recording, these aren’t
fast-and-hard rules for what mics should be used where. Sometimes, podcast-
ers use condensers in outdoor settings, and some podcasters prefer the sound
of dynamic mics in studio over condensers. When picking a microphone, you
want a mic that not only suits your needs but also makes you sound good.
Really good.

Dynamic mics

Dynamic mics are what you see everywhere from speaking engagements to
rock concerts. In fact, when someone mentions the word “microphone,” the
image that comes to mind is probably a dynamic microphone. These mics
work like a speaker in reverse. Sound entering a dynamic mic (by speaking
directly into it) vibrates a diaphragm (a small plate) attached to a coil. This
is located within proximity of a magnet, and the vibrations that this Wile E.
Coyote setup makes create a small electric current. When this signal runs
through a preamp or mixer, the original sound is re-created. This system
sounds complicated (and if you've ever looked inside of a microphone, it is),
but the internal makeup of dynamic microphones is such that they can take a
lot of incoming signal and still produce audio clearly. They’re also rugged in
build so they can be manhandled.

If you have a podcast that’s “out in the field” or if you're recording on the
street and want to be able to surrender the mic to guests and subjects with-
out worry, look no further than the Shure SM58 (pictured in Figure 2-2). This
mic has been in use for over 40 years and is considered the industry stan-
dard for its durability and reliability. Podcasters picking it up for $100 love it
for its affordability.

Condenser mics

When podcasting happens in studio and you’re looking for the subtleties and
nuances of the human voice in your recording (the more detail you get, the
better!), you may want to shop for studio condenser microphones. The anat-
omy of a condenser microphone is very different from a dynamic one. In the
condenser, a diaphragm (similar to the dynamic’s) is suspended in front of a
stationary plate that conducts electricity. As a signal enters the microphone,
the air between the diaphragm and the plate is displaced, creating a fluctuating
electrical charge. Once given a bit more power (phantom power, which is
explained later in this chapter), the movement becomes an electrical repre-
sentation of the incoming audio signal.
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A Shure-fire investment

Remember the opening of The Blues Brothers?
Jake (John Belushi) turns to Elwood (Dan
Aykroyd), after looking over the “new used” car
his brother is driving, and asks him what hap-
pened to their Cadillac. “I traded it,” Elwood
replies, “for a microphone.” Jake leans forward,
a little stunned. “You traded the Bluesmobile for
a microphone?!?" Then, on reflection, he nods.
“Allright, | can see that.” There are differences
between the economic $20 USB microphones
and the more expensive dynamic and con-
denser microphones, and there are even bigger
differences between the $100 microphones and
the $700 microphones.

The Shure SM7B was the first industry micro-
phone Tee ever had in Imagine That! Studios.
This was a microphone that, for its price, could
easily cover two mixers and two high-end
microphones, and this was a dynamic micro-
phone, a kind of microphone that Tee wasn't
accustomed to working with in studio. He had

recorded with this mic before though, in loca-
tions such as the Washington D.C. WJFK and
NPR affiliates in the DC-metro area. Now, it was
in his studio, and after his first recording project,
Tee understood — with the mic’s clarity and
exceptional performance — exactly why Shure
microphones are referred to as “the industry
standard” when it comes to recording equip-
ment, be it in-studio or on location recording.

Microphones can definitely be an investment,
worth the trade-in of a car in Jake and Elwood’s
case. What you invest in a microphone will
reflect in the quality of its sound. For Tee, the
investment was the right one. But is such an
investment right for you? Be sure that you and
your podcast are ready for this kind of studio
asset. Ask other podcasters what they use, try
out microphones if vendors allow for such test
drives, and take your time before making such
an investment.
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Figure 2-2:
Christiana
Ellis, creator
of the Space
Casey
comedy
podcast,
relies on the
Shure SM58
for her
record-

ing needs.
|

This set-up sounds very delicate, doesn’t it? Guess what — it is! This is why
condenser mics are transported in padded cases; they’re not really built for
hand-held use and are best used in a studio application (as shown in Figure 2-3)
versus an on-location kind of podcast. If manhandled or jostled around, plates
can be knocked out of whack or damaged, causing problems in the pick-ups.

The advantage to this delicate setup is that condenser mics are far more
sensitive to sound, and they pick up a wider spectrum of audio. These
microphones are so sensitive to noise around them that some come with
shockmounts — spring-loaded frames that “suspend” the mic when attached
to a microphone stand, providing better reception while reducing any noise
or vibration from your microphone stand. Think of a shockmount as a shock
absorber for your mic.

Tee is a big fan of the AKG Perception Line. Shown in Figure 2-3 as part of
Farpoint Media’s Draco Vista Studios’ setup, the Perception 100 is a fan-
tastic investment for $100, and it can also come bundled with mixer boards
(discussed later in this chapter) and even in economical two-packs from
online vendors like BSW (www . bswusa . com). With each higher model of
Perception, cost and features go up, but the quality sound that the AKG line
captures remains the same.
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Studio condenser mics
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Microphone vendors are noting the popularity of podcasting, and now USB
Studio Condenser microphones are becoming more and more prevalent.

Samson Technologies (www. samsontech. com) was the first to produce such

a microphone — the CO1U. For less than $90, podcasters can now record
studio condenser microphone quality audio and need only a USB port to

power and connect the mic. The CO1U (and the all-encompassing Recording
Pak shown in Figure 2-4) was the predecessor to other USB condenser mics

like the Blue Snowball, and the Marshall MXL 990 USB.

You might notice that condenser mics (such
as the Perception 100 described in this chap-
ter) are phantom powered — their connection
to the mixer provides them with all the power
they need. Portable condenser mics use bat-
teries to get their kick, but when they start to
die, so does your recording quality. (A word to

The phantom (power) of the podcast

the wise: Always check your mic’s battery level
before you interview and have fresh batter-
ies on hand.) Because phantom power comes
from the mixing board (in the studio) through
the cable connecting to the mic, it supplies a
constant boost. No battery worries.
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Figure 2-4:
Samson
Tech-
nologies
offers
everything
you

need for
portable
podcasting
with

the CO1U
Recording
Pak.

The clear advantage of working with USB microphones is you no longer need
the audio card, the mixer, or any of the go-betweens once considered essential
for connecting audio gear to a computer. With USB condenser microphones,
the audio signal now has a direct connection to the computer. It makes your
podcast production extremely portable.

Two drawbacks of USB microphones are in their latency and expandability:

v~ Latency is the slight echo you hear in your voice as you record. This is
your computer trying to re-create the signal in real time for monitoring
purposes. The recording itself will sound fine, but as you’re monitoring
yourself, you may hear yourself echoing, and the echo may progres-
sively get worse the longer you record one session, depending on your
computer’s performance. A faster computer can reduce the latency but
likely not resolve it completely. You can side-step the latency problem
by disabling the recording application’s monitor.

v The other problem is expandability. Hooking up four C01Us to a hub
can be possible for multitrack recording, but doing so requires fairly
advanced multitrack recording software which is beyond the scope of
this book. USB condenser microphones are great for solo podcasters,
especially ones who travel a lot, and USB condensers are quick and easy
to set up and figure out.
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High end is relative. Professional recording studios can spend hundreds of dollars
on a single microphone. Fortunately, the MP3 format isn’t so finicky. For this
book, we're defining high-end microphones as those ranging from $100 to $150.

Podcasts Well with Others:
The Mixing Board

A\\S

If you're looking to have more people in studio or you want to entertain
guests on your podcast, you need more than just a really good microphone.
(Otherwise there will be the passing back and forth of a mic, and that’ll get
distracting after a while.) You also need inputs for more microphones and
full control over these multiple microphones.

Along with a good microphone (and probably a microphone stand, discussed
later in the “Accessorize! Accessorize! Accessorize!” section), you will want to
invest in a mixing board. What a mixing board (or mixer) does for your pod-
cast is open up the recording options, such as multiple microphones, record-
ing acoustic instruments, and balancing sound to emphasize one voice over
another or balance both seamlessly.

You see mixers at rock concerts and in “behind the scenes” documentaries
for the film and recording industry. They come in all shapes and sizes; Figure 2-5
shows the Alesis MultiMix8 FireWire. At $300, you might feel like you’re sink-
ing a sizable chunk of change into it. (Other Multimix USB options include the
sans-iPod option MultiMix8 for $150.) After doing the math, this mixer does com-
pare to others, so you might be coming out ahead in the financial investment.

Before you take your mixer out of its packing, make sure you have room

for it somewhere on the desk or general area where you intend to podcast.
Something you’ll want to consider is how close you want to be to the mixer.
An ideal reach for your mixer is a short one. Whether it’s you recording your-
self or balancing the levels of those around you, clear off a section within a
relaxed reach. You'll be happier because of it.

The anatomy of a mixing board

The easiest way to look at a mixing board is as if you're partitioning your
computer into different recording studios. But instead of calling them studios,
these partitions are called tracks.
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Figure 2-5:
The Alesis
MultiMix8
FireWire
Mixer, a
reliable and
fantastic
mixing

board for
podcasting.
|
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A mixing board provides mono tracks and stereo tracks, and you can use any
of those tracks for input or output of audio signals. No matter the make or
model, mixing boards are outrageously versatile. If you’re podcasting solo or
with a friend, you can hook up two mics so you won’t have to huddle around
the same microphone or slide it back and forth as you take turns speaking —
nobody wants that. Multiple microphones are the only way to go when you
and your friends gather around to record. The real advantage of the mixer is
that it allows you to adjust the audio levels of those multiple inputs indepen-
dently so they sound even.

You may also be wondering about all those wacky knobs on a mixing board.
Some of the knobs deal with various frequencies in your voice and can
deepen, sharpen, or soften the qualities of your voice, and perhaps even help
filter out surrounding ambient noise (which is the sound of an empty room
because even in silence, there is noise). The knobs on the mixing board that
are your primary concern are the ones that control your volume or levels, as
the board labels them. The higher the level, the more input signal your voice
gains when recording. If one of your tracks is being used for output, the level
dictates how loud the playback through your headphones is.

Heavy-metal legends Spinal Tap may prefer sound equipment that “goes to 11,”
but cranking your mixing board way up and leaving it that way won’t do your
podcast much good. The best way to handle sound is to set your levels before
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podcasting. That’s what’s going on when you see roadies at a concert do a mic
check. The oh-so-familiar “Check One, Check Two, Check-Check-Check . . .”

is one way of setting your levels, but a better method is just rambling on as if
you were podcasting and then adjusting your sound levels according to your
recording application’s volume unit (VU) meter. For more on setting levels,
hop to Chapter 6 for all the details.

Hooking up a mixer to your computer

Now that you have your desk cleaned off (mind the dust bunnies!) and a
perfect place for the mixer, set your mixer where you want it. And then make
certain you can see the following items:

v Your USB or FireWire mixer
v A power supply

v A USB or FireWire cable

v A CD of drivers

Before hooking up the new mixer, check the manufacturer’s Web site for any
downloads (new drivers, upgrades to firmware, patches, and so on) needed
to make your digital mixing board work. The drivers on the CD — if a CD is
included or if drivers are needed — may be out of date. If you do see any
recent updates on the manufacturer’s Web site, download them and have
them on standby.

USB and FireWire mixers are so similar in setup that we can give the same
steps for both kinds of mixers. Regardless of where you fall in the Mac/PC
debate, you can follow these steps to hook up your mixer board:

1. Shut down your computer.

2. Connect the power supply to the back of the mixer and to an available
wall socket or power strip.

3. Find an available USB or FireWire port and plug your mixer-
appropriate cable into the computer.

If your computer’s ports are maxed out, we recommend investing in a
PCI card that gives your computer additional USB or FireWire ports. We
recommend against running your digital mixer through a hub because
that might create latency issues and/or affect the quality of the audio.

A direct connection between your mixer and computer is the best.
4. Plug the USB or FireWire cable into the back of your mixer.

5. Connect your input devices (microphones, headphones, monitors, and
the like) to the mixer.
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Analog versus digital

So you decide to go mixer shopping and you
see a lot of these mixers going for $40 or $50,
and in some cases offering more inputs than the
$300 Multimix we recommend here at half the
cost. What gives?

Before making this “too good to be true” deal,
check the details of this inexpensive mixing
board. The model may be an analog mixer as
opposed to Alesis” MultiMix models, Behringer
Xenyx series, or Yamaha's MW-USBs, which
are digital mixers. Digital mixers connect
directly to the computer either via FireWire
or USB ports. The inexpensive analog mixers
connect with a computer through another
audio interface, most commonly an audio card.
Almost all computers have an audio input that
you can plug your analog mixer into. If you don't
have one or if you want a little better quality,
you can find audio cards starting around $100.
Admittedly, add-in cards have to be installed,
which you can either do yourself or pay some-
one to do for you. Once the card is working, you
need RCA cables to plug into the audio card, as
well as adapters for the RCA cables to connect
to the right mixer board inputs. Now comes the
time investment in figuring out how everything
(audio card, mixer, and cables) hooks up.

With digital mixers, you plug it into an available
USB or FireWire port. That's it.

In the case of mixers, you do get what you pay
for. Cheaper mixers often have inferior audio
output because of cheap pre-amps or other
components. They often are poorly constructed
and don'tlast as long. For something that sits on
the desk, it's amazing how much abuse a mixer
can take. That's not to say allanalog mixers are
cheap or that you can't find a quality analog
mixer, just that digital mixers are considerably
less hassle to install and offer some enhanced
functionality like recording multiple inputs to
multiple tracks in your recording software —
trust us here, that's powerful stuff when it
comes time to edit.

We mention that digital mixers can be attached
with either USB or FireWire. Choices, choices,
choices . . . is there no end to this podcasting
buffet? FireWire, or IEEE 1394 as the geeks call
it, is generally a bit more expensive, but is less
error-prone and tends to put less load on your
computer’s CPU than USB. On the other hand,
your computer may not come with a FireWire
port, requiring an add-in card — yes, more
money to consider.

6. Power up your mixer by turning on the Main Power and the
Phantom Power switches. See Figure 2-6.

7. Start your computer.

8. From the manufacturer’s CD, install any drivers your USB/FireWire

mixer may need.

Follow the instructions according to the manufacturer’s enclosed docu-
mentation. Restart your computer if necessary.

Most USB and FireWire audio hardware works just fine on Macs without
the need for driver installation, but check your audio hardware manuals
just to be safe.
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And that’s it! You're ready to record with your USB or FireWire mixer. Now
with headphones on your head and some toying around, you can set levels
on your mixer good for recording.

Before filing away the reference manual that came with your mixer, be sure
you know how things work. Buttons like the “Mix to Control Room” suddenly
make sense to you as opposed to being “that button that needs to be down
when I record”. Getting a grasp of how things work on your mixer only makes
you a better podcaster, so keep that reference manual close by and set aside a
few pockets of time to clock in some reading time with it.

Accessorize! Accessorvize! Accessorize!

A microphone and a mixing board are just the beginning when it comes to
putting together your audio suite. You now need to add the final touches, as
Martha Stewart would no doubt tell you if she were helping you with this pro-
cess. Now when it comes to accessories, Martha might make suggestions like
a doily for the mic stand or a sweet, hand-knitted cover for the mixer. When
we talk about accessories, we have something different in mind. Here are
some optional add-ons that can help you produce a rock solid podcast:

1+ Headphones: Some of the best advice in podcasting comes from our
Technical Editor, accomplished podcaster and producer Steve Eley (www .
escapepod.org): Invest in a nice pair of headphones. Headphones help
you monitor yourself as you speak. That may seem a little indulgent, but
by hearing your voice, you can catch before playback any odd trip-ups,
slurred words, or missed pronunciations.
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The G-Track: The best of both worlds

So far we've been talking about microphones
and mixers as being two separate entities, but
Samson Technologies — the same people
behind the ultra-portable C01U Recording Pak —
decided to take the audio equivalent of chocolate
and peanut butter and combine them into one
sweet device: The G-Track, shown in the figure.

This microphone is a lot more than just a studio
condenser mic. The G-Track has inputs built
directly into the mic for an additional audio
source (labeled as “Instrument” butit can really
be for any audio input) and for headphones.
With the mic’s basic interface, you can now mix
in secondary audio with little to no crosshleed

from whoever is on the mic. All this, and the
microphone is completely USB-powered, the
latency kept at a minimum as the headphone
jack is closer to the signal than a computer’s or
mixer's headphone jack. The G-Track is a com-
pletely portable studio condenser mic solution;
and for a podcaster into music, mixing, or simply
on-the-go, this mic’s potential can really get the
audiophile’s creative juices going. To hear the
G-Track in action, listen to the second season
of Podcasting For Dummies: The Companion
Podcast, featuring Phil Rossi on guitar and his
opinion on this mic’s potential from the musi-
cian’s perspective.
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We suggest you invest in good headphones before you spend a lot of
money on a better mic, or else you won’t know how good the microphone
is. Good headphones are nice to have for monitoring, but really show
their value during the editing and mastering process.

Another advantage with headphones is they have better sound quality than
your computer’s speakers as well as reduce ambient noise around you if
you purchase what are called closed-ear headphones. Keep it simple for your
first time out with a pair of the Sennheiser HD202 closed-ear headphones
for around $20. These headphones end in a !/s-inch jack but come with an
adaptor that makes them a !/+~inch stereo male jack (as shown in Figure 2-7),
plugging directly into your mixing board. For more on headphones, how to
shop for them, and the different kinds out there, check out Expert Podcasting
Practices For Dummies, by Tee Morris, Evo Terra, and Ryan Williams.

There are those Bose Noise Cancelling stereo headphones you see adver-
tised on television for $300, promising the highest quality for audio listening.
Note, we say listening. Not recording and editing. Any headphones you
see listed as noise-cancelling are going to be terrific for listening to
audio, but those headphones aren’t the best for recording and editing.
You want to be able to hear the noise that these headphones cancel out
so that you can eliminate it before a word is recorded. The best noise
reduction and elimination happens before and during recording, not
afterward. For podcast production, stick with closed-ear headphones
sans the noise-cancelling feature.

1 Cables: As mentioned in the “Investing in a high-end mic” section earlier

in the chapter, your newfangled microphone may arrive without any
cable — and buying the wrong cable can be easy if you don’t know jack
(so to speak). So check the mic’s connector before you buy. With many
high-end mics, the connectors aren’t the typical RCA prongs or the !'/~inch
jack shown in Figure 2-7; instead, you use a three-prong connection: a 3-pin
XLR male plug. It connects to a 3-pin XLR female plug, as shown in Figure 2-8.
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Zoom H2: Podcasting-on-the-go

The idea of “portable podcasting” had a lot
of limits hemming it in at one time, ranging
from how mobile the studio could be to figur-
ing out the ideal conditions for a small, built-in
condenser mic to the audio’s overall quality.
Then in 2006, Samson Technologies (www .
samsontech.com) introduced the Zoom
H4, an impressive (if not intimidating-looking)
portable recorder-player-mixer that raised the
bar for portable podcasting. It was thought
nothing could beat it . . . until Samson rose to
this challenge in 2007 with the Zoom H2 — a
lightweight, unobtrusive, all-in-one solution for
portable-podcast recording.

As the iRiver was considered the must-have por-
table recording device in 2005, so now is the H2
Zoom, seen everywhere at the 2007 Podcast &

New Media Expo. It comes as no surprise this
device is from Samson that, since the unveiling
of the CO1U, has aggressively targeted podcast-
ers looking to keep their productions portable. At
$200, the H2 records directly to SD Media (up to
4GB) or to your computer with its built-in micro-
phone, a microphone capable of 90°, 180°, or full
360° Surround Sound pickup. The H2 can record
directly to MP3 format (in a variety of bitrate com-
pressions), to WAV format (also in a variety of
bitrate settings), and in a multi-track format.

Fitting in the palm of your hand, the recorder
also offers a Line In and External Mic Input and
an easy USB interface with your computer. This
unit makes a great portable rig or startup unit
for the beginning podcaster.
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To plug a microphone into your mixer, you want to specify a 3-pin XLR-
to-XLR male-to-female cord; the female end connects to the mic, the
male end to the mixer. These cables begin at $9 and work their way up,
depending on the length of the cord and quality of the inputs.

1 Microphone stands: On receiving the microphone and possibly its
shockmount, you may notice the attachment for a mic stand . . . but no
mic stand comes with your new mic. It’s your responsibility to provide
one, and although that may sound like an easy buy, your options for mic
stands are many, each with their advantages.

A simple desktop mic stand can run you around $10 and is the most basic
of setups. When shopping for the right height and make, you’ll notice
other stands like a boom mic stand around the $100 range.

The type of mic stand that is best for you depends on what you want it
to do and how you want to work around it. With the inexpensive desktop
stand, you're all set and ready to go without the extra hassle of position-
ing and securing a boom stand to your desk. The boom stand, though,
frees up space on your desk, allowing for show notes and extra space for
you to record and mix in. Consult your budget and see what works for you.

v~ Pop filters and windscreens: Go to any music store (Radio Shack, Guitar
Center, and so on) and ask for pop filters and windscreens, which are both
shown in Figure 2-9. Both devices can help soften explosive consonants
(percussive ones like B and P) during a recording session. A windscreen
can also reduce some ambient room noise. Using both on one mic could
be overkill, but these are terrific add-ons to your microphones.
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Chapter 3

Building Your Podcast's
Digital Workstation

In This Chapter

Trying out inexpensive software

Going for broke: Big-budget software

Creating an RSS feed

Finding a host for your podcast
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A fter you have your recording equipment in place, plugged in, and running,
it’s time to take a look at audio-editing software packages. These are

the applications that help you take that block of audio marble and chisel the
podcast that is hidden within it.

As with digital photo editors, DVD-authoring software, and word processors,
software for audio comes in all sizes and all costs, ranging from free to roughly
an entire paycheck (or three). Like any software package, the lower the cost,
the simpler the product and the easier it is to understand, navigate, and use for
recording. However, as the software grows more complex (and expensive), the
features that offer advantages for pro-level work become abundantly clear. In
this chapter, we run down some of the audio recording/editing software that
might be right for you.

For when you have your show recorded and cleaned up, we also explore options
for you to share your masterpiece with the rest of the rest of the world. The real
power of podcasting is the ability for listeners to subscribe to a “feed” and get
your show automatically delivered to their computer rather than download it
manually from your Web site. The piece that makes all this magic happens is the
RSS feed. We introduce you to some software to help you manage your feed here
and dig into the details in Chapter 12.

When you have software and hardware in place, test your setup to make sure
everything works. Take a look at your application’s preferences so that your
sound input and output are going through your mixer, bring up the volume on
the channel on the mixing board that your microphone is connected to, and
then listen to yourself through your headphones.
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Whoever said “you can’t get something for nothing” didn’t know about pod-
casting. It’s amazing what kind of product you can turn out with little or no
monetary investment.

Audacity: Who says you can’t
get something for nothing?

Audacity (shown in Figure 3-1) is a piece of software that quickly became a
podcaster’s best friend. It’s easy to see why: It’s free and simple to use. It’s
available for downloading at http://audacity.sourceforge.net.

Designed by volunteers who simply wanted to “give back to the Internet”
something cool, Audacity is designed for a variety of audio capabilities such

as importing, mixing, editing, and exporting audio. For podcasters, it’s become
the must-have tool for recording voice straight off a computer. It’s also com-
patible with Windows, Macintosh, and Linux. (We want to send a big thank you
to the volunteers who went out of their way to show that yes, software can be
made available for any platform, provided the creators are driven enough to
make it happen!)

But what can a free piece of software do? Well, for openers, Audacity . . .

v Records live audio through microphones or mixer channels

v Can record up to 16 channels at once

v Imports various sound formats for editing and remixing

v Exports final projects to WAV, AIFF, AU, and MP3s

v Grants the user unlimited Undo and Redo commands

v Can create an unlimited number of audio tracks

»* Removes static, hiss, hum, and other constant background noises

v Offers a wide variety of effects to manipulate your audio (and these
effects are expandable via third-party plug-ins)

v Records at an audio quality of up to 96 kHz

Make sure you access the right URL. Remember that the Web site for Audacity
ishttp://audacity.sourceforge.net and not www.audacity.com. If
you happen to enter the latter address in your browser, you find yourself at
Audacity, Inc., a Seattle, Washington-based janitorial service.



Chapter 3: Building Your Podcast's Digital Workstation

Figure 3-1: |

Audacity is
afreeware
application
that allows
you to edit
audio and
create MP3
files.
|

: NE-0501
%%” v T ”| s YR Bl ¢ (%@ W[4E| || [ #2220

(o |m|w|w| @ .
L. -_L_,a.-*! '
0 0 200 230 300 30 00 430 s:00 s30 600 630 7:00 70 800

@End  Olength  Audio Position

4a00 ) | 00N0OmO0sT | DONOOMO0ST | DONOOmODsH

Gick and drag to select audio

Cakewalk’s Pyro for the PC:
Podcasting is so HOT!

Audacity is an excellent piece of software for the basics, but what if you desire
more control over the capabilities and features of your audio-editing package?
Are you looking for more recording options, additional audio filters, built-in
multitrack recording, and pre-recorded music loops? (Gads, what some
people will do to set a mood or a tone for a podcast.)

Pyro (http://cakewalk.com/Products/Pyro) is part of the consumer
line of audio software offered by Cakewalk. If your computer has the horse-
power and the hard drive space, you can buy Pyro and directly download it
for around $20. If you prefer a hard copy of the software, though, you can also
make that happen for a few dollars more (around $30, if you're counting). And
just so you know, Pyro is available only for Windows.

Pyro (shown in Figure 3-2) offers its users some serious goodies:
v Record audio from a microphone or other media (CD, LP, cassette, or
Internet audio stream).
v Display and edit beat-by-beat with audio waveform displays.

v Pro-grade audio engineering tools included: DeClicker, DeClipper, DeNoiser,
Loudness Maximizer, Reverb, and other post-production effects.

v Support for MP3, WAV, and WMA files.
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Figure 3-2:
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Pyro allows users to record, edit, mix, and produce audio compositions, whether
it is an original score for your podcast, a continuous music mix, or just you and
your own personal soundtrack. Between its easy audio-editing features and
Cakewalk’s collection of original audio samples (called Cakewalk Loops), it’s
a breeze to set your own themes and special effects.

GarageBand: Moby in your Mac!

Pyro is an economic audio package for the PC user looking to go beyond
Audacity, but what about Mac users? For people in the minority of the com-
puter world, it’s always a frustration to hear software developers say, “No,
we won'’t be making this product available for Mac users.” Sometimes Mac
users seem to be denied the coolest toys and utilities because they just
aren’t offered for the Mac operating system (maybe a penalty for thinking dif-
ferently, but still . . .).

Apparently Steve Jobs and his crew heard about this injustice, and shortly
after the iPod took off, there came a gem that made it more than cool to be a
Mac user — especially one who’s into podcasting. Mac-using podcasters call
this gem GarageBand.

With hundreds of music loops that can easily switch from one instrument to
another, GarageBand (shown in Figure 3-3) makes royalty-free music easy to
compose. Many of the loops are editable and, with a bit of tweaking, can set
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Figure 3-3:
GarageBand
(pictured
here in the
Podcast
mode) is
easy to use
and easy

to have a
blast with.
|

the right mood for your podcast. With the release of iLife 08, GarageBand has
a few new additions (and one blessed repair) to enhance its initial version:

v Multitrack recording supports simultaneous tracks recording independent
audio sources all in one recording session.

v With the Multi-Take feature, you can now do multiple readings or
segments and save them as separate files. Then you can pick which one
you want for the final.

»* You can see a display of the music, with actual notation, in real time.

» You can choose to record your podcast as a Music Composition (Old
School podcasting with GarageBand) or take advantage of the extra
features available in the Podcast mode; note the extra track at the
top in Figure 3-3.

» You can save the recordings as loops in the GarageBand library.

Upgrading from older versions of GarageBand means purchasing the complete
iLife package, starting at $79.99. There is no separate upgrade for GarageBand,
but the good news is that the new GarageBand also includes the latest versions
of iPhoto, iTunes, iMovie, iWeb, and iDVD, each of which is a terrific application
in its own right.
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GarageBand’s most appealing asset is its hundreds of sampled instruments
available in loops. You can easily edit and splice together these loops with
other loops to create original music beds of whatever length you choose. Pre-
recorded beds range from Asian drum ensembles to Norwegian Folk Fiddles
to Blues Harmonica; these ensembles are easily incorporated with editable
loops of Classic Rock piano, Southern Rock, or Emotional Piano reminiscent
of films like Love Story and Sense and Sensibility.

GarageBand also provides a capability — with many (not all) of the samplings —
to create your own musical theme. Sure, some instruments may sound better
than others, but you might — with a bit of trial and error — create an original
melody that serves as the best royalty-free intro and exit for your podcast.

If you're planning to do a bit of composing in GarageBand, be warned. Much
like working with video in Final Cut, GarageBand is a lot of fun but can easily
soak up free time that you would normally dedicate to recording. So if you
need to get in touch with your inner Mozart, set aside a good-size pocket of
time to put together your desired riffs. You have many options to choose
from; as with podcasting, it’s best not to rush the process.

GarageBand is easy to tinker with, navigate, and understand within a short
span of time. Plenty of terrific books are available for mastering all the nuances
of GarageBand. We cannot praise this application enough — and with expansion
packs from Apple (called Jam Packs) that add instruments, riffs, and loops to
your GarageBand and start at $100 each and other loops and special effects
available from other software vendors (and usually stocked online or at your
local Apple Store), this unassuming software offers a lot to the podcaster.

WireTap Studio Pro: Recording
and editing made easier

If you're not interested in the musicality of GarageBand (or any of the other
applications offered in iLife), Mac users have another handy application for
recording podcasts and it comes with a few features not found in Audacity.
This renegade of audio software is called WireTap Studio Pro (www.ambrosia
sw.com/utilities/wiretap).

What makes WireTap Studio Pro (shown in Figure 3-4) unique is its ability to
record audio from nearly any source — not only coming in from microphones
and musical instruments, but also from Internet audio streaming and live
audio chats from Skype and iChat. WireTap even allows you to mix in music
from your iTunes libraries!
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Figure 3-4:
WireTap
Studio Pro
makes a
podcast
happen with
only a few
clicks.
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WireTap sports the familiar features that Audacity, GarageBand, and Pyro
possess — such as converting analog music to digital; preparing MP3 files
specifically for podcasting (by adding ID3 tags, setting bandwidth, and so on);
and supporting audio formats such as WAV, AIFF, and MP3. The latest version
of WireTap offers some appealing capabilities:

v Records incoming audio from microphones or other input devices.

v Records and encodes audio into a wide variety of file formats including
all the popular ones needed for podcasting (AIFF, WAV, MP3, AAC).

v Simultaneously records two sources of incoming audio (on a per-
application basis) into separate tracks.

v Provides lossless/non-destructive waveform editor.
v Provides Apple and Camel Audio digital effects for post-production.
v Provides basic MP3 and MPEG-4 Audio ID3 tag editor.

v Offers automated options for scheduling recordings.

Retailing for about $70, WireTap Studio Pro is a reliable application for Macintosh
podcasters and prides itself in being a one-stop shop for podcasting needs.
It’s a non-Apple product that can record in Apple’s audio-compression formats,
easily records streaming audio signals that tend to elude other audio-recording
and -editing software, and also offers editing tools for both audio and ID3 tags
so you can create the podcast from beginning to end, making it ready for
upload. Keep a sharp eye on this new player; it’s carving a niche for itself in
the podcasting community.
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Sharing with the rest of the class

We're particularly keen on GarageBand's
Preferences, which let you organize your final
AIFF files in an iTunes playlist. When you're
done with that particular recording session
(what GarageBand refers to as a “song” as
you're using the “0ld School” approach to pod-
casting), choose Share=>Send Song to iTunes.

The file is then exported in AIFF and immedi-
ately dropped into the playlist you named in
GarageBand, where it's tagged with your name
(or podcasting ID) and the “album” (which can
be anything from the show title itself to the air
date of the show). See Chapter 9 for details on
adding ID3 tags.

The Sky’s the Limit: Big-Budget Software

If you're lucky enough to have unlimited funds and resources to build your
podcasting studio, this section on software is for you. A majority of podcasts
are working on the bare-bones plan, and so far the investment in the equip-
ment we've recommended (in Chapter 2) is for a budget of under $500 —
provided you feel like making an investment in a professional microphone,

mixing board, or software.

You may hear podcasters say “content is king,” meaning it doesn’t matter how
good you sound if you don’t have anything to say. What makes a good podcast

is the same whether you’re on a budget of $0, $500, or $Ridiculous.

The difference is in the sound you can get. For the corporate entity, govern-
ment agency, or professional organization venturing into podcasting, sound
quality is crucial as your reputation and experience are now being “socially
tested.” Do you not bother with the details, or do you raise the quality bar?
Commercial podcasting demands nothing less than the best in audio quality.
Depending on your budget and the future of your podcast, you can purchase
and set up the higher-end audio hardware.

Podcasting is still a new media, but if you want to push its envelope and have
the bucks, high-end audio software gives you full control over every aspect of

the audio you're recording.

Adobe Audition

At one time, a favorite software application was CoolEdit. But when Adobe
Systems purchased it and repackaged the software as Adobe Audition (shown
in Figure 3-5), it got even better. Audition (www.adobe.com/products/

audition) is offered as an upgrade (provided that you meet the upgrade
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Figure 3-5:
Adobe
Audition

(formerly

CoolEdit)

is the PC/
Windows
software for
editing and
engineering
audio that
gives the

podcaster |

complete
control.
|

eligibility) at $99 or a full stand-alone version is available at $349. Audition’s
features are nothing short of awesome:

v 128 tracks available to the user
v Can record 32 different sources simultaneously
v Offers 50 digital sound effects to enhance your audio tracks

v Provides 5,000 royalty-free loops that can be easily edited and compiled
to create your own music beds

v Offers Surround Encoder for 5.1 surround sound mixing for audio only
or integration into an Adobe Premiere Pro project

v Offers audio restoration tools like Click/Pop Eliminators and Noise
Reduction that can restore recordings from vinyl and cassette record-
ings; remedy pops, hisses, hums; and fix clipped audio

v Offers integrated CD burning for audio

What makes Audition so appealing to heavily engineered productions such
as Slice of SciFi (http://sliceofscifi.com) and Murder at Avedon Hill
(http://pgholyfield.com/maah) is the complete control users have
over the audio. Audition gives you dominion over pitch, wavelength, time-
stretching, background-noise removal, and Dolby 5.1 stereo output, making it
a staple in the digital audio industry.

Audition runs exclusively on the Windows platform, but fret not, Mac users.
There’s an Audition equivalent for you called Soundtrack Pro, and since its
upgrade to version 2, it’s out to make itself a must-have tool for the profes-
sional podcaster.
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Apple Soundtrack Pro

Apple Soundtrack Pro (http://apple.com/finalcutstudio/sound
trackpro) is the up-and-coming software in the industry and one of many
incredible applications that make up the Apple Final Cut Suite. In its latest
incarnation, Soundtrack Pro (shown in Figure 3-6) has been given features
built for Mac-based podcasters:

v Supports multitrack recording.

v Displays multiple audio takes in a single window. After you select your
desired takes, Soundtrack Pro compiles them for a final composite —
complete with crossfades (the simultaneous fading from one audio source
into another) — creating seamless playback for the end result.

v Copies audio effects and EQ settings from another clip — setting them on
an audio clipboard for quick access and application or saving them as a
preset for future use.

v Features specific functions for producing podcasts, including audio-only,
enhanced, and video podcast formats, such as chapter, artwork, and
URL markers.

v Outputs multitrack audio projects into 5.1 surround sound.

v Automatically updates any changes made in Final Cut Pro.

Soundtrack Pro sounds like a dream come true, but here’s the reality check:
It’s no longer a stand-alone purchase. It’s bundled with the Logic Studio for
around $500 and the Final Cut Suite for a whopping $1,300.
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A more economic option for podcasters who want to go beyond GarageBand
is Logic Express (priced at $200), a digital workstation geared for the modern
musician. Many of the higher functions of Logic Express focus on composition

and music arrangement, and the interface is very different from GarageBand
and Soundtrack Pro (which share enough in common that you can make the
jump). For its price, though, you can accomplish a lot with it.

Gluing It Together with RSS

The hardware (mics and mixers) and the software (GarageBand and
Audacity) are necessary to record audio and create the podcast media file.
That’s the fun and creative part. But to make your recording a podcast, you
need to get your hands dirty on the tedious and technical parts and add two
more three-letter acronyms to your vocabulary: XML and RSS.

equation.

RSS is a “flavor” of XML. Chapter 12 plunges rather deeply into RSS 2.0, but
here we give a fast overview of where the RSS 2.0 feed fits into the podcasting

It's all about the <enclosure>, baby

If you already have a blog, you're probably
already generating an RSS feed — or have the
ability to do so. Although podcatching clients
can read this existing RSS feed, the feed needs
to include the <enclosure> tag in order for
podcasting to work.

Dave Winer invented the <enclosure>
tag in early 2001 for the purpose of embedding
links to large audio, video, or other “rich media”
elements into an RSS feed. At the time, Dave and
Adam Curry were trying to solve the click-and-
wait problems inherent in big files such as audio
and video. Typically, if a user clicked a link to a
30MB file, several minutes would drag by before
the file was completely downloaded to the user’s
hard drive and was usable. Not a good user expe-
rience, regardless of what's in the file.

With the advent of the <enclosure> RSS
element, users could subscribe to places
where they expected large files as a regular
occurrence and move the downloading of those
files to the early hours of the morning, when the
users were snug in bed and a ten-minute down-
load was no big deal.

Of course, users back then had to be techni-
cally savvy to take advantage of this new RSS
element. It wasn't until the summer of 2004 that
Adam Curry wrote what most consider the first
podcatching client — a simple, user-friendly
desktop program that extracted enclosed media
files from RSS 2.0 feeds called RSS2iPod. And
behold! Podcasting was born.
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We’ve helped dozens of podcasters get started — and in nearly every case,
the XML/RSS step is the biggest source of confusion. So, to get the basics out
of the way, XML (eXtensible Markup Language) is a language, and RSS (Really
Simple Syndication) is a file format built on XML. XML’s purpose is to allow
systems such as computers, network devices, and other gadgets to exchange
information in a structured format. The RSS file is that bit of information that
the podcaster publishes so others can use their podcatching software to
check for new content automatically.

If that explanation doesn’t do it for you, try this analogy about Star Trek
geeks and trained monkeys. Consider this: Star Trek geeks (or just STG) know
everything about their passion in life — Star Trek. Perhaps you’'ve seen other
forms of geekiness expressed toward other public icons — say, Apple com-
puters, the Boston Red Sox, or The Beatles. But you know the type of person
we’re talking about, right?

As a podcaster, you need a program that acts like a Star Trek geek. Your virtual
STG has a single job: To boldly know everything there is to know about your
podcast — and to flip happily into data-dump mode every time someone
drops by to see what’s new.

And the trained monkey? Well, listeners don’t have time to drop by and
check on each and every podcaster they want to hear. So the podcast listener
employs a trained monkey to tell him exactly which Star Trek geeks to check
with — and how often. When an STG has something new to say, the trained
monkey comes back to his owner with the specifics. (And they said nobody
could tie Star Trek, monkeys, and podcasting together. Ha!)

Here the role of the STG is filled by the RSS 2.0 file created by the podcaster —
and the trained monkey is actually the podcatching client (iTunes, for example)
used by the listener.

As a podcaster, your job is not only to create your RSS 2.0 file, but also to
make sure you keep that file updated and current each time you post a new
podcast media file. Lucky for you (and us too), plenty of software solutions
make this step a breeze.

Simplify the process and get a blog!

If you're looking to spend the least amount of time dinking around with your
RSS feed, look no further than the popular blogging software solutions. Blogs
are easy to set up, are often free, and ease the process of generating and
updating of RSS feed by doing it automatically.

You can choose from dozens of blog software packages, each with a variety
of bells and whistles that are designed to make your updates (including
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your RSS feed) as easy and/or customizable as possible. For a crash course,
check out Syndicating Web Sites with RSS Feeds For Dummies and Blogging For
Dummies (both published by Wiley); they can help you choose which blog
software might be right for you. Meanwhile, here are a few options:

v WordPress (http://wordpress.org): Perhaps the most popular blog-
ging solution in the writers’ eyes, WordPress has many advantages over
other free blogs. Not only is it easy to install and get running, but it also
supports podcasting out of the box. When you incorporate the PodPress
plug-in (available at www .mightyseek.com/podpress), podcasting takes
on a whole new level of “user friendly” options as podcasts can be dis-
tributed via RSS or played directly through the blog. There are also thou-
sands of WordPress and user-developed templates that can be used as is
or customized (with a bit of knowledge on how HTML and PHP work) to
fit your specific look and feel for your podcast. Oh, and it’s free. To make
incorporation into your Web site seamless, many hosting companies
like DreamHost (http: //dreamhost.com) offer packages that have
WordPress preinstalled. Figure 3-7 shows the WordPress signup page.

There are two basic options where to put your blog. Unless you're an
ubergeek, run your own server farm, load operating systems, handle
patches, and have a hefty Internet connection, you're likely to let some-
one else do all that work for you. Prices and products vary. For the pod-
caster, there are two varieties — the non-hosted model blog, where you
get to choose the blog software, and the hosted model where the choice
is made for you. In the non-hosted model, sure you get to choose what
blog software to use, but there is a little more work involved with setting
it up and maintaining it. In the hosted model, you generally give up some
of the flexibility for ease-of-use.

~ Blogger (www.blogger . com): Blogger holds the distinction of being one
of the most widely used blogging systems. It’s available only in a hosted
model and is still the de-facto standard for most of the blogging world.
While free from cost and any setup confusion, Blogger is somewhat lim-
ited in functionality, customizability, and ease in troubleshooting when
something goes wrong. (In other words, if something does go “boom,”
you're at the mercy of Blogger’s tech support.) Although it does allow you
to create an RSS 2.0 template, it won’t allow you to include the podcast
media file as WordPress does. Several workaround solutions exist, but
your Blogger account won't allow you to podcast without some work.

v LibSyn (http://1libsyn.com): Don’t be surprised if Liberated
Syndication turns up quite a lot in this book. LibSyn is a combined blog/
hosting company specifically designed for podcasting. Although it may
not address all your needs, its ease of use and all-in-one nature should
not be passed up. Some podcasters choose to use LibSyn as their hosted
solution, others use it to store their podcast files while their blog is on a
non-hosted solution somewhere else. Either way, we think LibSyn’s pric-
ing is quite reasonable, starting at $5 per month.
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Figure 3-7:
WordPress
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Fine. Do it without a blog.

Blogs are great if you want to include text and other information along with
your podcast. But if you're enough of a purist that you want your podcast to
stand on its own without a supporting Web site, that’s okay, too.

A place to put your show notes — and a home for your podcast, where folks
can get your e-mail address or other pieces of data they may not catch on the
show — is a really good idea. If you're confident that you prefer your podcast
to stand on its own and exist only as an RSS 2.0 file, these options may be
what you're looking for. If you're not sure, we suggest avoiding this route.

Take a closer look at some of these Web sites to provide a home for your
podcast, sans blog. With these services, your podcast is simply an RSS file
and an accompanying MP3 file, making show notes, additional comments,
and hyperlinks a bit of a challenge; but you can podcast without a blog if you
please, and here’s where you do that:

v Hipcast (www.hipcast .com): For $9.95 per month, Hipcast lets you
record, host, and publish MP3 files, generating a custom RSS 2.0 file
for you automatically. No blog or hosting company is required. In fact,
these folks even came up with a way to record and upload your audio
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file right in your browser — no recording software required. This is a
great option if you want to test the waters of podcasting without making
a huge investment of time or money.

v Podcastamatic (http: //kenwardtown.com/podcastamatic):
Podcastamatic automates the creation of an RSS 2.0 file based on the con-
tents of a folder on a Web server. It’s not for the technical neophyte, but
if you already have a Web server and don’t really want to run blogging
software of any flavor, this is a solid free option.

Once installed and configured on your server, Podcastamatic watches a
particular folder for new MP3 files you upload. When it detects changes
to the folder, it generates a new RSS 2.0 file. It even creates or populates
an HTML page if you so desire.

v Feeder (http://reinventedsoftware.com/feeder): Feeder provides
a simple interface that gives a lot of flexibility to podcasters who already

maintain an active site. You fill it out, and it cranks out an RSS 2.0 file
that’s ready to be uploaded to the server. Very easy, full featured, and
self-contained, it’s popular among many podcasters. It’s for Macs only,

and it’s a steal at $29.95.

FeedBurner turns any blog into a podcast

Rick Klau and the folks at FeedBurner deserve
a nod for their dedication to a podcasting
approach that's 100 percent For Dummies—
friendly. With a free FeedBurner account, you
can convert an existing RSS, Atom, or other
syndication feed to a podcast-ready feed in
three simple steps:

1. Sign up for a free FeedBurner account at
www. feedburner.com.

2. Burn your existing feed.

Enter the URL of your blog’s feed into the
easy-to-use interface and select the | Am a
Podcaster option. Then click the Next button.

3. Confirm your feed title and address and
then click the Activate Feed button.

FeedBurner then converts any pod-
cast media file links into an embedded

<enclosure> element in a new feed,
provided you link the podcast episode to
the blog post. (Remember to provide a link
to the MP3 in the post.)

That's it! You now have a new podcast-ready
RSS 2.0 feed.

FeedBurner is now watching your original blog
feed. The next time you make a post and include
a link to a media file (MP3, M4V, PDF, . .. what-
ever), your new FeedBurner feed automatically
does the behind-the-scenes magic necessary to
get the <enclosure> tag pointing at the file
you referenced in your post. Although your orig-
inal feed (maybe www. fishingalaska.
com/index.xml) doesn't change, your new
FeedBurner feed (perhaps http://feeds.
feedburner.com/FishingAlaska) is
now podcast-friendly and ready to be served to
podcatching clients.
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Doing it by hand

What’s this about podcasting by hand? Are you crazy? No, seriously — gen-
erating an XML file in RSS 2.0 format isn’t overly difficult, but it’s extremely
easy to mess up! Sure, you could open Notepad, TextEdit, or any text editor,
download a few examples, and generate your own code, but we advise
against it.

However, some code warriors — in the same vein of hand-coding HTML,
JavaScript, and other markup languages — insist on composing their own
code from the ground up (you glutton for punishment, you). You’ll want to
jump ahead to Chapter 12 for an in-depth look at writing a simple RSS 2.0
feed. We also recommend getting extremely comfortable with Syndicating Web
Sites with RSS Feeds For Dummies or Beginning XML, 4th Edition (or at least
keeping a copy of each under your pillow); those books go into more detail
on these topics.

When you finish putting together your home-spun, handmade RSS feed, you're
going to want to make sure your is are dotted, ts are crossed, and open state-
ments are closed. Go to Feed Validator at http://feedvalidator.org and
enter your feed’s URL (not the host blog or site, but the feed itself) and then
click the Validate button. Feed Validator tells you whether your feed is air-
tight. You can also find the full technical specifications for RSS 2.0 and a few
answers to questions you may have about RSS.

Finding a Host for Vour Podcast

a\\J

Unless you already have hosting taken care of, you're going to need a place
on the Web to put your stuff. You know — your podcast media files, RSS feed,
and show notes for your podcast. You also need a way to get them up there.

Getting a hosting provider is a breeze, with hundreds of companies all vying
for your precious, hard-earned money each month. The good news is that all
this competition has brought down the cost of hosting packages significantly.
The bad news is that you have to go through a lot of clutter to reach the right
selection.

This section covers the basic needs for most beginning podcasts and mentions
a few pitfalls to watch out for. In Chapter 10, we get into the process of actually
moving your files to your host.

Don’t rush into a hosting agreement just yet. We suggest reading the rest of
this chapter as well as Chapter 10 before forking over your credit card. We
cover lots of good information that can help you narrow your choices.
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When you're comparing hosting plans, try not to get bogged down in the number
of e-mail addresses, MySQL databases, subdomains, and the like. All of those

features have their own purposes, but as a podcaster, you have only two wor-
ries: how many podcasts the site can hold and how much bandwidth you get.

Size does matter

Podcast media files are big. Unlike bloggers, podcasters eat up server space.
Where simple text files and a few images take up a relatively small space,
podcast media files tend to be in the 5MB to 50MB range. And that’s just for
audio. For video, the size can double.

Here some suggestions for zeroing in on what you need storage-space-wise:

v Think about how many podcasts you want to keep online and plan
accordingly. If you have a plan that isn’t constrained by storage space,
then you don’t need to worry about it.

v Consider the amount of server space you’ll need to host your blogging
software, databases, text, and image files. For example, Tee is using well
over 3GB of space for just one of his podcasts, and not all of that covers
his media files! Of course, he’s been building his Web site since 2001 and
didn’t get to that level overnight. (Podcasting did help quite a bit though.)

Podcasters should look for hosting plans that include at least 3GB of stor-
age space. As of this writing, several host providers charge less than $10 per
month for that much space, and more.

Bandwidth demystified

Of equal importance to storage space is bandwidth, an elusive and often-
misunderstood attribute of Web hosting that is critical to podcasters. Bandwidth
refers to the online space needed to handle the amount of stuff you push out
of your Web site every month. The bigger the files, the more bandwidth con-
sumed. Compounding the problem, the more requests for the files, the more
bandwidth consumed.

For instance, the bandwidth for Farpoint Media’s Slice of SciFi is over 10 tera-
bytes a month — that’s pretty impressive. At the initial launch, the amount
of information exchanged (read: downloads) was modest, but then people
started talking. With the rise in popularity (thanks to interviews with people
like Bruce Campbell, Stargate’s Amanda Tapping, Grant Wilson of Ghost Hunters,
and star of Star Trek:TNG and Web 2.0 Wil Wheaton), the downloads increased.
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So did the demands on bandwidth. Web hosts, in situations like this, must
consider when it’s time to allocate a larger bandwidth package to handle a
show — and that means more cash outlay for you.

And therein lies the double-edged sword of success. Most podcasters want
more listeners — and that means more podcatching clients requesting the
podcast media files. Bottom line: The more popular your show gets, the more
bandwidth is being consumed every month.

To simplify, pretend that you produce one show each week, and your show
requires 10MB of bandwidth. You publish the show on Monday, and your 100
subscribers receive your show that evening. You've just consumed 1,000MB
of bandwidth (100 x 10MB) for that week. But next week, more people have
found out about your incredibly amazing show, and now you have 200 sub-
scribers. Next Monday, your bandwidth increases to 2000MB, which gets
added to your previous week’s total to bring you up to 3,000MB. The new lis-
teners were so happy, they also download the previous week’s show, tacking
on an extra 1,000MB. You've just consumed 4,000MB (or 4GB) of bandwidth
for the month. You still have two weeks to go in the month, and if your num-
bers continue to climb like this, you will be burning through bandwidth (and
your Web host budget) quickly!

If you want even more detailed math on figuring out bandwidth needs, take
alook at Chapters 10 and 14. Both offer real-world tips on figuring out what
your bandwidth requirements might be. As a general rule, though, the longer
your podcast episodes are, the more bandwidth you will need. If you find a
plan that offers unlimited bandwidth, the problem is solved. Otherwise, you’ll
want to try and find a plan that’s high in the gigabytes. If you have a podcast
that’s both long and popular, start looking at plans that offer 1TB (that’s tera-
bytes) or more.

You have ways to avoid the issue of bandwidth, or at least make it less of a
concern even if you have large ambitions — as well as files. Chapter 10 talks
about some podcast-specific and some advanced hosting options. Even if
you don’t think you’ll have to worry about bandwidth, it’s a section to pay
close attention to because you'll likely be more popular — and perhaps more
wordy — than you think.
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In this part . . .

A podcast starts with a simple audio recording.
Whether you’re recording your voice or splicing
together various audio clips to create a show, every pod-
caster needs to know the ins and outs of the recording
process. In this part, we help you figure out what to
record, how to record it, and how to avoid some pitfalls
along the way.




Chapter 4

Before You Hit the
Record Button ...

In This Chapter

Finding a voice for your podcast

Using an outline or script

Deciding how long your podcast should be
Understanding legal issues

Tme to a classical radio station (and when we refer to “classics” here, we
mean Beethoven and Haydn, not the Beatles and Hendrix) and listen to
the DJs — oh, sorry, the on-air personalities — featured there. You'll notice
that they’re all speaking slowly and articulately, mellowed and obviously relaxed
by the melodic creations of greats such as Mozart, Wagner, and Joel. (Yes, Billy
Joel has a classical album — a pretty good one, too!) Although the on-air per-
sonalities of your local classical music station all sound alike, they sound dra-
matically different from the wacky Morning Zoo guys on your contemporary
hits radio station who sound as if they’re on their eighth cup of espresso.

When you hear people talk about finding your voice in broadcasting, that’s
what they mean. You come to an understanding of what your average audi-
ence wants (and to some degree, expects), and then you meet that need. This
chapter helps you develop the voice and personality you want to convey
when podcasting.

After you discover your voice, you will want to get ready for the show. This
chapter shows you what to do to prepare for smooth and easy podcasts that
(one can hope) will be glitch-free during the recording process. Preshow prep
is not only important, but also essential in making a feed worth catching. Even
the most spontaneous of podcasts follows a logical progression and general
direction, remaining focused on the podcast’s intent.
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Choosing a Unique Topic for Your Podcast

Before you can think about putting together a podcast, you need to decide
what topic you want to cover. At the time of this writing, a sample of what
people were podcasting (according to PodcastAlley.com) — listed by genre
from most to least common — looked like this:

Topic Number of shows
General 7,982
Music 6,891
Technology 3,854
Comedy 2,807
Religion & Spirituality 2,421
Business 1,816
Society & Culture 1,744
Education 1,558
Sports & Recreation 1,266
Video Podcasts 1,148
TV & Film 998
News & Politics 991
Health 977
Arts 952
Travel 514
Food & Drink 264
Environment 163
Games & Hobbies 110
Kids & Family 46
Science & Medicine 28

Government & Organizations 10

That’s a total of 36,540 podcasts — an increase of 30,000 since the first edi-
tion of this book was published in 2005. This averages out to roughly 50 new
podcasts going online every day.
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The first thing to understand about podcasts is that this activity isn’t all about
being “number one” in your chosen podcast genre. Granted, some podcasts
do vie for top honors on various polls. But instead of worrying about garnering
ratings (a topic that’s covered in Chapter 13), think about what will make
your podcast uniquely worth your effort and your listeners’ time. Here are
some ways you can create a unique podcast:

1 Study other podcasts. Before you can figure out what will make your
podcast unique, check out some other podcasts. The best way to find
out what makes a podcast worthwhile is to subscribe to a few feeds that
pique your curiosity.

Listen to these feeds for a few weeks (provided they’'re weekly) and jot
down what you like and don’t like about them. From the notes you take,
you might find your angle. Keep in mind that downloading and listening
to other podcasts should be educational and constructive, not a raid for
fodder for your own show.

Q\\x\NG! Don’t steal content, special effects, or content structure from another
Ry podcast. Approach others’ podcasts as you would someone’s Web
site. It’s okay to be inspired, as long as you don’t make your podcast a
carbon copy of your inspiration’s work. When you have your podcast
up, avoid criticizing another podcast in your own; criticizing someone
else’s work is no way to better yours. Stay on the pod-sitive side.

v Pick a topic you know. Whether you’ve decided to take on the topic
of music, religion, or technology, the best way to make your pod-
cast unique is to find an angle you’re comfortable with (Polka: The
Misunderstood Music, Great Travesties of Sports History, Forgotten
Greats of Science Fiction). There’s also the possibility that your initial
show may inspire an additional angle so unique that you’ll have to start
another podcast specifically to address that audience.

<MBER The content you bring — regardless of what genre it’s in — is unique because
it is your podcast. It’s your voice, your angle, and your approach to whatever
intent you pursue. Provided you maintain a high confidence level and genu-
inely enjoy what you're doing, people will tune in and talk to other listeners
about what you'’re podcasting.

Finding Your Voice

The broadcasting industry might not want to admit to this, but podcasting
and commercial radio share a lot in common. In the early days of what is now
a major radio genre, talk shows were reserved for National Public Radio and
news stations. In general, they were pretty dry and lackluster, bringing their
listeners the news, weather, and daily topics that affected the world — but
nothing particularly unusual or exciting.
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Then a guy named Howard Stern came along and changed everything in this
once-tiny niche! You can love him, you can hate him — you can claim to hate
him when secretly you love him — but Stern completely turned around what
was considered AM-only programming. Now talk radio is big business. Some
personalities are just out to entertain (Don & Mike, Ron & Fez); others use it
to voice their political viewpoints (Rush Limbaugh leaning to the right stereo
channel while Al Franken favors the left); and then you have the bottom-of-
the-barrel personalities (insert your least favorite on-air loudmouths here)
who turn you off radio and on to podcasting!

A majority of podcasting is just that: talk radio. Actually, a more accurate
description would be “homespun talk audio” because radio is broadcast whereas
podcasting is narrowcast. Each podcast has a different personality and appeals
to a different market. Finding your voice is one of the most challenging obsta-
cles that you (as a once-and-future podcaster) must clear.

Even if your podcast’s aim is entertainment, you have a message you want to
convey. That message will influence the voice you adopt for your podcast.

If you're podcasting an audio blog about life, its challenges, and the ups and
downs that you encounter, then maybe a soft tone — relaxed and somewhat
pensive — would be appropriate. But if you decide to go political — say you're
the Angry Young Man who’s fed up with the current bureaucracy — then it’s
time to fine-tune the edginess of your voice. That’s what you need for a
podcast of this nature.

After you discover the passion your podcast is centered around (see the preced-
ing section for tips on how to do that), here are some ways to find your voice:

1 Record your voice and then listen to what it sounds like. It astounds
us how many people hate listening to their recorded voice. It’s a fear
akin to getting up in front of people and speaking. When finding your
voice, though, you need to hear what your current voice sounds like.
Write a paragraph on your show’s subject. Then read it aloud a few
times and find a rhythm in your words. Expect the following:

¢ Talking too fast

¢ Swallowing small, one-syllable words like to, in

¢ Ignoring commas, thereby creating one long, run-on thought

¢ Lip-smacking, heavy breathing, and the unavoidable ahs and ums

You can edit out some of these problems (see Chapter 7), but you
should grow accustomed to hearing your own voice because you’ll hear
yourself again and again . . . and again . . . during the editing process.
The more familiar you are with how your voice sounds, the easier time
you’ll have editing your podcasts before publishing them online.

v+ Play around with the rhythm of your speech. You don’t have to be an
actor to podcast, but you can apply some basics of acting when you're
recording. One of these basics, as one of Tee’s acting professors told
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him, is to “Make a meal of your words.” This means to play around with
the rhythm of your speech. When you want to make a point, slow down.
If you're feeling a tad smarmy, pick up the pace. Above all, be relaxed
and make sure you don’t sound too contrived or melodramatic.

v Speak clearly. Another simple trick from the acting world to add to your
arsenal is to open your mouth wider. Many people talk with their mouths
mostly closed, but by opening up your mouth, you can gain clarity. So,
when making a meal of your words, it is good manners to chew with your
mouth open.

v~ Speak with confidence. Speak confidently about your topic. No one is
going to believe in what you have to say if you don’t believe in yourself.
It may take a few podcasts to find a groove, or you might hit the ground
running and have a podcast that immediately takes off. Just speak with
conviction and allow yourself to shine.

v Develop your podcasting personality. After you know what you sound
like when you record, here’s where you develop your podcasting personal-
ity. Is your persona going to be light, fun, and informal, or something a little
edgy, jaded? Is your message taking an angle of marketing, politics, or reli-
gion? Or are you podcasting a love of music, science, or your Macintosh?
Your persona should generally match the theme of your show. If you're doing
a show on classical music, a persona of a morning radio DJ probably isn’t
going to work. If you're taking a light-hearted look at politics, you may want to
have a little more levity in your tone and pace than a funeral director.

Deciding Whether You Need

an Qutline or Script

What method works best for you? A full script and hours of prep time, or a
single note card and two clicks of the mouse — one for Record and another
for Stop? Both approaches work, depending on the podcaster’s personality. It
could be said that there’s little difference between a writer and a podcaster:
Some writers prefer to use an outline when putting together a short story or
novel; others merely take an idea, a few points, and a direction, and then let
their fingers work across the keyboard.

If you decide to work with a script, it’s a good idea to invest some time into
preshow prep, simple preparation for what you're going to say and how
you’re going to deliver it. Depending on your podcast, though, prep time may
vary. Here are a couple of examples of how dramatically different prep time
can be for different podcasting situations:
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v For his podcast Speaking of Beer, “Charlie the Beer Guy” does very little
prep — usually just enough to get accurate numbers for the alcohol
content of his subject. After he does minimal orientation with the guest
panel, he’s ready to record. You really need to know your subject and
have good chemistry with your show participants to make a minimal
plan like this turn in to a good show, but it can work.

v On the other side of the spectrum is The Radio Adventures of Doctor Floyd,
a 10-minute show in the style of old-time radio with a modern, educational,
comedic spin. Grant Baciocco and Doug Price (see Figure 4-1) have every
show carefully scripted. Depending on the historical research required,
Grant can spend anywhere from 1 to 3 hours doing preshow prep. The
careful scripting comes in real handy when “Doctor Floyd” has celebrity
actors playing a part in the show.

Preshow prep can range anywhere from jotting a few notes on a napkin to
writing a complete scripted with full sound effects — regardless of show
length. So how far should your prep go technically? That depends on what
your podcast needs. Outlines and scripts will keep you on track with what
you want to say, serving as roadmaps you use to keep moving smoothly from
Point A to Point B.
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Whether you're a napkin scribbler, a script writer, or somewhere in between,
if you've never done any kind of planning like this, the secret to efficient pre-
show prep can be boiled down to three disciplines:

v Habit: Many podcasters, especially podcasters emerging from corporate
offices, prepare for podcasts in the same manner as business presenta-
tions. They jot down essential points on note cards to keep the podcast
on track, but the points are the only material they write beforehand.

You can easily apply your organizational skills from the workplace to
the podosphere. For example, C.C. Chapman eats, breaths, and sleeps
marketing in his day job. He has been able to take this “PowerPoint men-
tality” of speaking for 30-60 minutes based on a few bullet items, and apply
it to his show. His entire preshow prep for his podcast Managing the Gray, is
to take listener suggested topics or questions, jot down a few bullet items,
and run with it. With a collection of ideas and topics gathered between
podcasts, he begins his one-take recording with a handful of points
serving as a guideline.

v Talent: Some podcasters are truly the Evel Knievels of the podosphere,
firing up their mics and recording in one take. These podcasters tend
to have backgrounds in live entertainment, deciding in a moment’s time
when a change of delivery is required. This is a talent of quick thinking,
and although it keeps material spontaneous and fresh, it’s a talent that
must be developed with time.

For example, Dan Klass is the demented mind behind the sharp and sar-

castic podcast, The Bitterest Pill. His show is completely improvised. No

prep time. Not a list of key points in sight. How can he do this? Dan’s is a
special breed of bravery: He’s a professional stand-up comedian.

v~ Passion: Passion is a driving force with a majority of podcasters that
keeps their podcasts spur-of-the-moment. With enough drive, inspira-
tion, and confidence in their message, they keep their prep time to a
minimum because podcasting isn’t a chore but a form of recreation.

For example, Doctor Who Podshock by Ken Deep, Louis Trapani, James
Naughton, and a cast of others, is all centered around the Doctor Who
television series. Their preshow prep can be as much as a couple hours
of research or as little as five minutes of topic overview and then they
let their passion for The Doctor, the TARDIS, the Daleks, and more carry
them through more than an hour of show.
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Determining a Length for Your Show

If you've been using this chapter to develop your podcast, you’'ve made seri-
ous progress by this point in getting your preshow prep done. Now you’re
ready to podcast, right?

Well, no. Have you thought about how long your show’s episode is going to
run? No? Okay then, check out the following sections.

The hidden value of the short podcast

There are many podcasts that run under ten minutes where hosts deliver
their message and then sign off only moments after you thought they signed
on. On average — and this is more like an understood average, not really a
scientific, detailed study of all the podcasts out there — a podcast runs from
20 to 30 minutes per episode. So what about these 10-minute vignettes? Does
size matter? Does time matter? (Woah. Deep.) Is there such a thing as too
short a podcast?

Here are some advantages in offering a short podcast:

v+ Shorter production time: Production time is reduced from a week-long
project to a single afternoon of planning, talking, editing, and mixing.
With a quick and simplified production schedule, delivering a podcast
on a regular basis — say, every two weeks, weekly, or twice a week — is
easier.

v~ Fast downloads: You can be assured — no matter what specs you
compress your audio file down to — that your podcast subscribers will
always have fast and efficient downloads.

v~ Easy to stay on target: If you limit yourself to a running time of less than
ten minutes, you force yourself to stick to the intent (and the immediate
message) of your podcast. There’s no room for in-depth chat, spontane-
ous banter, or tangents to explore. You hit the red button and remain on
target from beginning to end, keeping your podcast strictly focused on
the facts. Shakespeare said, “Brevity is the soul of wit.” Considering his
words, ol’ Bill would probably have podcast under 15 minutes if he were
alive today.

Nothing’s wrong with keeping a podcast short and sweet. In fact, you might
gain more subscribers who appreciate your efficiency.
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A little length won’t kill you

Now with that quote from the Bard about brevity, you might think,
“Shakespeare said that?! Before or after he wrote Hamlet?” That’s a good
point because Shakespeare did have a number of his characters say, “My
lord, I will be brief . . .” and then launch into a three-to-four-page monologue.

So what if Shakespeare decided to be brief in his podcast? Would he get any
subscribers if his show ran longer than half an hour? What if he broke the
60-minute ceiling? Would the Podcast Police shut down his show?

Podcatchers (such as iTunes, Juice Receiver, and Songbird) and subscribers,
on reading your show notes and descriptions, should be able to figure out
the average running time of your show. On a particular topic, some podcasts
can easily fill two or even three hours. It’s hard to believe even avid podcast
audiences would want to sit and wait for such a mammoth download, but
huge productions have some definite advantages:

v~ If the show is an interview, you have anywhere from two to three
hours with an authority. It’s something like having a one-on-one session
stored on your computer or MP3 player. From marketing shows like
G’day World or science/tech shows like Technorama, if a guest or author-
ity is part of the podcast, you can rest assured your podcast will go a
little longer than 30 minutes — and sometimes it should.

* You're allowed verbal breathing room. Discussion stretching past the
30-minute mark allows you and your co-hosts or guests to break off into
loosely related banter, widening your podcast’s focus and sparking dis-
cussion that can lead in other directions.

Be careful with this one. Shows and interviews that ramble aimlessly run
the risk of losing audience attention. We talk more about good interview
practices in Chapter 5.

The cost of podcasts longer than 30 minutes is in bandwidth and file-storage —
issues that smaller podcasts rarely, if ever, have to deal with. See Chapter 10
for a discussion of the bandwidth demands on your server.

Finding that happy medium

[s there such a thing as middle ground in the almost-completely undiscov-
ered territory that is podcasting? How can you find a happy medium if pod-
casters can’t agree on a standard running time?

The happy medium for your podcast should be a sense of expectancy or con-
sistency. For example, in Tee’s podcast of Billibub Baddings and The Case of
the Singing Sword, the running times for each chapter are across the board —

Chapter 4: Before You Hit the Record Button . . .
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the shortest is just over 30 minutes, and the longest weighs in at a whopping
1 hour, 15 minutes. His audience, however, understands this is a podiobook,
an audiobook in serialized format. Readers understand that chapters vary

in size with a printed book, so it’s no surprise when a podiobook follows

suit. Some of the podcasts are short, sweet, and a quick bridge between one
plotline and another. Other chapters reveal a new plot twist or introduce new
characters, meaning that some length is in order.

Podiobooks aren’t the only genre that variable length works well for. If your
podcast deals in do-it-yourself home improvement, explaining the construction
of a bookshelf will be a far shorter show than one about adding an extension to
your deck.

Give yourself some time to develop your show, your voice, and your direction.
If you build some consistency and expectation for your audience, it’s easier to

introduce a little variation or even a happy medium into your running time.

1 Hear Music (And It Sounds
Like Police Sirens!)

In creating your own podcast, something that will give your show an extra
punch or just a tiny zest is the right kind of music. We're all musicians, and
although our skills and tastes range from classical to rock 'n’ roll, we all

Podcast Galactica

The SciFi channel has struck gold with an inno-
vative approach on an old favorite from the ‘70s:
Battlestar Galactica. With a new cast, a new
look, and some gender-bending on the char-
acters Boomer and Starbuck, the successful
series rounds off a solid night of science fiction.
Galactica takes delight in taking chances and
challenging boundaries. In the spirit of taking
chances (as well as being interested in reaching
new audiences), Executive Producer Ronald D.
Moore and SciFi.com decided to host a podcast:
hour-long episodes, similar to director commen-
taries on DVDs, providing an inside look at what
went into the season’s most recent episode.

An hour inside Ron Moore’s head? That's a
sci-fi geek’s dream come to life. Season one
of Battlestar Galactica was so successful that
its premiere, “33,” won Science Fiction's high-
est honor — the Hugo — for Best Short Form
Dramatic Presentation. The companion pod-
cast of Battlestar Galactica was so successful
that SciFi brought it back for repeat episodes
and has now broadened its scope to include
scriptwriting sessions and guest appearances
from cast members. Moore's casual chats last
an hour (well beyond the average running time
for a podcast . . . not that anyone subscrib-
ing cares) and provides inside stories on how
improvisational the actors can be on the set,




delves into the decision process behind shoot-
ing schedules, and even grants a more personal
look atthe production, such as referring to iiber-
intense actor/director Edward James Olmos as
“Eddie.” Keeping the production values to the
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basics, Galactica’s companion podcast adds
a new dimension to the military SciFi epic by
taking fans behind the scenes and into the
imagination of its creator.

LESTAR s
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appreciate and understand the power of music and what it can bring to a

podcast.

We also understand and appreciate the law. Although you may think it’s cool

to “stick it to the man” and thumb your nose at Corporate America, the law
is the law, and there are serious rules to follow when featuring that favorite
song of yours as a theme to your podcast.

81
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QNING/ We want to make this clear as polished crystal — we are not lawyers. We're
Sy podcasters. We've looked up the law on certain matters so we know and
understand what we’re talking about, but we are not lawyers. We can tell you
about the law and we can give a few simple definitions of it, but we are not
giving out legal advice. If you need a legal call on a matter concerning your
podcast — whether it concerns the First Amendment, copyright issues, or
slander — please consult a lawyer.

The powers that be

The government still regards the Internet as a digital Wild West, an unknown
territory that’s avoided regulation for many years, granting those who use

it a true, self-governed entity where ideas, cultures, and concepts can be
expressed without any filtering or editing, unless it comes from the users
themselves.

Does this mean we podcasters are free to do as we please? Well, no, not by
along shot. There are some rules and regulations that even podcasts must
follow. There are also organizations that both broadcasters and podcasters
must pay attention to.

The following organizations all have influence on the destiny of podcasting,
and it’s only going to benefit you as a podcaster to understand how their leg-
islation, activities, and actions are going to affect you.

The Federal Communications Commission (FCC)

The Federal Communications Commission, or FCC (www. fcc.gov), is

the watchdog of anything and everything that gets out to the public via

mass communications. The FCC keeps an eye on technology development,
monopolies in the telecommunications industry, and regulating standards for
telecommunications in the United States and its territories. They are most
commonly known for enforcing decency laws on television and AM/FM radio.

For podcasters, the FCC can’t regulate what is said (yet) because it doesn’t con-
sider the Internet a broadcasting medium. However, given existing legislation
to reduce spam (junk e-mail) and the growing popularity of podcasting among
mainstream broadcasters (such as Clear Channel, Oprah Winfrey, and the SciFi
Channel), it may not be long before the law catches up with technology.

The Recording Industry Association of America (RIAA)

Sean Fanning. Does that name ring a bell? Sadly, it was Fanning who lost his
battle against the Recording Industry Association of America, also referred to
by their more common acronym RIAA (www.riaa.com), when he contested
that his file-sharing application, Napster, in no way infringed on copyright
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laws and was not promoting music piracy. The RIAA led the charge in shut-
ting down the original Napster and continues to protect property rights of its
members — as well as review new and pending laws, regulations, and poli-
cies at the state and federal level.

The RIAA will have a definite say as to why you cannot use a selected piece
of music for your podcast. Simply put, it’s not your music. Sure, you own
that CD, but the music you listen to is under the condition that you use it for
listening purposes only. (Didn’t realize there were conditions involved, did
you?) This means you can’t use it as your own personal introduction that
people will associate with you. And, no matter how appropriate your favor-
ite song is, you cannot use it as background music. Unless you’re granted
licenses and you pay fees to the record labels and artists, you're in copyright
violation when playing music without permission.

One way of getting music for themes, background beds, and segues is to look
into what musicians and podcasters refer to as podsafe music. This is pro-
fessionally produced music from independent artists who are offering their
works for podcasting use. The demand for podsafe music has been so high
that the Podsafe Music Network Web site (see Figure 4-2) was launched (www .
mevio.com/music/), offering a wide array of genres, artists, and musical
works. Today several other sources of podsafe music exist including Garage
Band.com (www.garageband. com) and Magnatune (www . magnatune. com).
Find out more about podsafe music, the conditions of using it, and how it can
benefit your podcast.
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The Electronic Frontier Foundation (EFF)

In addition to the big dogs who are passing the laws and legislations to
restrain your podcasting capabilities, a group is looking out for you, the
podcaster, with Science Fiction author and tech guru Cory Doctorow step-
ping forward as one of its more outspoken members. The Electronic Frontier
Foundation, or EFF (www.eff.org), is a donor-supported organization
working to protect the digital rights of the individual; to educate the media,
lawmakers, and the public on how technology affects their civil liberties; and
uphold said civil liberties if they’re threatened.

A good example of EFF’s mission is its involvement in various legal cases
concerning URL domain registration and cybersquatters (individuals who buy
desired domains and then hold on to them, waiting for the highest bidder).
The EFF stands for the rights of legitimate Web site owners who happen to
own a domain that a larger corporation would desire to use.

The EFF, provided you have a strong case to contradict the findings of the
RIAA and the FCC, will stand up for you and give your voice a bit of power
when you're standing up to a corporate legal machine.

Creative Commons (CC)

Founded in 2001, Creative Commons (CC) is a nonprofit corporation dedi-
cated to helping the artist, the copyrighted material, and the individual who
wants to use copyrighted material in a constructive manner but may not
have the resources to buy rights from groups like the RIAA.

Copyright protection is a double-edged sword for many. On the positive side
of a copyright, your work is protected so that no one can steal it for their
own personal profit, or if someone makes the claim that you're ripping off
their work, your copyright is proof that your egg came before their chicken.
That’s the whole point of the copyright — protection. The downside of this
protection is that people now must go through channels for approval to fea-
ture your work in an educational or referential manner; and although you’re
given credit for the property featured, there’s still a matter of approvals, fees
for usage, and conditions that must be met. Also, many contributors just
want to share their work with others on no other terms but to contribute and
share with the world. Copyrights complicate this.

This complication of the digital copyright, protections, and desire to exchange
original creations brought about Creative Commons (http://creative
commons . org), shown in Figure 4-3. It’s dedicated to drafting and implementing
via the Internet licenses granting fair use of copyrighted material.
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In the case of the podcaster, you want to offer your audio content to every-
one, not caring whether listeners copy and distribute your MP3. As long as
the listeners give you credit, that’s all fine and good for you. CC can provide
you with licenses that aid you in letting people know your podcast is up for
grabs as long as others give credit where credit is due. CC provides these
same licenses for artists and musicians who would not mind at all if you used
their music for your podcast.

CC licenses are made up of permission fields:

v~ Attribution: Grants permission for copying, distribution, display, and
performance of the original work and derivative works inspired from it,
provided credit to the artist(s) is given.

1 Noncommercial: Grants permission for copying, distribution, display,
and performance of the original work and derivative works inspired
from it for noncommercial purposes only.

1 No Derivative Works: Grants permission for copying, distribution, dis-
play, and performance of the original work only. No derivative works are
covered in this license category.

v+~ Share Alike: Grants reproduction of the original work and also allows
derivative works if they are also released under a similar Creative
Commons license.



86 Part ll: The Hills Are Alive with the Sound of Podcasting

WMBER
‘x&
&

These four fields can be used as stand-alone licenses or can be mixed and matched
to fit the needs of the podcaster or the artist offering content for the podcast.

The CC and its Web site give details, examples, and an FAQ page that answers
questions concerning the granting of licenses for use of protected content. Just
on the off-chance you don’t find your answer on the Web site, it gives contact
information for its representatives. CC is a good group to know and can open
opportunities for you to present new and innovative ideas and works in your
podcast.

] can name that tune . . . | wrote it!

Using almost anyone else’s music for your podcast can be an open invitation
for the RIAA to shut it down. This is primarily to protect the artist’s rights.
Think about it — how would you feel if you were producing a popular pod-
cast, receiving praise from all over the world, and while you’re thinking about
ways of taking the podcast to the next level, you turn on your radio and hear
your podcast being broadcast on a top-rated radio station. Soon, your podcast
is all the rage on the broadcasting airwaves — and you haven’t made dollar one.

The same thing can be said for artists and their music. They work hard to
produce their work, and now podcasters are using their music to brand their
shows, not bothering to compensate the artists for their efforts. Artists love
to say that they “do what we do for the love of the craft” but in the end, it’s
their work, and artists have to pay the bills too.

So how can you use a piece of music without suffering the wrath of the RIAA
or FCC? Ask permission of the artist? Only if the artist owns the rights to the
music and the recordings. Otherwise, you also need to get written permission
from artists, musicians, record labels, producers . . .

The best way to avoid the legal hassles is to avoid copyrighted material that is
not your own.

If you want to use published pieces that aren’t royalty-free, ask the artist
directly (if you can) for permission to use that music on a regular basis.
Compensation to the artist may come in the form of a promotion at the begin-
ning or end (or both) tags of the podcast. As long as you have written permis-
sion from the artists and the artists have the power to grant it (that is, they
haven’t signed the power over to their label or publisher), you should be able
to use their work to brand your show or feature them on your podcast. (If
you’re not sure whether you have the appropriate permission, you may want
to consult an attorney.) This is usually acceptable with independent artists
because, in many cases, they also own the record label. Confirm this with art-
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ists. Otherwise, you run into the same legal issues if you were to use music
recorded by Queen, Switchfoot, or U2.

You can always offer your podcast as a venue for the musician to sell his or her
work. Dave Slusher of Evil Genius Chronicles (www.evilgeniuschronicles.
org) has written permission from the Gentle Readers to use its music as intro,
exit, and background music for his podcast; in return, Dave promotes its CD
Hi, Honey. This promotion works well for the Gentle Readers as well as artist
Michelle Mallone (www.michellemalone.com). After her music was featured
on Dave’s podcast, her sales spiked — both through her Web site and on
iTunes!

I'll take the First: Free
speech versus slander

Words can (potentially, at least) get you in just as much trouble as music.
The legal definition of slander is a verbal form of defamation, or spoken words
that falsely and negatively reflect on one’s reputation.

So where does podcasting fit into all this? Well, the Internet is a kind of public
space. Think about it — before you open your mouth and begin a slam-fest on
someone you don’t like in the media or go on the personal attack with some-
one you work alongside, remember that your little rant is reaching MP3 players
around the world. Be sure — before you open your mouth to speak — that you
aren’t misquoting an article or merely assuming that your word is gospel. When
expressing jaded opinions, have real evidence to back up what you say — and
put up or shut up!
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Chapter 5

Interview-Fu: Talk to Me,
Grasshopper

In This Chapter
Getting prepared for interviews
Recording your interviews with Skype
Approaching an in-person interview

Making sure your interviews are trouble-free

podcasting is empowering. There’s something about a microphone in
your hand that gives courage. Suddenly, you're not afraid of anything.
Oh yeah, you’re “running with the big dogs” now, and like Charlie Rose, Larry
King, or Mike Wallace, you're asking the questions to find out what makes
your guest tick.

What sets you apart from those big dogs, though, is skill. James Lipton of
Inside the Actor’s Studio may make interviewing look easy, but make no mis-
take: Interviews are not easy. It takes skill to host an interview, and hosting
a great interview is an art. The good news is these luminaries possessing the
gift of gab all had to start somewhere. Podcasting is an excellent venue to
hone your interviewing skills, but you're going to want a solid foundation to
build your skill set on.

Along with helping you schedule an interview, we help you get ready for it by
looking at hardware and software tried and true for us, asking good questions
to keep the conversation lively and engaging, and giving you examples of bad
questions best avoided. Finally, we impart those always-valuable behind-the-

scenes technical tips that make the interview go smoothly.
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I'lt Have My People Call Your People:
Interview Requests

The courage to submit an interview request comes simply from your inter-
est in the interview subject. Script or compose an e-mail to ask your favorite
author, actor, sports celebrity, podcaster, or whomever you want for an
interview. You may need to submit the request multiple times, and some-
times you may have to work through numerous people simply to get a “no”
as your final reply. That happens. It doesn’t mean that individual is mean, a
rude person, or otherwise. They just don’t do interviews. For every “no,” you
will find ten others who will enthusiastically say “yes.”

Here are some other things you should keep in mind when working on the
interview request:

v Market yourself and your show: A good deal of marketing is involved
with podcasting. Your interview request needs to sell your services to
the prospective interviewee. If you're part of a podcasting network, be
sure to mention that. Large listenership numbers are always helpful.
Have you done interviews before? If so, do some name dropping. If not,
a good place to start might be with other podcasters. They’re looking to
get their names out and grow their listenerships also.

+ What can I do for you? The person (or the person’s agent) is going ask
“What’s in it for me (or my client)?” You need to ask yourself questions
like: Does he or she have a new book coming out? Perhaps he or she is
about to launch a special product? Find an angle and work with it.

+~ Be flexible: Remember, you're asking for their time. There may be
restrictions in your schedule and theirs. Sometimes you can get an
interview within 24 hours or you have to schedule it weeks or months in
advance. You may have to take time off work from your regular job or re-
arrange other plans.
<MBER
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& Don’t assume the person reading your interview request is going to know what

a podcast is. You may have to explain your medium using alternative terms or
a short explanation.

Preparing for Interviews

There’s an approach that all interviewers, be they Barbara Walters or
Stephen Colbert, should take in talking to guests — use a simple, basic plan
to ask the questions that garner the best responses.
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Asking really great questions

Chances are good that if you're new to podcasting, you’'ve never held an
interview quite like this — an interpersonal, casual chat that could get a bit
thought-provoking or downright controversial, depending on your podcast’s
subject matter. The interview may be arranged by you, or it may be prear-
ranged for you, but if you think what reporters do is easy, it isn’t. There’s a
science to it, and here are just a few tips to take to heart so you can hold a
good, engaging interview:

+* Know who you’re talking to and what to talk about. With interviewer
Jana Oliver, former host of two shows on Leisure Talk Radio, the sheer
number of guests she interviewed could cause a problem: trying to
find the time to read all her guests’ books. So she did a different kind of
homework on her guests. “If my guest wrote a book about Charlemagne,
I will go online and do my own research into the topic. This has two
effects: (1) I sound like [ have a clue what I'm talking about and (2) It
allows me to ask better questions.”

It’s also a good idea to visit guests’ Web sites (provided they have 'em).
You don’t have to be an expert on their subject matter, but you should
be familiar with it so you know in what direction to take the interview.

1 Have your questions follow a logical progression. Say you're interview-
ing a filmmaker who is working on a horror movie. A good progression
for your interview would be something like this:

e What made you want to shoot a horror movie?

e What makes a really good horror film?

e Who inspired you in this genre?

¢ In your opinion, what is the scariest film ever made?

You'll notice these questions are all based around filmmaking, beginning
with the director’s choice and ending with a director’s choice. The pro-
gression of this interview starts specific on the current work and then
broadens to a wider perspective. Most interviews should follow a pro-
gression like this, or they can start on a very broad viewpoint and slowly
become more specific to the guest’s expertise.

v Ask open-ended questions. To understand open-ended questions, it’s
simpler to explain closed-ended questions. Close-ended questions are
the kind that give you one word answers — for example, “How long have
you been studying plate tectonics?” Don’t count on your interviewee
giving a dynamic answer to a question like that. Close-ended questions
make the process harder than it needs to be. Instead, rephrase your
question like “So what exactly got you interested in plate tectonics?”

91
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v Prepare twice the number of questions that you think you’ll need.
Some interviews you hear grind to a halt for no other reason than the
interviewer believed that the guest would talk his head off on the first
question. You're certainly in for a bumpy ride when you ask a guest,
“Tell the listener a little bit about your experience at WidgetCo” and the
guest replies, “It was a lot of hard work, but rewarding.” (Yeah, this is
going to get painful.)

Write down a series of questions that could fill your podcast with brief,
one-or-two-word answers. This way, if you find yourself struggling, you
have a hidden stockpile of questions to call upon. After a few quick
answers, you can always fall back on the “Would you expand a bit on
that please?” question.

1 Never worry about asking a stupid question. When asking questions
that may sound obvious or frequently asked, remember: Chances are
good that your audience has never heard them answered before. Okay,
maybe a writer has been asked time and again, “Where do your ideas
come from?” or a politician has heard, “So, when did you first start in
politics?” often. When you have a guest present for a podcast, there’s
no such thing as a stupid question; what’s really dumb is not to ask a
question that you think isn’t worth the guest’s time. He or she may be
champing at the bit in hopes you will ask it.

Avoiding really bad questions

Before you start percolating and dream up a few questions based on the
preceding tips, stop and think about the interviews you’ve listened to where
things suddenly headed south. Usually the interviewer ambushes the guest
or tries to dig into something that’s either out of the guest’s scope or none
of the interviewer’s business. We've piled up the typical gaffes in a prime
example of a good interview gone bad.

Every podcaster should know how to turn a pleasant conversation sour (uh,
this is a satire and not a recipe, okay?); the following blunders should do it:

v~ Ask inappropriate questions. Keep in mind your podcast is not 60
Minutes, 20/20, or even Jerry Springer. If you want to fire off hard-hitting-
tell-all-mudslinging questions, think about who your audience is, who
you're talking to, and whether the question is within the ability of the
guest to answer honestly and openly. If not, an awkward moment may be
the least of your worries.

Inappropriate can also mean irrelevant, wacky, off-the-wall, and far-too-
personal questions. For instance, author Neil Gaiman was once asked
completely out of the blue: “Mr. Gaiman, what is your best score in bowl-
ing?” Gaiman, somewhat baffled, replied awkwardly, “Well, um, I can’t
really answer that question becausel. .. don’t ... bowl. Never been
bowling. Don’t know how. So . . . ummm . . . sorry.”
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Maybe silly questions work for shock jocks, but when you have an
opportunity to interview people you respect in your field, do you really
want to ask them something like, “Boxers, briefs, or none of the above?”
Think about what you're going to ask before you actually do.

v Continue to pursue answers to inappropriate questions. If a question
has been deemed inappropriate by a guest, don’t continue to ask it.
Move on to the next question and continue forward into the interview.
Podcasts are by no means an arena for browbeating guests into submis-
sion till they break down in tears and cough up the ugly, sordid details
of their lives. If this is the intent of your podcast, you've picked up the
wrong book; you need Psychotherapy For Dummies.

Are there exceptions to this exception? We would say, yes, depending
on the content of your podcast. Say after reading — and enjoying —
Podcasting For Dummies, you decide to become the Tom Green of pod-
casting. Of course, if you're after irreverent material for your show and
push that envelope as far as you can, your guests may not want to play
along — especially if they don’t get the joke. If that’s the case, expect
your guests to get up and walk away. Even in the most idyllic situations,
guests can (and do) reserve the right to do that.

v Turn the interview into the Me show. Please remember that the spotlight
belongs to your guest. Yes, it is your podcast, but when a guest is intro-
duced into the mix, you're surrendering control of the show to him or her,
and that isn’t necessarily a bad thing. Let guests enjoy the spotlight; your
audience will appreciate them for being there, which adds a new dimen-
sion to your feed. One way to avoid the “me factor” is to think of yourself
as a liaison for the listener. Ask yourself, “As a listener, what questions
would I ask or information would I be looking for from the guest?”

Feelin’ the synergy

One final note on preparing for interviews: We've heard some guests say, “I'm
doing these interviewers a favor by going on their show.” And we’ve been
told by other show hosts, “We’re doing you a great favor with this chance to
showcase your work on our show.”

Both of these opinions are not just arrogant, they’re just flat-out wrong.

The reality is that host and guest are working together to create a synergy.
The interviewer has a chance to earn a wider audience and display mastery
of journalistic techniques. The guest has a chance to get into the public eye,
stay in the public eye, and talk about the next big thing he or she has coming
in sight of said public eye. Working together, guest and host create a seam-
less promotional machine for one another.
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If you decide to take on the art of the interview, keep these facts in mind; you
and your guests will have your best chance to work together to create some-
thing special.

If your format allows it, ask your guest for an ID that you can drop in from
time to time. You’'ve probably heard these before on radio stations “Hi, this

is Rex Cramer, danger seeker. You may remember me from such films as
Airplane and Kentucky Fried Movie, and you're listening to The Shameless Self-
promoting Podcast.” If the interview guests want to be more creative, let them.
These are a great self-promotion tool, a whole lot of fun, and a way to remind
your listener of previous accomplishments. Remember to ask politely, and be
aware that not everyone will (or can) comply.

Recording Interviews with Skype

NG/
Q\“\ H

Unless you're conducting in-person interviews, your podcast just got a bit
more technically complicated. You need to have the appropriate software to
record your interview over the phone.

The best option of recording your interviews is with Skype (www . skype . com).
Skype is “free Internet telephony,” which is akin to iChat’s/AOL IM’s Audio
mode but is more stable and, in some instances, provides clearer reception.
What makes Skype more appealing to Internet users than iChat/AOL is the
expandability of the application. It’s available for Windows, Mac, and Linux.
Skype is the vehicle to make your calls, but it lacks the feature to record them.
You can record Skype conversations with various methods and use down-
loadable software to monitor levels and volume as you record. You can also
use Skype with a little more hardware for similar results. We discuss all your
options — whether software or hardware — in the following sections.

As stated in Chapter 4, there are legal restrictions concerning the recording
of telephone/Skype calls, and these restrictions vary from country to country,
state to state, and region to region. Compliance with these laws is the respon-
sibility of the podcaster. Always ask for permission (or better yet, get it in
writing) before recording phone calls.

Recording using software

Recording using software or hardware — once again you're faced with
choices. Software solutions are typically less complex to set up and use and
cost less; however, they can put more load on the computer’s CPU. If the CPU
is too busy, it could impact the quality of the recording. The following sec-
tions cover some software options for recording Skype calls.
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Call Recorder

Call Recorder for the Mac from eCamm Network (www . ecamm. com/mac/
callrecorder) is a handy little piece of software with a simple interface
that allows you to record Skype audio and video and save it to one of many
formats for later editing. The only downside of Call Recorder is that the file is
recorded as a robust MOV file. To reduce its size (for archiving purposes or
to produce a smaller MP3 from), you need to run it through a media player
like QuickTime Pro, producing a streamlined AIFF or WAV file. However, this
step isn’t necessary if you're using GarageBand or Soundtrack Pro. If you
don’t have the money for a mixer and second computer (or portable record-
ing device), the $15 investment is a great deal.

SoundTap

For the Windows users, SoundTap, from NCH Swift Sound (www.nch.com.
au/soundtap/index.html) lets you record just about any audio that plays
through your Windows computer. Simply install the software and turn it on,
and then all sound played on or through the PC, including Skype calls, will be
recorded as WAV or MP3 files. All audio is “tapped” by a virtual driver, so the
process is perfect digital quality. Current pricing for SoundTap is $19.40.

WireTap Studio Pro

As mentioned in Chapter 3, WireTap Studio from Ambrosia Software (www .
ambrosiasw.com/utilities/wiretap) lets you record just about any
audio that plays through your Mac and also allows you to record from a
second source such as your mixer, iTunes, or another media player.

As for the steps involved in recording a Skype interview with WireTap Studio,
it’s a piece of cake:

1. Launch WireTap Studio Pro and make sure the Controller window
(shown in Figure 5-1) is visible. You can access it either by choosing
Window=>Controller or by pressing $+0.

2. From the top menu, select one incoming source of audio. From the
menu underneath it, select your second input source.

The image on the right in Figure 5-1 shows you the input menus for the
running applications that can serve as an audio input source.

3. Choose Filew>Preferences to access the Preferences of your WireTap
Studio Pro application.

The Preferences window appears, as shown in Figure 5-2.

4. Click the Source button at the top of the Preferences window. Have
your interview subject (on Skype) talk as you check your own levels
(on the mixer, USB microphone, and so on).
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5. Click the Format option to select an audio format.

You can record your audio as an AIFF, a WAV, or another uncompressed
digital audio format or it can go directly to MP3 to the compression set-
tings of your choosing.

6. Close this window and then return to the Controller. The large, dark
circle is the Record button. Single-click that to begin recording.

7. When the interview is concluded, end the recording by clicking the
Stop button (the dark square).

Automatically WireTap Studio pulls up a window with the waveform of
your newly recorded audio (see Figure 5-3). Here you have tools avail-
able for editing, creating loops, and creating basic audio effects. For
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more on the capabilities of these tools, review the online tutorials for
WireTap Studio at www.ambrosiasw.com/utilities/wiretap/
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8. When your recording is ready, you can select it from WireTap’s
Library window and then click either the iTunes or the Local Disk
button from the Send To options at the bottom of the window.

If the Library window isn’t displayed, choose Window=>WireTap Studio
Library to display it. Check out Figure 5-4.

Your WireTap recording is then sent to your desired location either for
ID3 tag editing (see Chapter 9) or for further editing.

[CNGNG] WireTap Studio Library [=)
-l > —
O@O 00:00 €———100:00 & 2
Search
Name Added File Format Duration

+ Ill] No Selection 4

[A] Mac Audio_recording 4/26/08 9:51 PM MPEG Layer 3 00:13
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The Gizmo project: A recording option

Gizmo (http://www.gizmoproject.
com) is an intuitive, multiplatform VolP (Voice
over Internet Protocol) application (much like
Skype) offering additional features that Skype
lacks. One of these additional features is the
ability to record conversations and save them
in WAV format. Gizmo also informs both parties

in the call that the phone conversation is being
recorded and when recording stops.

If you're looking for an easy way to record inter-
views, take a good look at Gizmo, the latest option
offered by the Internet to make over-the-phone
interviews cost effective for start-up podcasts.
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WireTap Studio Pro is the more pricy of the software options at $69, but
when you consider its capabilities of mixing in two separate audio sources,

editing, ID3 tagging, and exporting options, it’s an easy and reliable recording

resource for those important Skype interviews.

SkypeOut

SkypeOut is a built-in feature that comes with Skype and gives you, the Skype

user, the ability to dial a telephone number and use Skype to talk to people
all over the world starting around 2 cents per minute. Rates to various desti-
nations vary, so check the Skype Web site for details.
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Follow these steps to start using SkypeOut:

1. Go to the Skype Store Web site at www.skype.com/go/store, click the
Account button, and log in using your Skype username and password.

You can also access this Web page by clicking the View Account button
in Skype’s startup window.

2. Look for the SkypeOut link and click the Add Credit link.

3. Select the credit package you want (usually listed in Euros in incre-
ments of ten, but each package lists the details of what you’re buying)
and then purchase it by using PayPal or any major credit card.

Your SkypeOut account is activated.

Your account can go inactive for two reasons. When your credit is at $0,
or when it’s been 180 days since your last SkypeOut call (credits have

a shelf life of 180 days). So if you go three months between calls, you
might find that your credit is gone and your SkypeOut feature is inactive.
If your account goes inactive, simply purchase another block of credit to
reactivate it.

4. On the Skype Web site, click the Dial tab.

Skype opens a numeric keypad emulating a telephone, as shown in
Figure 5-5.

5. Enter a phone number and click the green Call button.

6. Record the phone call by using either WireTap Studio or Gizmo (both
of which are described in this chapter).

Recording using hardware

If recording using software has your head spinning, using hardware may sim-
plify things a bit. The key to the operation is a device called a mixer. (You can
find more details on mixers in Chapter 2.) You've probably seen mixers at
music concerts or television studios — those are for the big boys and tend to
be quite expensive. Fortunately for you, there are less expensive options that
cost as little as $50.

The idea behind a mixer is to take multiple inputs and mix them to create an
output. An input can be a microphone, a computer, a MP3 player, an elec-
tronic keyboard, or just about anything with an audio output to feed in to the
mixer. For interviews, your input will come from the microphone, and your
interviewee will be coming from a computer running Skype. The output needs
to go to a recording device such as an MP3 player or a second computer.
Why do you need a second device? Well, the output can’t go to the machine
running Skype, or your interviewee would hear his or her own voice (prob-
ably with annoying lag), and that would be bad.
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Figure 5-6 shows an example setup that provides the ability to record Skype
calls using a little more hardware.

For standard studio recording, the mixer is quite simple — microphones,
computers, perhaps an MP3 player in the input port (or channels), and your
main output going to a recording device. Of course, because we're talking
about interviews, who wants simple?

Alright, it’s not that complex. Whether you have a basic four-channel mixer
or something the size of a cruise ship, most mixers have the same basic
layout and features. Plugging in a microphone to a single audio channel is
pretty straightforward. Adding the stereo output of a second computer is
also pretty simple (given you have the right connecting cables). The real fun
begins when you need to get your output back to the Skype machine and the
recording device. This is where you need to take advantage of your mixer’s
aux send (sometimes called effects send) port. This is an output port that you
will feed back to your Skype machine. So the question now becomes, how do
you get your microphone input sent out the aux send?
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You see, most mixers have the ability to create multiple mixes. The main mix
is what you typically record, but there are often hidden mixers, called buses,
that let you create an alternative mix. How cool is that? You thought you
were just buying one mixer, and you got yourself one (or more) for free! To
make use of this additional output mix, locate the row of knobs on your mixer
labeled Aux, which often are red in color. (If you have more than one row

of Aux knobs on your mixer, each row corresponds to a separate aux send
channel.) These are the volume controls for your aux send. If you turn up the
volume on your microphone, whatever is connected to listen to the aux send
output will hear it.



T2 Partii: The Hills Are Alive with the Sound of Podcasting

For example, if your Skype computer is connected to input channels 3 and 4,
you want the red knobs on those channels turned all the way down so that input
isn’t fed back to the output on the aux send channel. This is called mix minus 1
because you're taking the entire mix minus one input (the Skype machine). For
a short video tutorial, watch the video at www. friendsintech.com/index.
php/archives/23.

Prepping Vour Green Room for Guests

A guest could be your dad, your mother-in-law, your best friend, or the man
on the street. It could also be the friend of a friend who can get you on the
phone with your favorite author, actor, or athlete. When you're interviewing,
you have a second party to worry about.

Removing the “technical difficulties” element usually means either taking the
show to the guests or bringing the guests to the show. This kind of interview
not only is the most fun to do, but also gives you direct contact with the sub-
ject so you can observe body language, facial expressions, and reactions to
questions and answers.

Welcoming in-studio guests

When you have guests visit your facilities — and because you’re podcasting,
this is probably your house — make them feel at home. Offer them something
to drink. Offer to take them on a tour of your humble abode. Introduce them to
your family. The point is to be polite. You don’t have to cook dinner for them,
but offering a hint of hospitality, be it a glass of water (or a beer, if you've ever
worked closely with the Draco Vista Studios crew), is a nice touch.

If you're having in-studio interviews, it’s also a good idea to get your home
and yourself ready to receive guests. Sure, Tee has recorded quite a few pod-
casts in his pajamas, but because he’s reading a book for his podcast, he’s
allowed. If fantasy and science fiction authors Terry Brooks and Catherine
Asaro ever come over to his house for an interview, don’t think he’d be greet-
ing them in his Joe Boxer jammies and Guinness slippers.

Okay, maybe he would greet them wearing the Guinness slippers, but he would
be bathed and dressed and have his teeth brushed and hair combed. The key
word here is guest. Treat them as such. Be cool, be pleasant, be nice. And if
you're a guest on someone else’s podcast, the same rules apply. Don’t prop
your feet up on the furniture, don’t demand hospitality, and don’t be a jerk
during the interview.

The in-studio visit is an audition for both guest and host. If the guest is abra-
sive, abusive, and just plain rude, chances are good that the guest will never
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be invited back, no matter how well the previous interview goes. If a host
asks unapproved questions, continues to pry into personal matters that have
nothing to do with the interview, or seems determined to take over the inter-
view spotlight as if trying to impress the guest, said guest may never return,
even if extended an invitation.

Meeting guests on their own turf

Be cool, be pleasant, be nice. These same rules apply when you take your
podcast on the road. You may find yourself at a person’s home, place of busi-
ness, or some other neutral place. You’re now practicing — for the lack of

a better term — guerilla journalism, ambushing unsuspecting people with
questions that may not strike you as hard and probing but could be to people
who don’t expect them. Make certain to show respect to your guests, wher-
ever you are when the interview takes place.

A good approach for getting good interviews is to ask permission of your
guests, be they passers-by or experts at their place of business, to interview
them. Shoving a microphone in someone’s face and blurting out a question

is hardly a great way to introduce yourself and your podcast to the world. If
the guest you want to interview has a handler or liaison, it’s good protocol to
follow the suggestions and advice of the guest’s staff.

If you start out with a warm, welcoming smile and explain what you're doing
and why, most people open up and are happy to talk.

When interviewing people on the street or in the moment, there are some

easy ways to identify yourself. Michael Butler of The Rock and Roll Geek Show
(http://rockandrollgeek.podshow.com) uses a mic cube around his micro-
phone — these are sometimes called mic flags. The classic cube usually has a logo
identifying a network, a show, or an organization affiliated with the interviewer.
You can find mic cubes online (unprinted) starting around $25. There’s also the
simple greeting, “Hi, do I have your permission to record this for a podcast?”

Just as with the phone and Skype interviews, test your equipment. You're now
out of the controlled environment of your home studio; you have to deal with
surrounding ambient noise and how well your interview is recording in the
midst of uncontrolled background variables. Set up your equipment; power
up your laptop, mixing board, and mics; and record a few words. Then play
back your tests and set your levels accordingly. When you have your setup
running, you're ready to get your interviews.

Ensuring Trouble-Free Recordings

When it comes to recording conversations, here are a few points to keep in
mind before asking the first question:
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* Get permission to record conversations, even if the interview is prear-
ranged. Laws (both federal and state) prohibit the recording of conver-
sations without permission, and further restrictions limit broadcasting
these conversations. If you plan to record and publish a conversation, get
the subject’s consent (for both) beforehand, both verbally and in written
communication (even e-mail) to make sure your legal issues are covered.

v Test the calling equipment. If you have arranged a phone-in (or
Skype-in) interview with someone for your podcast — say, a favorite
musician or politician — prepare for the interview ahead of time. Skype
(or phone) a friend to conduct a mock interview and make sure the
recording setup not only works but also sounds good.

The bandwidth demand increases the more people you conference
through your computer. Reception will be affected, so if you know more
than one person will be involved in this interview, it’s a good idea to test
how many people you can effectively conference in one call.

v+ Check your batteries. If you're using a portable recorder (such as the
Zoom H2), make sure your batteries are charged and you have spares.
(Check the spares, too.) If you're really paranoid or live in an environ-
ment with periodic electrical problems, you can also pick up an uninter-
ruptable power supply in case your main power cuts out.

v Check your hard drive space. Hard drives are getting bigger and cheaper,
but that doesn’t mean they’re infinite. Audio files can be big — especially
if you're recording to a raw format like WAV or AIFF! If you run out of
space in the middle of recording a show or an interview, you lose time;
lose pace; and in the case of interviews, lose face with your interviewee.

If you're recording to a portable recording device, it’s basically the same
idea. Know how much storage you have, in megabytes or gigabytes, and
how long you can record at your current bitrate. Don’t worry; we talk
more about bitrates in Chapter 9.

<P If you're doing an interview with multiple Skype participants (known as confer-
encing), it’s often best to have the person with the highest-power CPU host the
meeting. That person should initiate the call and invite the other attendees
one at a time. The better the CPU, the better the conference will run and the
better your recording will sound. Also, the conference host may or may not
be the same as the person recording the call. Remember, your goal during an
interview is to try and minimize the chances for problems.

And although this may sound a bit pessimistic, be ready for things to go
wrong. Guests might not show up for interviews. Also, new high-tech toys, if
not given a proper pre-interview shakedown, may not come through. Prepare
to have plenty of topics to discuss on your own, and then your podcast can
continue following a quick disclaimer. In podcasting, sticking to a regular
schedule is reassuring to your listeners because they know you’ll offer new
feeds consistently and punctually.



Chapter 6

S0 What Are You Waiting For?
Record, Already!

In This Chapter
Setting your levels and parameters
Focusing on volume and projection
Capturing ambient sound
Pacing and clock management
Going off on tangents
Recording

Okay, you’ve most likely gone through the hardware and software gad-
gets from Chapters 2 and 3. In this chapter, we make the bold assump-
tion that you’ve made your purchasing selections, hooked up all the
hardware according to the supplied documentation (you did read the docu-
mentation, right?), chosen your software, and gotten everything ready to
record. This is it! You have a microphone pointing in the direction of your
mouth, just waiting anxiously for you to begin podcasting.

So what’s stopping you? Perhaps you have no clue how you sound to your
recording equipment, or perhaps you're still trying to understand why your
smooth and sultry voice sounds like you just finished a dozen espressos. The
problem could be in your audio application’s sound settings. Too much pep
in the voice, and you sound like Rob Zombie crooning a goth’s delight. Too
little amplification, and you’d be better off if you just went out to your front
porch and shouted your podcast’s content.

So before the podcast itself comes setting levels and parameters — a fancy-
schmancy way to say fiddling with knobs and sliders on your mixing board or
your audio-editing software to ensure that the signal you're sending through
the microphone is loud and clear. And once the technical side is running
smoothly, give some thought to your voice — things like timing and enuncia-
tion. Because how you say your message directly impacts the listeners’ inter-
est in what you're saying.
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Did Your Sound Check Clear the Bank?

If you show up early enough for a rock concert, you see those roadies setting
up microphones, playfully waving to the crowd as they speak quickly into a
microphone “Check one, check two, check-check-check!” It’s a staple for
rock 'n’ rollers to do such a mic check because the fans expect a good
performance — it needs to be done.

With podcasting, your own mic check should be more involved. In Chapter 4,
we recommended you perform such an audio diagnostic just to assure your-
self (and, if applicable, your guests) that the equipment is working and sound
is, in fact, reaching your computer. The goal is not only to confirm that your
mic is picking up sound, but also to check the volume of the voices — yours
and that of whoever else is involved in this podcast.

Understanding dB levels

Setting levels is quite easy, provided you know where your decibel (dB) input
levels are displayed on your software. The decibel unit is used to express the
intensity of sound, beginning at zero for the least perceptible sound to
approximately 130 for an intensely loud sound level. Your readout measures
how hot you are (that’s the power of your voice, not how good you look) on
the microphone. Audio signal strength (measured in decibels) is the amount
of power that goes into the signal, which affects how clearly it can be heard
and how hard it hits the ears. “Loud and clear” is good; too much signal
strength causes distortion, and that’s a pain to listen to.

In vintage radio and audio equipment, this dB display was a VU (volume unit)
meter — the little needle that bounced in response to your voice. Later, the
needle was replaced by lights that reacted when you spoke into a micro-
phone, going from green to yellow to orange to red. What the lights said was
pretty easy to translate:

v Green: Well, | can hear you, but wow, are you quiet!

* Yellow-Orange: You're coming in loud and clear.

v Red: You're in danger of hitting the distortion level (clipping).

+ Red with double bars: Your audio is going to sound distorted.
Across hardware and software, the volume meters appear different (Figure
6-1 shows the volume meter display for Audacity), but they all serve the
same purpose: to make sure your content is heard clearly. Your aim, as you

speak and watch the indicators speak back, is to keep your dB levels bounc-
ing in the high level (low red) without lighting up those double bars. When
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you attain that average, your voice is rising and falling within a good bal-
anced dynamic range. Try to keep things a little lower — in the red and
orange range — with only the high points (when you raise your voice) going
in to the red occasionally. You can always bring up the low spots with some
simple post production tips (described later in this chapter).

Input level meters

[ XSXs) Audacif

Stereo, 44100Hz
32-bit float

Because microphones, audio-capture cards, and mixing boards all work at
different sensitivity levels, it’s best to test your voice before you record. If
your levels are in the green, it means you're loud enough to be heard by your
equipment but still so soft that people will have to crank up the volume on
their computers or portable MP3 players, consequently blowing out their ear-
drums on the next podcast or CD.

If your recording is too loud (or “hot”), it tends to cause problems for listeners.
Listeners have their MP3 players set for a pleasant, comfortable volume.. . .
and suddenly your show begins with guns blazing and pipes blaring. As your
levels reach deep into the red, listeners fumble for their players and try to
turn down the sound so the program can be understandable through its own
distortion. Sadly, the modulation is such a problem that your voice crackles
and growls as it tramples the volume limits of your recording equipment,
even at the lower volume.

You want try to avoid clipping to prevent that distorted sound. Clipping is
when you’re feeding too much signal to your equipment. It can come from
many sources including incorrect settings on a microphone or other audio
input, incorrect settings on a mixer, or the preferences in your software. Once
audio is clipped, you can’t get the original (or intended) quality back.
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Calling in the crew

It'd be great to set your levels so “0 dB” is
always where your lights remain, but recording
is a real-world activity. Sometimes your meter
may never reach yellow, and other times it
might hit the double red bars. If your goal is to
maintain perfect levels from the beginning
to the end of a recording session, an audio
crew can work with you in rehearsal and

performance, adjusting levels when you go loud
and when you go soft.

The downside of hiring a crew is an added
expense to producing your podcast. Even if the
crew is a collection of audio geek friends, it can
still cost you sending for a /ot of pizza every time
you record.
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In achieving a balance in your audio, you could spend the day setting and
resetting those levels in quest of dB nirvana. That’s time spent, but not well
spent. It makes more sense to practice till you get a pretty good sense of
what your best working level is and get comfortable speaking into a mic at
that level. Time to go mano-a-mano with setting the levels.

Setting your levels

Your mission, should you decide to accept it, is to keep your levels in the
neighborhood of 0 dB, dipping and spiking when necessary. For podcasting,
consistency is key. You have your mixer turned on (if you have one), your
mic is plugged in and turned on — check — and your software is running.
Now follow these steps to check levels:

1. Begin talking into the mic about your podcast topic or plans.

You can do a scripted test read or just talk off the top of your head, but
be sure to speak in the manner and mood of your podcast.

Instead of speaking to thin air in the vague direction of the mic (or the
person next to you), speak in the exact direction of the mic, pointing
your voice directly at the recording device (as shown in Figure 6-2).
Even if the mic isn’t omnidirectional (meaning it picks up sounds from
all directions at once), it can pick up your voice better this way.

If you speak directly into the microphone, you might hear some

sounds — particularly ps and bs — causing an effect known as popping.
An investment of less than $20 in a windscreen or pop filter can fix that.
This device is a foam or nylon filter that stops the wind made by your
mouth from hitting the microphones diaphragm and causing distortion.

2. While you’re talking (or if you’re monitoring by playing back your test
takes), keep an eye on your dB levels on the computer screen.
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If the levels are spiking into the double-red/red area or remaining in the
green, check your input volume settings on your mixing board or audio-
editing software. This might require a bit of multitasking on your part,
but continue to adjust the input levels while talking, as you watch the
input meters.

3. Rerecord your voice at the new settings.

Try to speak in the same manner and inflection as you did on the first
recording.

4. As you review the second take, watch the dB input levels and adjust
accordingly.

When in doubt, err on the side of caution on the input levels. Record
your volume a little low. You can always correct it in post production.
One way to increase the volume later, using Audacity, is to select your
audio and use the Effectse>Amplify feature to bring it up. Another is to
save your audio to WAV format and use a tool called The Levelator
(http://gigavox.com) to fix the levels.

After you set your levels, make a note of the settings somewhere other than
your computer (using, say, a PDA or its retro ancestor — a legal pad and pen),
in case your preferences are lost or fiddled out of whack by somebody’s child
or best friend playing spaceship in your studio. (Yes, even adults enjoy play-
ing spaceship with really super-cool-looking equipment!) That way, even if
something awful happens to your application’s preferences or your mixing
board, you always have your last known settings to reference.
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There's a right way and a wrong way . ..

Time for a confession.

When Tee got his MXL990, it was his first studio
condenser microphone, and he was so excited
about this microphone he failed to check the
small slip of paper included that told him how to
talk into it. Perhaps it was the excitement of ven-
turing into new frontiers of creativity that made
him hook up the equipment without reading the
directions. Maybe it was a bold assumption that
he knew what end to talk into with a mic as he
had worked with (dynamic) microphones before.
Whatever the reason, Tee was speaking into the
microphone incorrectly (left image). His friends
in the podosphere, on seeing Tee “in action,”
didn't really have the heart to tell him so — or
didn’t know any better themselves.

Fortunately, Evo Terra is a heartless evil
mastermind. He told Tee he was doing it wrong,

as any heartless evil mastermind would.
On a podcast, naturally.

All microphones do not behave the same, and
condenser microphones work best when
speaking into them properly (right image), with
the microphone pointed straight down. Tee, on
hooking up his new AKG Perception-200, read
the documentation included, reflected on Evo's
“kind” advice, and then positioned the mic
accordingly. When hooking up microphones,
refer to the enclosed documentation for addi-
tional and essential information on getting the
best sound out of your microphone.

You, too, can avoid the embarrassment (caught
forever) that published photographs may deliver
upon you . .. regardless of how good the

content it generates for your podcast.

Noises Off: Capturing Ambient Noise

Part of the charm that is podcasting is just how varied the content is, as well
as how spontaneous the shows tend to be when the record button is hit.
Some podcasters believe that a “true” podcast (whatever that is!) must
record everything in one take and deliver its content to listeners completely
unedited. This supposed mark of authenticity includes any background noise
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(also called ambient noise) you happen to capture while recording — you
know, rustling trees, birdcalls, pounding car stereos, jackhammers, the usual.

Hey, if that’s the style of your show, that’s great. However, if you're trying to
take listeners to a place in their imagination, read on to find out how to
reduce or eliminate ambient noise.

Identifying ambient noise

As we discuss in Chapter 7, how much you edit depends on what kind of con-
tent you're presenting. For example, if you're doing an off-the-cuff, off-the-wall
podcast about your life and a typical day in it, you may just grab the iTalk,
plug it into your iPod, and head out the door, recording every step along the
way. This kind of podcast can be (note we said can be) easiest to record.
You're podcasting a slice of Americana . .. or Britanniana, if you're in the
United Kingdom . . . or Australiana if podcasting from Down Under. Especially
if your goal is to capture the look and feel of your culture, ambient noise is
not only welcomed, but desired. Up to a point.

Some podcasters cringe at the mere mention of ambient noise — ambient
noise like . . . well, what was in Tee’s very first podcast. When he podcasted
MOREVI: The Chronicles of Rafe & Askana, he worked to create a magical set-
ting with voice, story, music, special effects . . . a world that was completely
shattered by real-world interference like school buses, kids at recess, UPS
trucks, the Virginia Commuter Rail system, and air traffic from two nearby
airports. (All this, and he’s a dad.) Even if you love the source of the ambient
noise, sometimes it just doesn’t fit what the podcast is trying to do.

If your podcast could do without input from the outside world, scheduling
recording sessions is the start of your production. The best noise reduction
happens in pre-production. Try scheduling your recording at night or early
morning. You'll find that traffic is lighter, the kids are in bed, workers aren’t
running those jackhammers, animals typically are less active — all adding up
to less ambient noise, hence takes on the mic.

Minimizing ambient noise

To reduce the intrusion of the outside world and still maintain a budget,
some creativity is in order.

Truth be told, there really isn’t an easy solution to podcasting in a noisy
world. One not-so-cost-effective answer is to rent a studio and record your
podcast there. Unless you have a sponsor who bankrolls your costs, your
“hobby” could easily max out credit cards and cast a hungry eye upon your
nest egg. (Let’s not even go there.)
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A somewhat-less-expensive option is to soundproof your home-based record-
ing room. That may sound simple, but it can involve a lot of home improve-
ment before you have one room in which you can be sure the only sound is
yours. But is it impossible or impractical? Not really. P.G. Holyfield of the
podcast novel Murder at Avedon Hill (http://pgholyfield.com/maah)
and the writing podcast The NanoMonkeys (www . teampodcasts.net/
nanomonkeys) built his own studio for podcasting.

Holyfield’s do-it-yourself adventure began with a house hunt, so a studio in a
finished basement was on the list of what the house needed. The studio even-
tually came about from a large storeroom, a few new walls, and the addition
of an air vent. The newly created 7 x 8 foot room was then soundproofed with
foam tiles that cost around $500. Holyfield found the effort worthwhile. “The
studio is working out great. It was amazing to hear the difference as the foam
went up. Now I have a completely silent room, except when the A/C turns on
(which I can turn off most times, since the basement is pretty cool).” Figure
6-3 shows the process he went through: the arrival of acoustical foam (left),
measuring twice and cutting once (center), and the studio (right). The advan-
tage of being in the basement is far less outside noise entering through the
walls. The advantage of the acoustic foam is to reduce sound waves bouncing
off the walls and creating unwanted effects.

Renovation, especially if you're a fan of the DIY Network, makes this kind of
home-built studio a possibility, but still may not be a practical solution for all
homeowners. And this kind of aggressive home improvement is seriously
frowned upon if you're renting an apartment.

You can keep this home renovation affordable and within the lease agree-
ment terms:

1 Stuff towels under the door. It decreases the amount of sound from
inside your house filtering into your recording area.

1 Keep the microphone as far away from your computer as possible. Its
fan (if audible) simply becomes part of the natural ambiance for the pod-
casting room.
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v Turn off any ceiling fans, floor heaters, additional air conditioners, or
room ionizers. With fewer appliances running, you have less chance of
additional ambient sound being created.

v If you do encounter ambient noise that you don’t want in your pod-
cast, simply give it a few moments. Wait until the noise subsides, pause,
and then pick up your podcast a few lines before the interruption. That’s
for the sake of post-production: With a substantial gap in your podcast
activity, you can easily narrow down where your edits are needed.

When noise interferes with your podcast, leaving gaps of silence so you know
where to edit isn’t exactly a foolproof method. Always set aside enough time
to listen to your podcast — and really listen, not just play it back while you
clean the office or call a friend. Make sure levels are even, no segments are
repeated, and the final product is ready for uploading and posting.

Many podcasts rely on ambient noise to set a mood, but sometimes reality
just doesn’t cut it. If you want to put more craft into the setting for your pod-
cast, the ideas in this section should help you keep the background down to
a dull roar.

When holding podcasts on location, make sure the ambiance — be it a particu-
larly busy crosswalk at a street corner, a frequented bar, or backstage at a
concert — does not overwhelm your voice. Background noise belongs in (well,
yeah) the background. Its intent is to set a tone for the aim of the podcast, not
to become the podcast itself. It would also be a good idea, if possible, to do a
few test recordings in the space to see how much volume you’ll need and how
close to the mic you have to be in order to be heard.

Now Take Vour Time and Hurry Up:
Pacing and Clock Management

Podcasts, whether short and sweet or epic and ambitious, all share some-
thing in common: the need for pacing. As a rule, you don’t want to blurt out
the aim or intent of your podcast in the opening five minutes and then pad
the remaining ten or fifteen with fluff. Nor do you want to drone on and on
(and on . . ) till suddenly you have to rush frantically into why you’re pod-
casting on this particular day about this particular topic. Give yourself ample
time to set the mood comfortably and competently and make it to the intent
without dawdling. Enjoy your podcast but respect your listeners’ time. Make
certain you don’t overstay your welcome. The trick in pacing is to under-
stand how much time you have to get your message across.
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So the big question is how to really grasp how much time you really have.
Where to start?

It’s a good idea to get a grasp of how much time you really have in one whole
minute. To do this, find a clock, watch, or a stopwatch and for one minute
(and only one minute) sit quietly and do nothing, say nothing, and remain
perfectly still. That one minute will feel like a short eternity. Now imagine
that one minute times 15. (No, no, no — do not repeat this exercise for 15
minutes. There’s a fine line between an exercise and a complete waste of
time.)

Fifteen minutes (for a start) is a good amount of time on your hands, so you
should make certain that in your podcast you take your time to get to the
message. The journey you take your listeners on doesn’t necessarily have to
occupy all of that time — be it 15, 20, or 30 minutes — but you have time to
play. That’s the most important thing to remember as you set your best pod-
casting pace.

Take the potato out of your
mouth and enunciate

This section is dedicated to FarPoint Media’s, Michael R. Mennenga. He’s an
easy guy to love; but, man, does he need to take a breath and give himself a
moment before speaking. It’s rough enough when your Slice of SciFi co-hosts
are constantly riding you like a Triple Crown winner; but an intervention is in
order when Bruce Campbell (Ash from the Evil Dead films, and Elvis from
Bubba Ho-tep) puts you in your place — and on your show!

And sometimes, all you need to sharpen your speech and your vocabulary is
to take a breath.

It isn’t out of the ordinary to fire up the mic and launch into your podcast
with enough energy and vitality to power a small shire in England. Nothing
wrong with that — until you go back and listen to yourself. Your words,
phrases, and thoughts are running together and forming one turbulent,
muddy stream of thought. Yes, that is your voice, but even you're having a
tough time understanding what the podcast is about and what the podcaster
is saying . . . and you’re the podcaster!

One way of getting a grip on pacing yourself through a podcast is enunciation —
pronouncing your words distinctly, explaining your topic clearly — and there is
no better way to do that than to slow your speech slightly and listen carefully to
certain consonants (for example, the ¢, s, and d sounds). Proper enunciation can
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help you set a comfortable pace and keep you from rushing through your pre-
sentation. In fact, it isn’t a bad idea to over-enunciate. In the excitement of
recording, over-enunciation actually forces you to slow down, clean up your pro-
nunciation, and make your voice easily understandable. That same excitement is
likely to increase your pace of speaking. Again, if the rapid pace is part of your
presentation, stick with it, but if you're doing anything like a narration for an
audio book, slow down. If you think you're speaking just a little too slowly,
you’re probably going just the right speed.

Speaking a few tongue-twisters before going on mic helps your enunciation
and also warms up your voice and prepares it for the podcast you’re about to
record. Here are some easy ones that emphasize the problem consonants lost
when speaking too quickly:

v Toot the tin trumpet, Tommy, in time.

v Pop prickly pickles past the peck of parsley.
v See sand slip silently through the sunlit seals.
v The sixth sheik’s sheep is sick.

v Will Wendy remember wrecking the white rocker?

If you perform a search online for tongue twisters, you can find a wide variety
of classic and original warm-ups for the voice. You can also take the twisters
you find and compose your own.

And now let’s take a break
for station identification

Ever notice that certain podcasts suddenly break in with a show ID or take
some other marked break and then (if they’re lucky enough to have spon-
sors) play their sponsors’ spots? They’re trying to emulate — and maybe
make themselves easily syndicated by — conventional radio. You know —
the broadcasting industry. Clock management is the careful, standardized
interruption of a typical radio broadcast — usually every 15 minutes in a one-
hour slot — for such necessities as station identification, show identification,
public-service announcements (PSAs), and (of course) commercials.

Following this professional format has broadened podcasting’s potential of
becoming a commercial venue. Many shows such as NPR, The Dragon Page:
Cover to Cover, and NBC’s The Today Show are following clock management
as they’re syndicated for radio or television already. Tailoring a podcast for
the broadcast airwaves, or even scheduling in quarterly breaks in the hour,
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can actually work in your favor. Some podcasts such as Dancing with
Elephants (http://dwithe.com), and the audio novels of Scott Sigler
(http://scottsigler.net) have found natural places in their episodes
for ads. They may not be following strict clock management, but it’s a step
towards that model, making advertising and commercial gain in podcasting a
possibility.

Another nice bonus of following clock management is you have several points
in your show to give a quick “show ID” (something like “You’re listening to
Technorama with Chuck and Kreg . . .”) that lets people know who you are.
This show ID is great to catch the attention of people who may be walking
into the middle of your podcast, and just as they ask the podcast listener
“What are you listening to?” the show ID drops. Although “show IDs” are usu-
ally expected at the top of the hour and on the half-hour, you can drop in a
show ID anytime you feel like it.

Clock management usually works in this fashion during an hour:

v :00 — programming break, station identification, show ID, PSAs,
advertisements

v :15 — programming break, PSAs, advertisements

v :30 — programming break, station identification, show ID, PSAs,
advertisements

v 45 — programming break, PSAs, advertisements

These breaks vary in length but can last anywhere from two minutes to five
minutes. No surprise that this is where hardcore podcasters (anyone pod-
casting since before early 2005) get a bit restless. They find clock manage-
ment and show ID redundant, if not frivolous. Why bother to break or even
drop in a show ID? People have downloaded your feed specifically. They
know what they’re listening to, so what purpose does clock management
serve?

It all comes back to what you see for your podcast’s future. If you intend to
remain in the podosphere (the community of podcasters and loyal listeners, a
podcast version of the blogosphere), it really comes down to your format,
your way. No constraints from the FCC. It’s just you, the microphone, your
listeners, and caution to the wind. However, if you set your sights for the
broadcast airwaves — be it AM, FM, or satellite radio — you have to format
your show to fit the standards. This may not sound like a challenge, but when
Michael R. Mennenga and Evo Terra took the 2004 incarnation of The Dragon
Page from a pre-recorded venue to a live call-in show on an Arizona radio sta-
tion, their jump appeared no larger than a hop as the pace of the show was
already tailored for clock management.
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Podcasting goes pro

Broadcasting networks that present to the air-  podosphere as a way to market their shows and
waves sensational commentators like Sean reach a worldwide audience.

Hannity, Anderson Cooper, Bill Mahr, and Rush
(no, not the kickin’ rock group from Canada,
but the big man of the Right Wing, Rush
Limbaugh .. .) are now taking their shows to the

Along with the talk-radio personalities, other
major players in broadcasting turning to pod-
casting as an alternative include NPR, ESPN,
Disney, the BBC, and ABC.

Think about the possibilities of your podcast and where you see yourself
with it several months (or years) down the road. Maybe a bit of management
and organization will aid your podcast in jumping to the airwaves.

Concerning Tangents and Their Val —
Oh, Look, a Butterfly!

It’s hardly surprising that broadcasters who have no experience in broad-
casting tend to stray from their topic once the microphone goes hot, and
then they lose themselves in the thickets and thorns of tangents. Defensive
podcasters claim that’s part of the charm of podcasting, but that charm fades
as the topic gets closer to serious. If (for example) you launch a podcast
intent on addressing the growing concern of television violence and wander
into American Idol trivia, don’t be surprised if your audience wanders away.

QQ,N\BER It’s worth repeating: Stay focused on the intent of your podcast. Remaining
& true to your podcast’s intent isn’t just a matter of staying within your running
time; it also makes clear to your listeners that, yes, you have a message and
you will deliver it. You haven’t promised something substantial only to let
your mind and commentary wander aimlessly. When people listen, you want
them to feel assured that what they will hear is exactly what you've offered.

Read on to find out how you can make tangents work and how to smoothly
get back on topic after you've taken your side trip.

)

“Say, that reminds me of something . . .’

Tangents can be creative opportunities. You don’t necessarily treat tangents
as strictly verboten in podcasting. If your tangent is directly related to, or
benefits/enhances, your topic, it can be effective and engaging.
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Say your commentary begins with “Anyone notice how cell phones are no
longer just cell phones but tiny PDAs that can be easily monitored and
hacked into?” and covers that for a bit, and then you break off on a tangent
about cell phone etiquette and the lack of manners it brings out of people,
then this is a tangent that will keep your listeners engaged — and that can
count as much as staying on topic.

What if your podcast isn’t so structured, though? There’s nothing wrong with
hitting Record and forging ahead into the great unknown of the next 15 or 20
minutes, so long as you have an idea of where you want to go. Tangents are
terrific in moderation, but put some reins on ’em and keep them at least
(well, yeah) tangentially related to the subject matter of your podcast. If, say,
your podcast is about movies but your review of The Fantastic Four suddenly
goes into the decline of the comic book industry (regardless of the onslaught
of comic-books-to-film productions), then you still have a sense of focus.
However, if your review of The Fantastic Four wanders off into how your cat
is throwing up hairballs every time you podcast or that your car’s sunroof
chose to stop working, blah, blah, what the heck is going on here? Your audi-
ence may grow frustrated enough to stop listening.

“But getting back to what
1 was saying earlier . . .”

When you’re podcasting for 15 or 20 minutes (or longer . . .), it’s okay to take
the scenic route with your discussion, but make sure that you return to the
point you wanted to make in this particular (weekly, bi-weekly, or monthly)
installment. The listener’s delight in podcasts is often the revelation that indi-
viduals who (in many cases) have never set foot in a recording studio can
produce entertaining, and even informative, shows. Sometimes meandering
back to the point is part of that delight.

For instance, a podcast might begin with something read in the headlines —
say, a new marketing strategy launched by Apple for the iPhone to reach a
wider client base. This can lead to a variety of topics in the discussion, such
as the following:

v Multipurpose cell phones that play MP3s, video clips, text messages,
and podcasts

v Costs for iPhone services from AT&T and other carriers

1 Ways that carriers could bring down the costs of services

v Continued shortcomings and disappointments from the cell-phone
industry
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The name says it all

The ADD Cast(http: //addcast .net)has
a real charm about it in that its hosts Paul
Fischer and Martha Holloway indulge in the
many tangents that, on hitting the Record
button, they explore with their numerous in-
studio guests. What makes The ADD Cast so
much fun to listen to is how they go completely
off-topic and try to come back full circle at the
end. Sometimes, it's the guests that bring Paul
and Martha back to the starting point. Other

control

the

times, it's the show hosts themselves. Many
times, though, The ADD Castlives up to its name
and covers a lot of ground in less than an hour’s
time, ending with an offering from the Podsafe
Music Network. Although most shows try to
stay focused on the topic at hand, the cast of
The ADD Cast creates engaging content with
tangents. Have a listen and you'll soon under-
stand what they mean by “If you can’t control
the stimulus, control the response.”

response

But in the last five to ten minutes, a simple segue like “So, to recap our
thoughts on this bold marketing strategy from Apple to offer the iPhone
legally to other carriers. . .” can successfully steer you, or you and your co-
hosts, back to the aim and intent of your podcast. If you return deliberately
from a tangent, your listening audience arrives back at the point and knows
the destination as well as the scenery they went through to get there.
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Get your listeners there and back again. Not only will they appreciate it, but
they’ll tell others about your podcast, and your subscribers will grow in
numbers.

We hit on the topic of using a script versus an outline in Chapter 4. When it
comes to staying on track, clearly, a script has a distinct advantage over an
outline. Regarding interviews (see Chapter 5), having a list of questions is
important, but don’t be afraid to ask impromptu questions — you can always
go back to your prepared list.

Recording!

Whew — there certainly is a lot to think about before you get started. That’s
what makes a great podcast — someone did some planning. Now it’s time to
put that planning and practicing into action.

Getting started with GarageBand

When you first start GarageBand, you’re presented with an array of choices.
How you answer this first question has ramifications on what you can — and
in some cases cannot — do in GarageBand: Should you create a new music
project or a new podcast episode? Believe it or not, if your goal is to have an
MP3 to distribute to the world, you want to create a new music project. Ah,
the sweet ironies of podcasting. The reason is because so many of the
defaults for a new podcast episode are set up to create an “enhanced” pod-
cast, one that contains multiple images, discrete sections known as chapters,
and a file format (m4a) that is playable only on an Apple-branded product
like an iPod or iTunes. That isn’t to say you can’t create an MP3 by creating a
podcast project in GarageBand, but it requires a few extra steps.

For simplicity’s sake, choose to create a new music project. We also recom-
mend changing a few settings that work better for music composition than
they do for podcast recording:

v Turn off the metronome. The metronome is a device used to keep time
in music. If you don’t turn it off, you’ll hear a click-click-click while
you’re speaking — annoying to say the least. The easiest way to turn it
off is to press 38+U.

v Turn off the snap-to-grid feature. Again, this feature is beneficial to
musicians but can be rather annoying to podcasters when it comes to
editing. By turning this feature off, you can edit any arbitrary position
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rather than those based on measured spaces. To turn off snap-to-grid,
press 8+G.

* Delete the default track. Not to sound like a broken record, but this too
has a purpose for musicians. The first track doesn’t really have a use for
recording voice, so delete it by pressing 8 +Del.

v Turn off the keyboard display. Unless you have a need to plink on the
keyboard while recording your podcast, turn it off by pressing 38+K.

v Show time in the LCD. In the bottom of the GarageBand window is a dis-
play. Because you picked a music project, it shows measures. For your
podcast, time is more appropriate so switch it by pressing Shift+38+F.

That may seem like a lot before you even hit the Record button, but it takes
about a second to press all those key sequences. If you prefer, you can find
most of these on the Control menu.

Now you have a clean slate to start with. There’s just one more thing to
check before you “throw the switch,” and that’s to make sure GarageBand
knows where to get input from. Choose GarageBand=~>Preferences and click
Audio/Midi at the top of the window that pops up. Check to make sure your
Audio Input is selected correctly. The setting varies depending on your
actual input (USB microphone, FireWire mixer, analog mixer to the built-in
audio, and so on). After that’s taken care of, close the window.

Go ahead and create a new track by choosing Track=>New Track, click the big
red Record button on the bottom, and begin speaking. When you’re ready to
stop, click the Play button. Note, clicking the Record button again stops
recording, but GarageBand continues playing.

Congratulations, you've made your first recording in GarageBand!

Getting started with Audacity

Audacity was meant to be simple. To record a podcast in Audacity, follow
these simple steps:

1. Set your input.

At the top of the screen you can find a drop-down list with several
choices — Line In, Microphone, CD Player, and so on. Your settings
depend on your system setup. Audacity is pretty good at detecting what
inputs it can use on your system. Go ahead and pick the proper one.
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2. Click the Record button.

Audacity creates a new track and begins recording. As you speak your
words of wisdom to the world, you should see the meters moving and
the waveform being created.

3. Click the Stop button.
When you’re done, just click Stop.

Congratulations, you've made your first recording using Audacity. Now you
know why so many podcasters love it!



Chapter 7
Cleanup, Podcast Aisle 7!

In This Chapter
Pondering “To edit, or not to edit . ..”
Adding bed music for a comfortable podcast

Introducing intros and outros

A Ithough a high-tech activity like podcasting doesn’t exactly qualify

as quaint, “the charm of podcasting” is (as Steve Jobs describes it)

a Wayne’s World approach to broadcasting. In Wayne’s World (1992), two
lllinois teenagers, Wayne and Garth, shoot a television show in Wayne’s base-
ment. They rock and roll their afternoons away for their local cable-access
station, all on the budget that their allowance (and perhaps the odd sponsor
or two) can swing.

Podcasts, much like Wayne’s World, are often done on a shoestring budget
and recorded in one take, with no editing. All the trip-ups and tangents are
captured for posterity and sent to MP3 players everywhere. This is part of
the homespun appeal that podcasting is not only known for, but prides itself
on nurturing as new and innovative podcasters enter the podosphere.

Although podcasting purists may harbor animosity toward the editing pro-
cess, sometimes it makes all the difference between a listenable podcast and
an incoherent mess of senseless rambling. For example, you might want to
eliminate the sound of a train going by or silence a cough that would other-
wise distract your listeners from a brilliant riposte. This chapter shows you
how to use editing to shape your podcast while retaining its natural atmo-
sphere, adding depth to that atmosphere with music, and then give the final
touch to your podcast’s format with an introduction and exit.
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A Few Reasons to Consider Editing

Take a serious look at the script and the mood you want to convey with your
podcast. From there, you can judge how intense your editing workload will
be. The following list explains some instances where editing is needed — and
(trust us) your podcast will benefit from it:

v Professional production quality: You can’t always get everything right
on the first take — and sometimes not even on the second or third.
Editing makes it sound like you got even hard-to-pronounce names and
tricky tongue twisters right on the first try. What’s more, you can drop
in pre-produced clips with just the right amount of space before and
after to give it that polished feel.

* Removing boring material: You've probably watched a live show or
listened to live audio that doesn’t go quite where it is intended. The
content gets dull and uninteresting. As a listener, you can fast forward,
change the channel, or just turn it off. As a podcaster, you can avoid this
situation with editing. But even though it sounds easy to take out the
boring bits, be careful that you maintain continuity. If edited improperly,
the listeners may find themselves confused because the line of ques-
tions changed from space travel to herbs and spices in the matter of a
few seconds.

v Ambient noise: As explained in Chapter 6, ambient noise is the natural
and spontaneously occurring noise you may pick up when recording
your podcast. In some productions, such as podiobooks (books podcast
one chapter at a time, in a serialized format), moods and atmospheres
must be maintained. In others — say, a radio drama like The Radio
Adventures of Doctor Floyd (http://doctorfloyd.com)— continuity
and clarity are established, requiring a certain amount of editing simply
to control ambient noise. If you're conducting an in-studio interview and
suddenly a passing siren or the rumble of a garbage truck makes it into
your recording, the noise can disrupt the momentum of the interview
and distract the audience.

+* Running times: You just wrapped your latest podcast with a great inter-
view, and you’re confident that you have plenty of material for your
30-minute podcast. And then you check again and realize that you have
recorded over 90 minutes’ worth of interview. And you love all of it!
Now here’s where editing works in your favor. Your listeners expect 30
minutes, give or take a segment or two, from your podcast. You could
run the whole thing, unedited, but that might test the patience of your
audience members (not to mention their bandwidth and file storage).
Or you could split it up into two 45-minute interviews — or even three
30-minute interviews — breaking up the airplay of the interviews with
two smaller podcasts in-between the segments. In this approach to edit-
ing, everyone wins.
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Editing can easily increase your productivity with podcasts. True, some
podcasters define “editing” as cutting and deleting material, but there’s
more to it. Editing can actually help you rescue discussions and content
that would otherwise be hard to shoehorn into one podcast.

v Scripted material: Some podcasters argue that the true podcast is done

in one take, but as podcasting matures as a medium, audiences grow
more and more demanding. Expectations for a podcast change when
your podcast includes scripted material. Editing is a necessity in these
situations. With dramatic readings and productions, moments of “ah”
and “um” should be edited out to maintain the clarity of the story, as
well as maintain the mood or atmosphere established in your reading.

With the rising popularity of audio literature in the podosphere, pro-
fessionalism and performance are the keys to a good product — and
usually that means (yep) editing. If you feel that editing would mar the
spontaneity of your podcast — but still want to present literature or
other scripted material — ask yourself how good you think The Lord of
the Rings would had been if lan McKellen or Viggo Mortensen did every-
thing in one take. Imagine their dialogue sounding like this:

Gandalf: Frodo . . . he, uuummm, grows closer to, you know, the
end. I wonder if, um, he’s, ahh . . . alive.

Aragorn: Ummm . . . what *sneezes suddenly — sniffle sniffle* . . .
what does your heart *ahem* tell you?

Not what we would call riveting drama. With scripted material, editing is
a must.

The Art of Editing

Editing out breaks, stammers, and trip-ups may sound easy, but there’s a sci-
ence to it. If you cut off too much from a clip, one word comes right on top
of another, and you sound unnatural. If you don’t cut off enough, pauses last
too long between thoughts.

WMBER
@&
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When you're editing voice, the key is to review, review, review.

Alot of audio applications are out there, each with their own way to edit
stumbles, bumbles, and moments of silence to honor a lost thought. The
same principles apply to all of those applications:

1.
2.

Find the unwanted content.

Give your clip a little bit — perhaps a half a second — of silence as
leader or “play area” between edits.

. Review the edit, making sure it sounds smooth and natural; an effective

edit doesn’t sound like an edit.
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But instead of talking about it, how about you do it? In the following sec-
tions, we go into basic editing using GarageBand (www.apple.com/ilife/
garageband) and Audacity (http://audacity.sourceforge.net) as
examples. These are two very common audio-editing software packages in
podcasting, and both serve as our benchmarks for how to create podcasts. If
you're using some other audio-editing software package, the steps are similar
enough for you to apply to your own project.

Editing with GarageBand

You can use GarageBand to edit awkward gaps of silence or eliminate coughs
and stammers from your podcast. We assume at this point you just finished
recording or opened a GarageBand file with a recorded track already done
(see Chapter 6 for instructions on recording with GarageBand). You can also
import audio files (perhaps recorded on a portable device) by dragging them
from the Finder into GarageBand.

To prepare for editing the silences and splutters, split your audio into
smaller segments to isolate the audio that you want to remove. Then follow
these steps:

1. Determine where in the track you want to make the edit by clicking
and dragging the playhead to the beginning point of your edit.

Use the Time Display readout to see exactly how long the gap of silence
runs. The playhead tool is the triangle connected to a vertical red line.
(See Figure 7-1 for details.) When creating segments, you want to place
this line at the beginning and ending points of your edit.

<P Silence is pretty easy to see when you're looking at a waveform of the
audio. Coughs or other noise can be a little trickier to isolate. We sug-
gest watching the waveform while you listen to the audio at the same
time. You may want to use the slider in the bottom left to increase your
time scale resolution and make it easier to work with smaller bits of
information.

2. Choose Edit=>Split to make the first cut.
Figure 7-1 shows the first cut.

3. Move your playhead to the location where you want the edit to end.
Then choose Edit~>Split to make your next cut.

<P As you edit, give yourself a second or two of silent “play area” at the
beginning and end of your edits. It makes the editing of two segments
sound like one continuous segment, and they’ll be a little easier to mix
together.



Chapter 7: Cleanup, Podcast Aisle 7! 1 2 7
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4. Single-click the segment between your two cuts and then press the

Delete key.

If you're working with GarageBand for the first time, note that the first
track of audio is selected by default. To deselect the segment you're
editing, single-click anywhere in the gray area underneath the track(s)
you're working on.

. To join the two remaining audio segments, click and drag the right

segment over the left segment, overlapping the two (as shown in
Figure 7-2).

If the selected segment overlaps any part of the unselected segment, it
takes priority over the unselected segment, effectively erasing any con-
tent there.

You can combine the step of deleting a segment and closing the
gap (delete and move) by using the GarageBand key sequence
Ctrl+Backspace.
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6. Click and drag the playhead to any point before the edit and click the
Play button to review.

7. If the edit doesn’t sound natural, undo the changes (by choosing
Edit=>Undo Change of Position Region) and try again.

Because you’re allowed multiple undos in GarageBand, you can step
back in your project to begin at the first Split command.

Hate editing? Getreal ...

Are there exceptions to the rule? Absolutely!
Yes, a performance is at its best when your
actors are stammer-free, but back in 1938
there was a radio drama that was chock-full of
trip-ups, stutters, and “fluffs” as Paul Jenkins
of RevUp Review (www.revupreview.
co.uk) calls them. With all this going against
its production, the Mercury Theatre terrified a
nation with its adaptation of H.G. Wells’ War of

the Worlds, arguably the first “reality-based”
entertainment (well, a realistic simulation of
reality, anyway) unleashed on America — the
fluffs intensified the illusion of reality. If your
podcast is primarily entertainment anchored
in reality, you can probably avoid the arduous
editing process. Again, it depends on the con-
tent you're podcasting.
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As much as we would love to cover all the neat doo-dads in GarageBand —
and there are a lot of them — we need to stick to the essentials you need
to get started podcasting. For more in-depth information on mastering
GarageBand, there are plenty of other resources available, including The
Garage Door Web site at http: //thegaragedoor.com.

Editing with Audacity

At this point, we assume you’ve just finished recording something awesome
with Audacity (see Chapter 6 for instructions), or perhaps you've opened a
saved project. If you have an audio file from another source, such as a porta-
ble recorder, you can import it using File>Import. Now you’re ready to follow
these steps to make a basic edit:

1. Find the segment that you want to edit.

To view the entire timeline of your project, click the Fit Project in
Window tool, shown here in the margin.

You can easily navigate between the segments of your timelines selected
and the project timeline as a whole with the Fit Project in Window and
Fit Selection in Window tools, located in the top-right section of the proj-
ect window.

2. Click the Selection tool — in the upper left (Mac) and upper center
(Windows) — and then click and drag across the unwanted segment.

The unwanted segment is highlighted, as shown in Figure 7-3.

Right about here would be a good opportunity to use the Fit Selection in
Window tool to double-check that the selection border doesn’t go into
the recorded content you want to keep.

3. Single-click the segment between your two cuts and then press the
Delete key (Mac) or the Backspace key (Windows).

You can also choose Editr>Cut or press 8+X (Mac)/Ctrl+X (Windows) to
remove the unwanted segment.

Do not use the Trim command. (HERE’S THE COMMAND NOT TO USE:
Edit>Trim or 88+T for Mac/Ctrl+T for Windows.) You may think you are
trimming away unwanted content, but this command works differently
from the 38+T command in GarageBand: Just like when you crop an
image, it trims off unselected material — leaving you with only the con-
tent you wanted to edit out. Ack!

4. Review the clip.

5. If the edit doesn’t sound natural to you, undo the changes by choosing
Edit=>Undo Change of Position Region or pressing 8+Z (Mac) or Ctrl+Z
(Windows), and try again.



130 Partii: The Hills Are Alive with the Sound of Podcasting

|
Figure 7-3:
With the
Selection
tool, click
and drag
across the
unwanted
contentin
the timeline.
|

Movie-Trailer-Music
L IL] I
R

R L s d| !
2 o Y Y S D 1 e 2 o e
45 8

1:00

= mw'_w-ww

o 15

€
- Project Rate (Hz):  Selection Start: @End (Olength  Audio Position:
“eat0 (5) | GO00m22sd | 00R00m32sY | 0000 MO0 ST

Draw Tool

You're allowed multiple undos in Audacity, giving you the advantage
to go back to the beginning point of your editing just in case you aren’t
happy with the sound of the edit.

Making Your Musical Bed and
Lying in It: Background Music

On listening to podcasts of people in interview situations or in round table
discussions, there can be a strange sense of isolation, especially if the con-
versation hits a pocket of dead air (when conversation or the signal stops),
and only silence is recorded or broadcast.

A few podcasters like to add a little bit of atmosphere in their individual pod-
cast with bed music — a background soundtrack that’s usually two to three
minutes long and is looped so it can play again and again throughout the
podcast, if desired. Sometimes the bed music lasts only a minute or two into
the podcast when the hosts return from the break, whereas other shows, like
Chuck Tomasi’s Gmail Podcast, keep it going from beginning to end, fading it
out if they’re bringing in any other sources of audio (voice mail, other pod-
cast promos, ads, and so on).
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Regardless of how long the loop is, you must obtain permission from the art-
ists to use their music and give them audible credit — either at the beginning
or end of your podcast. If you're using shareware music, such as from Podsafe
Music Network (http://music.podshow.com), giving audible credit is one
of the conditions you must agree to. Other options include using music loops
found in GarageBand, Audition, or Soundtrack.

Finding the right balance

As you add music as a background bed, incorporate sound effects, and bring
in pre-recorded audio from other sources (such as a Samsung H2 or a Skype
call), the sound of your podcast gets more complex. Balance becomes not
only harder, but even more essential. (Note, for example, the various volume
levels of the multiple tracks in Figure 7-4.)

Bed music should add atmosphere to your podcast. That means finding a
proper balance between the talking of the hosts and the soundtrack. The fol-
lowing sections explain why you want to avoid music that’s too soft or too
loud.
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What is that noise?

If your music is too soft, your looped music could be mistaken as unwanted
ambient noise of someone listening to music in the next room. Or it could

be regarded as some kind of technical difficulty such as a stray signal bleed-
ing (another wireless audio signal accidentally being picked up by the same
frequency as your own wireless audio device) into the podcaster’s wireless
microphone. Music too indistinct to hear can be a distraction, particularly in
quiet moments or pauses in the conversation. Your audience might end up
hammering out e-mail after e-mail (asking what’s making that annoying noise)
or trying to figure out what that faint music in the background is.

Could you speak up? 1 can’t hear you for the music . . .

When bed music is too loud, your voice is lost in the melody. Music, espe-
cially classical music and selections that rise and fall in intensity (like any
good Queen album) can be really tricky to mix into a conversation.

You do want to allow your audience to hear the music in the background, but
the music, if you're using it as background music, probably isn’t the point

of the podcast. It shouldn’t be so loud that you have to pump up your own
voice track to be heard.

Never sacrifice audio clarity so bed music can be heard and identified clearly.
If you want to showcase music, then showcase music properly. Otherwise,
your bed music should remain in the background as a setting, not in the fore-
front of your podcast.

Applying bed music the right way

When you’re setting audio levels, you want to find the best blend of music
and voice, assuring one doesn’t overpower the other. Both tracks should
work together and not struggle for dominance.

Always listen to the podcast before uploading to the Internet — review,
review, review, and find that balance.

To avoid music that’s either too soft or too loud, keep the following points in
mind as you apply the bed music:

v Experiment with levels for the music before you record voice. Watch
your decibel level meter and set your music between -11 and 16 dB,
depending on the music or sound effects you're using.

+* When you’re comfortable with the bed’s level, lay down a voice track
and see how your project’s overall levels look (as well as sound) on
your decibel level meter. Remember, your aim is to keep your voice
in the “0” or red area without overmodulating. With the music bed now
behind your voice, it’s much easier to hit the red without effort.
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v Avoid “uneven” music, or music that suddenly dips low and then has
moments of sudden intensity. The best music-bed-friendly loops have
an even sound (whether driving and dramatic or laid-back and relaxed)
and an even level.

v Experiment with putting your music at the beginning and at the
ending of your podcast instead of throughout. In these cases, music
beds announce upcoming breaks and pauses in your podcast.

Setting volume levels for bed music

Each audio application has its own way to change volume dynamically — but
the basic process is the same. In the sections that follow, you find out how
to use GarageBand and Audacity to bring music into your podcast at full
volume, and then balance it to be just audible enough in the background.

Setting volume levels manually with GarageBand
Follow these steps to set volume levels with GarageBand:

1. Click to select the track icon (usually represented by a silhouette of a
person) that your voice resides on.

All segments in this track only are selected.

2. Click and drag the playhead to anywhere between five and ten sec-
onds into the project.

If you look at the Time Display in GarageBand and see a music note in
the left corner, single-click it. Doing so switches the display out of Beats
and Measures mode and into Time mode.

3. Click and drag the beginning of your vocal track (your voice) to the
playhead.

You now have ten seconds of lead time between the beginning of the
timeline and your podcast.

4. In the Finder open a window and find the music file you want to
use as your bed music. Click and drag the file into GarageBand, just
underneath your podcast track, as shown in Figure 7-5.

When using sound effects or bed music, try to use AIFF or WAV files.

An MP3 file is a compressed file. Compressed files (film, photo, audio,
whatever) are usually far from ideal for editing because there’s loss with
every compression cycle — you lose a bit of quality. If you have audio
bits you want to export for editing, perhaps in another program, we
recommend to export them in a raw format such as AIFF or WAV so you
don’t lose any quality.

133
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5. Expand the new track of audio you just imported into the project by
clicking the Expand Track (the upside-down triangle) tool located in
the collection of tools grouped with the music track.

You should see a thin blue line against a simple grid. This is your track
volume control. If your playhead isn’t at the ten-second mark, be sure to
put it there.

6. Click at the point where the playhead line and the volume control line
intersect.

You have now created a control point — a place you can click and drag
to change volume levels at various times. (See Figure 7-6.)

N

Move your playhead back two seconds to the eight-second mark. At
the eight-second mark, click the volume control to create another con-
trol point.

8. Return to the first control point you created (in Step 6). Click, hold,
and drag the control point halfway between the bottom of the track-
volume partition and its current level.

You have just created a volume curve. Now the sound dips lower, allowing
for a voiceover to be heard with music softly playing in the background.

9. Move your playhead back to the ten-second mark, as shown in
Figure 7-6.
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Doing so completes your fade-down (the automatic fading of the music
to a subdued volume behind the voiceover).

10. Select the podcast track and click and drag your podcast segments to
where the content begins at the ten-second mark.

You now have a bed of music behind your podcast.

11. Bring the playhead back to the beginning and review your podcast.
Change the levels accordingly to set the music at a level you think
works best.

Setting volume levels automatically in GarageBand

Beginning in iLife ‘06, GarageBand includes a ducking feature to automati-
cally lower (and raise) the volumes of your bed music. When enabled, duck-
ing automatically senses audio from the other tracks and lowers any tracks.
When there is silence or a gap in the other tracks, the ducking feature raises
the volume.
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Follow these steps to have GarageBand automatically detect the volume
levels in your podcast:

1. Begin with the same four steps as the previous section, by dragging an
audio file from the Finder to GarageBand.

2. Choose Control~>Ducking from the menu.
A pair of arrows appears in the audio controls for each track.

3. Click the top triangle for the lead tracks, where the volume should
not be automatically adjusted, and click the bottom triangle to enable
ducking on your bed music track. (See Figure 7-7.)

Now when your primary track(s) have audio on them, the bed music
automatically fades down to roughly —14 dB and pops back up to 0
during gaps.

Ducking control

GarageBand - My Podcast
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You may find that the ducker isn’t responding rapidly enough. For example,
you don'’t feel your bed music is coming back up quickly enough after you're
done talking. If you have GarageBand '08, you can adjust the sensitivity of the
ducker by following these steps:

1. Choose Track=>Show Track Info.

2. When the Track Info pane appears, click Master Track and then click
the Details triangle at the bottom.

3. Choose a preset from its preset menu or click its Edit button (the little
pencil) to fine-tune things with the sliders.

So the likely question in your mind right now is “Why would [ want to set the
volume levels manually instead of automatic ducking?” As with anything,
manual control affords the ability to be in complete control of your volume
levels — at the trade off of increased effort. If you plan on using bed music,
our recommendation is to try the auto-ducking feature and see whether it
meets your needs. If not, work with the manual audio controls.

Setting volume levels with Audacity
If you're using Audacity, you can set volume levels by following these steps:

1. Click the Selection tool to activate it and then click at the ten-second
mark of your timeline, placing an edit line there.

2. Click the Time Shift Tool button on the toolbar, shown in the margin.

The Time Shift tool takes an entire track of content and places it else-
where along the project’s timeline.

3. Click and drag your audio to the edit line you created in Step 1.

4. Choose File>Import=>Audio and browse for the music file that you
want to use as bed music. Then select the file and click Open to begin
the import process.

Although you can import MP3 files directly into Audacity when you're
editing — be it film, photo, or audio — you shouldn’t be working with
compressed files. (It’s just too easy to lose a bit too much quality along
the way.) You can use them in Audacity, but do so at your own risk.

5. Click the Envelope Tool button on the toolbar.

The Envelope Tool allows you to dynamically control the audio levels
over a timeline. Clicking at the beginning of the audio track establishes
the first volume setting, and the second click (at the ten-second mark)
establishes the new volume level.
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6. Select the track of recently imported music by clicking its name on the
left side of the project window.

7. Click at the beginning of the music and then click at the point where
your podcast begins (the ten-second mark).

Two sets of points appear in your track of music.
8. Click and drag the second set of points to the 0.5 dB mark.

You now have a fade-down of the music that maintains its subdued
volume behind the voiceover.

9. Activate the Selection tool, click at the beginning of the timeline, and
then click Play to review your podcast.

Now you can change the levels as needed to set the music at a level you
think works best.

Making an Entrance: Intros

Now that your podcast has a solid lead-in and a cue to fade out — or you
have a loop throughout your podcast that sets a tone — your podcast is
beginning to solidify. It’s establishing an identity for itself; be proud of the
way this podcast of yours is maturing.

But when the microphone comes on, do you always know what those first
words are going to be? For some listeners, you're about to make a first
impression. What do you want that first impression to be? Are you looking
for something spontaneous every time, or do you want to create a familiar
greeting that makes listeners feel like old friends? Your chance to make a first
impression with your listeners is with an infro, which is the first thing the
listener hears, be it with a bit of theme music or a word or two about you and
your show.

It’s up to you, but think about how strong a first impression and a cool intro
can make. Consider the ten simple words that became the signature introduc-
tions for George Lucas’ Star Wars saga:

A long time ago in a galaxy far, far away . . .

This intro leaves an unforgettable first impression. But even if you're not
vying to be the next George Lucas, the first impression is always important.
No matter who you are, this is a moment that can either establish you as a
personality (and a podcast) that people will enjoy and anxiously await from
episode to episode, or it will make winning over audiences a little harder.
You want the first impression to be fascinating, lasting . . . and positive.
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Consistent, iconic intros can serve as a polished touch of preparation or a
subtle flair of professionalism. You’re announcing to your audience that the
show is on the launchpad, you're ready, and the journey is about to begin.

Theme music

How about a catchy theme? Just as television and motion picture themes
establish a thumbprint for themselves in pop culture, an opening theme — be
it a favorite song (used with permission!) or an original composition — can be
just the right intro for your podcast. Perhaps you have a friend in the wide
world of podcasting who can assist with audio production. Ask — you might
be surprised how willing other podcasters are to assist. Earlier-mentioned
software applications such as GarageBand, CakeWalk, Soundtrack, and
Audition all offer royalty-free loops that can be easily edited into your own
podcast intro. If you have a little cash in the coffers, check out Digital Juice
(www.digitaljuice.com) for a large collection of royalty-free jingles and
sound effects for around $50 per CD set.

<MBER Royalty free means you're free to use the audio clip over and over without
paying a license fee. You may still need to purchase the audio clips such as
Digital Juice. In the case of GarageBand, the loops and clips are included in the
price of the package with additional add-on libraries, or JamPacks, available
for $99 each.

Intro greeting

Some podcasters use quick, snappy intro greetings for their podcasts. For
example, Adam Christianson opens every show with a heavy rock riff and the
salutation “Hey, Mac Geeks, it’s time for the MacCast, the show for Mac Geeks
by Mac Geeks . . .” that kicks off his podcast, The MacCast (www .maccast.
com). Others create an imaginative setting; for Slice of SciFi (http://sli
ceofscifi.com), the crew has a more complex intro with music, sound
effects, and other audio clips. Whether elaborately produced or just a simple
welcome, a consistent greeting serves to bring listeners into your corner of
the podosphere.

The elements you’re looking for in a spoken introduction are

v The show’s name.
v The name(s) of the host(s).
v Location of the podcast.
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1 A tagline that identifies your show. One of the more interesting tag lines,
(and show titles), is Jimmy Jett’s Podcast About Nothing (www . jimmyjett.
com).

Sit down and brainstorm a few ideas on how to introduce your particular
podcast. For example, try these approaches on for size:

v “Good morning, Planet Earth! You're listening to My Corner: A Slice of
Cyberspace, and I'm your host, Tee Morris.”

v “From Washington, D.C., welcome to My Corner: A Slice of Cyberspace.”

v “With a perspective on politics, technology, and life in general, it’s Tee
Morris with the My Corner podcast.”

As you see in these examples, you can mix and match the elements to drop
into an intro. Come up with what feels right for you and your podcast, and
stick with it. After you’ve put together your greeting, you can either keep it
pre-recorded and use it as a drop-in (an isolated audio clip that you can use
repeatedly, either from podcast to podcast, or within a podcast) at the intro-
duction of your podcast, or you can script it and record it with each session.
Whatever method you choose, a greeting is another way of bringing your
audience into your 20 to 30 minutes (or five minutes to an hour and a half) of
time on someone’s MP3 player.

Exit, Stage Left: Outros

Now that you have reached the end of your message or the time limit you
have set yourself for a podcast, what do you do? Do you just say “Thanks,
everyone, see you next time . . .” or just a basic “Bye,” and then it’s over? Or
do you want to go out with a bit of fanfare? Whatever you decide, an outro

is much like an intro — as simple or elaborate as you want to make it. Your
outro is your final word, closing statement, and grand finale (at least for this
podcast).

In practical terms, putting together an outro is no different from putting
together an intro — same approach, only you’re doing it at the end. So review
the earlier suggestions for intros and consider what seems a likely direction
for an outro.

Some podcasters figure there’s little more to think about for an outro than
what to say and how to present it. Sure, you could keep it simple — say “Bye”
and switch off, no fuss, no script, just do it, done, and then upload. But other
podcasters see the outro as more of an art form. Before taking a shortcut

to the end, check out the following sections for some ways to spiff up your
outro.
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Leave the audience wanting more

Continuing your podcast to its final moments is a gutsy, confident, and excit-
ing outro, carrying your audience all the way to the final second. This is one

of the toughest ways to end a podcast, but if it’s done right, it can only make
your podcast better.

For example, Jimmy Jett’s Podcast About Nothing takes a cue dating back

to “Smokey and the Bandit” movies with outtakes at the end of each show.
While Jimmy’s entire show has a clean, professional polish to it, he keeps
you listening to the end to find out what really happened when he tried to
produce those segments. Just when you think the show is over with his sign
off “Bye-bye, my friend,” an announcer hits you saying “. . . and now, the out-
takes,” with all the bloopers Jimmy made along the way. The content contin-
ues right up to the end.

Catch phrase sign off

Your outro can be the final word from the host, and it should be your bow
during the curtain call. A signature farewell is a classy way of saying “This
podcast is a wrap. Thanks for listening.”

For example, throughout the years that journalist Walter Cronkite reported
the news to America, he always ended with the words, “And that’s the way
itis...” followed by the date. On Technorama, Chuck and Kreg have taken a
similar approach with their signature sign off starting with Chuck saying “And
until next time, a binary high five.” To which Kreg always responds “1-0-1.”

It has become such a well known piece of the show that listeners writing or
calling to leave feedback close their pieces with the same tag.

If you can’t think of anything overly clever, a consistent exit such as “This has
been my podcast. Thanks for listening . . .” works too.

Credits roll

Another possibility for your outro could be a scripted list of credits: Web
sites where past shows can be downloaded, resources can be endorsed, and
special thanks can be given to various supporters of your podcast.

<MBER When listing credits, take care that your list of thank-yous and acknowledg-
ments doesn’t ramble on for too long after every podcast. Some podcasters
reserve a full list of end credits for special podcasts, such as an “end-of-the-
season” or even “final” episode. By and large, a minute can serve as a good
length for ending credits — plenty of time to mention relevant Web sites, tuck
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in the obligatory “Tune in next week . . .” statement, and ask for a vote of sup-
port on your favorite podcast directory.

Coming soon to an MP3 player near you

Just as television shows drops teasers of what will be coming up next week,
podcasters can also give quick hints as to what is planned for future pod-
casts. Mark Jeffrey’s The Pocket and The Pendant (http: //pocketandpendant.
com) and Scott Sigler’s EarthCore (http://scottsigler.net) episodes
had already been pre-recorded for the intent of podcasting. This gave both
authors a terrific advantage to edit together montages of audio clips and
even record a quick synopsis of what was to come in the next

episode.

Previews for future podcasts tend to be difficult to plan — mainly because of
the spontaneous nature of podcasting that the medium prides itself on. Many
podcasters have no idea what will be on the agenda for their next show until
the day or even a few hours before recording, and then there are other pod-
casts that start up the audio equipment and speak with no prep time for their
latest installment. However, for those podcasts that can provide glimpses of
things to come, this kind of outro serves as a commitment to the audience
that there will be more content coming through the RSS feed and that pro-
gramming is being planned for future installments.

As mentioned with intros, your outro can use one of these approaches or
combine them. Find what best fits your podcast and stick with it. The more
consistency your podcast can follow, the more professional it sounds —
spontaneous but focused, right?
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In This Chapter

Making the jump from audio to video

Finding out what you need to make a video podcast
Creating a video podcast episode with iMovie

Preparing your Windows Movie Maker video for podcasting

n its first year, podcasting established itself as an exciting audio option.

It was truly “The People’s Radio” for your computer, promising a fresh
alternative to cookie-cutter corporate radio. A few potential podcasters took
a closer look at the way RSS 2.0 worked and thought, “Wait a second — if
we can do this with audio, what about video?” So a few brave podcasters
decided to put moving pictures to their podcasts; and while people still
search for “just the right term” (vidcast, vodcast, vodblog, and so on) video
podcasting came to be and continues to grow.

Once upon a time, professional-quality video production (such as editing,
post-production effects, and DVD authoring) on a consumer market was
either a pipe dream or a hobbyist’s major investment. With the advance-
ments in professional-grade cameras, advancements in home computing
systems, and the ease of video-editing software, producing broadcast-quality
video is not only affordable, it’s expected. Add to this the popularity of ser-
vices like YouTube (http://youtube.com) and LuluTV (http://1lulu.
tv), and creative minds both in the amateur and professional circles are now
looking at video podcasting as an alternative to distribution.

We barely scratch the surface of video podcasting in this chapter. To go
above and beyond, pick up your copy of Expert Podcasting Practices For
Dummies, which goes into great detail on post-production with audio, post-
production with video, and working with the professional applications like
Final Cut and Premiere.
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When to Go Video

While Evo and Chuck have only dipped their toes in working with video, Tee
sports the longest track record with editing video, both in a linear (the tradi-
tional two video decks tied together to one central deck with a control board
offering basic post production effects) and a nonlinear (all on a computer, in
a digital format) method. Even in those early Flintstones-esque days of digital
video, Tee thought this whole process very cool. Today, with terabyte drives,
gigahertz processors, and 8-core computers, a lot of things have changed,
and Tee’s opinion has changed as well. He now finds editing video on his Mac
very, very cool.

Video production is also not easy. Some of the downfalls to video podcasting are

v A learning curve: Despite what the commercials for Macs, Dells, and HP
computers insinuate, editing video is not a push-button technology. A lot
goes into video, even on the most basic of levels; with video podcasts like
Rocketboom (www . rocketboom. com), Calls for Cthulhu (www.calls
forcthulhu.com), and The Onion News (www . theonion.com), the bar
to run with the big boys and girls of video podcasting is pretty high.

v More production time: With video, you have to contend with more than
just ambient noise. Now you need to consider lighting, camera angles,
wardrobe, make-up, and so on. Podcasting audio can prove daunting in
its production needs, but video is a step up and demands a great deal of
time and attention.

So with all these daunting challenges, why go video with your podcast? Here
are some good reasons to step up to video podcasting:

+” Your message needs more than sound to get across to your audience.
If you're putting together a show for educational or training purposes,
you may want to feature diagrams or procedures that require visual
aids. With video, you now can appeal to listeners on a visual as well as
an aural level.

+* You want a captive audience. The ability or temptation to multitask is
removed as your subscribers are now applying the visual senses, taking
advantage of the video features in iTunes, iPhones, and iPods. They
can’t drive a vehicle, cook a meal, or walk Fluffykins at the same time
that they watch your video podcast, so you gain greater audience focus.

+* You want to create your definitive vision. In travel podcasts (also
known as sound-seeing tours), where the sounds of a marketplace pro-
vide the host with a background, or beer tastings (also called pubcasts,
barcasts, or beercasts) where the flavor of a local bar filters into the
show, or podcast novels (also called podiobooks) where a few sound
effects set the scene, the listener’s imagination fills in the blanks on
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what is happening around the podcaster. Now, the subscriber can see
and (virtually) experience walking through the marketplace in Athens,
take in the sights and sounds of a Western Yorkshire pub, or see the

characters as the author intended them to be seen, in the settings he or

she imagined.

Enhanced podcasting: The happy medium

If you're an audio podcaster who's curious
about going video but you aren’t quite ready
to make the jump, take a look at the rarely
employed but extremely versatile format of
enhanced podcasting. Enhanced podcasting
gives producers the ability to drop into their
podcasts chapter markers, images, and even
URLs. On iTunes, the Album Artwork window
provides visual aids for what the show hosts
are talking about. Although not as visually
demanding as video (you can still listen to the
audio without following the images), enhanced
podcasts are a terrific way to grab the atten-
tion of your audience: Keynote and PowerPoint
presentations can now be podcast as they are
presented, podcasters can now give you direct
access to resources cited, and chapter markers
can now help listeners navigate to their topic of
choice. With enhanced podcasting, the experi-
ence becomes more interactive.

So what's the catch? Enhanced podcasts use
the AAC format. These MA4A files play back only
in iTunes and QuickTime and can go portable
only on iPods. This can limit your audience, so

many enhanced podcasters produce two feeds,
essentially doubling their workloads. Also, at the
time of writing this edition, the best applications
for creating enhanced podcasts are GarageBand
and Soundtrack Pro 2 (both from Apple) and also
Lemonz Dream’s Podcast Factory. These appli-
cations run only on Mac 0S.

Still, with a bit of thought, planning, and
panache, an enhanced podcast can bring a
lot to your audience. Podcasting For Dummies:
Season Two, the companion podcast for this
book, is an enhanced podcast. The enhanced
version of MacCast (www .maccast .com)
gives links and images of various product
reviews and new items, providing an interac-
tion with tech hungry audiences. Stephen
Fry’s Podgrams (www . stephenfry.com/
podcasts) gives you maps, images, and even
a potential look at “branding” in a podcast about
the British actor Stephen Fry’s travels across
England and various points of the world. To find
out more about enhanced podcasting and what
it offers, check out Expert Podcasting Practices
For Dummies.

BROKEN ARM

BY STEPHEN FRY = 20TH FEB 2008




15,6  Parti: The Hills Are Alive with the Sound of Podcasting

\\3

Earl Newton is the creator and executive producer of the award-nominated
podcast, Stranger Things (http://strangerthings. tv), the world’s first
speculative fiction podcast offered to its viewers in high-definition video.
When you see what he produces, it’s obvious that Earl is truly a professional,
and he brings that skill and expertise to the enhanced feed of Podcasting

For Dummies: Season Two. If you're looking for additional tips, tricks, and
techniques in creating a top-notch video podcast, subscribe (for free) to the
Enhanced Podcast Feed on Podcasting For Dummies: The Companion Podcast,
available from iTunes and Dummies.com.

The Price of Pretty Pictures

You can create video podcasts with any video-editing application running on
either Mac or Windows. You can use Apple iMovie, Windows Movie Maker,
Apple Final Cut Pro, or Adobe Premiere Pro to create your episode. When it’s
time to export your movie out of your video-editing software, many of these
applications use a format optimized for podcasting. If you're using older
video editors, you can invest into QuickTime Pro (a $30 upgrade available
from www . quicktime.com), which can export a video file to a format spe-
cific for the iPod (which also includes iTunes).

Of course, you could do the compression by hand, but the question here is
“Why?” Take advantage of the shortcuts because in this section, we take a
closer look at other considerations concerning video podcasting.

Sorry, we don’t do window's
(Media Player)

So if video is so cool, so easy, and (while demanding) so powerful, why isn’t
everyone doing video podcasts? For one thing, the most common video
podcast format (.m4v) plays only on iTunes or QuickTime for the desktop
computer and in iPod portable players (iPod, iPod Touch, iPhone, and so
on). You could release your podcast in a variety of multiple formats such as
MPEG, MOV, and AVIL. MOV and AVl files, though, are huge in comparison

to the M4V counterpart. As far as MPEG compression, the format come in
various versions (MPEG1, MPEG2, and so on). You can export to multiple for-
mats, but now comes the added responsibility of managing numerous feeds,
tracking which feed people are subscribing to, and exporting for playback in
specific devices. M4V (which uses the H.264 codec in podcasting) performs
best in QuickTime and iTunes and is the simplest format to export in (as illus-
trated later in this chapter). M4V doesn’t perform at all in Windows Media
Player.
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That file is how big?!

Provided you follow our Cheat Sheet’s compression specs, the standard
audio podcast of roughly 80MB will cover anywhere from 90 minutes to two
hours — of audio. When compared with other podcasts that are far more eco-
nomical in their running times, 80MB is huge.

To video, this is chump change.

80MB might earn you 15 minutes of video time, and that depends on whether
you go with the M4V format or a flavor of MPEG. When video podcasting first
came to the hearts and minds of audio podcasters, it was a bit of a shock
when they tried to make their 20-t0-30 minute audio into a video equivalent.
“How do I get my file size smaller?” podcasters asked on various discussion
boards. Although the reply might have come across as snarky, it was the only
available answer: “Make a shorter podcast.” If you have a two-hour podcast
and are planning to compress your video down to the same size (or there-
abouts) as that 80MB MP3, well . . . that just won’t happen.

For standard 720 ¥ 480 digital-video resolution that you will probably import
into iMovie or Windows Movie Maker, the iPod compression setting takes one
minute of video and squeezes it down to 5MB. Take your epsiode’s running
time and multiply it by five to get an approximate size before compression.

Burn, bandwidth, burn!

Bandwidth is the factor most new podcasters tend to gloss over. That can
prove to be costly, especially if your podcast is 50MB or higher per down-
load. If you garner 1,000 listeners, for example, you've gone through 5GB
simply for that file transfer. If these 1,000 listeners are going through your
archives, your bandwidth needs to increase exponentially.

Now, suppose you decide to produce a video podcast with some length —
and even dare to explore the possibilities of high-definition video podcasting.
What happens? Your first episode is 100MB — a very hefty download.

It’s even heftier if your podcast is a runaway success. If you have 2,000 sub-
scribers in your first week, you have burned through 200GB of your monthly
bandwidth. What about the weeks — and the listeners — to come? What does
your webhost offer, and can it handle this kind of traffic for your podcast?
When you’re looking at video podcasting, consider the running time and file
size of your episodes, and then look at your Web host’s bandwidth.
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Lock and Load (Vour Camera): Planning
Vour Shooting Schedule

Nonlinear (that is, digital) video applications like iMovie and Movie Maker
have dramatically simplified the process of editing video. However, the com-
mercials aren’t quite accurate when describing the ability to make a movie
as quick and easy. It’s still far from a push-button technology. We've been
talking about the various demands for your video podcast, but perhaps the
greatest demand of them all is time.

Here’s how the process works:

1. Set up the camera, rehearse your podcast (if applicable), and then make
time to shoot from that angle.

2. Reset for the same shot but from a different angle. Shoot your footage
from the new angle.

3. Review your video footage and capture (get the video off the miniDV cas-
sette or your DVD and into the video editor) it onto your computer.

4. Edit your footage together, remove your mistakes, continuity errors, and
small trips and tumbles, and make the whole project appear seamless
and fluid.

5. After all the editing, post-production, and reviewing is done, you must
render the video, outputting this production in the desired format — be
it podcasting, full-screen video, or DVD.

Depending on the power of your computer’s processors, the length of your
video, and what format you’re outputting it to, this could take anywhere from
a few minutes to a few hours to a full eight-to-nine-hour work day.

The allure of video is intense — and don’t mistake us for a moment, we love
it! — but make sure you give yourself time: time to shoot, time to edit, time to
review, and time to render.
o Make that first episode and then give a second episode a shot. Go for three,
if you can. Once you have those episodes edited and ready to go, you can
decide on what kind of posting schedule you want your podcast to follow.

iTarantino: Creating with iMovie

If you've just purchased a new Macintosh computer or picked up the most
recent incarnation of iLife, you have iMovie (www.apple.com/ilife/
imovie) within reach. This unassuming application grants you the ability to
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edit video by dragging and dropping clips where you want them on your proj-
ect’s timeline.

Capturing video with iMovie

You need to get the video off the camera or media it is currently recorded
on (DVD, cassette, and so on) and into your computer. This process is called
capturing. The video is played back and then captured into the video-editing
application in a format that the program can understand.

We’re going to make the bold assumption that you have a miniDV camera or
some other DV playback device that has your video footage ready for captur-
ing. Here’s how you get your video off the camera and into your computer for
editing:

1. Launch iMovie.

2. From the intro window, select Create a New Project from the offered
menu options.

3. From the introduction window, change the default title to whatever
you want to name your project.

By default, your selected video format will be DV, which is a basic video
format common with many consumer miniDV cameras. Stick with the
default.

4. Connect your video camera to your computer and set it to playback
mode.

iMovie detects the camera automatically. If it doesn’t, you won’t have
any options available for capturing footage. If iMovie doesn’t detect your
camera, check your camera to make certain it’s in playback mode, has
power, and is plugged into your computer.

5. Click the Import button, and iMovie automatically captures what’s on
your miniDV tape or miniDV tape deck.

Your clip is imported into the Clips Pane, the area on the right in iMovie,
as shown in Figure 8-1.

If you have an older version of iMovie, your clips are imported by seg-
ments. If you have iMovie HD, choose iMovie HD=>Preferences and select
whether to import clips either by scene breaks (where the camera turns
on and off) or by segments with running time designated by you.

The version of iMovie Tee is using on his Mac is iMovie HD. There is a
more recent version available now — iMovie '08, part of iLife 08. Some
of the interface may have changed between versions, but the steps
should be easily applied to either version.
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6. After capturing the clips on your camera, in the Clips Pane, double-

click the name of the first clip labeled Clip 01.

The Clip Info dialog box opens, as shown in Figure 8-2.

. Name the clip something easier to identify it by.

For example, Wide Angle A or Close-Up: Guest Name.

Custom-naming clips allows you to organize your clips, which helps you
put your podcast together.
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8. Repeat Steps 6 and 7 for all the remaining clips in the iMovie Clips
Pane.

9. When your tape is concluded, move the switch currently on Edit
(Scissors) back to Capture (Camera) mode. Then repeat Steps 4 through
8 for any remaining miniDV tapes you need to capture.

If your video is on your computer as a data file (MOV, M4V, MPEG, and so on),
choose Filec>Import (or press Shift+8+I) to import your clips into the Clips
Pane.

A walk in the park on a clear Spring day, don’t you think? This process is
known as logging, where you go through your video (be it one cassette or
many) and organize your clips as needed.

Creating your episode with iMovie

When you have your video imported and organized in iMovie, you're ready to
edit it into a video podcast. Follow these steps:

1. Switch iMovie from Capture to Edit mode by moving the switch to the
right (to the scissors icon).

Or simply select a clip in the Clips Pane. iMovie automatically switches
from Camera to Edit mode.

2. Click and drag your opening clip from the Clips Pane into the
Timeline along the bottom of the iMovie interface.

The Timeline in your iMovie interface is where you assemble and edit
your clips. Simply drag and drop clips in the order you want them to
appear. By default, you're viewing video in the Timeline as clips (View
Clip mode).

3. Repeat Step 2 for the remaining clips in your Clips Pane until you
have your clips in the order you want. See Figure 8-3.

What you have now is commonly referred to as a rough cut. This is your
video podcast without transitions, set volume level, or any detailed edit-
ing. It gives you an idea of what the video will look like when it’s done.

The amount of editing your video podcast needs depends on the amount of
footage you shoot and how detailed you want your production to be. When
you have a rough cut, here are some editing tricks to try:

v View your video by running time. Click the icon of the clock in the
iMovie interface. This switches your Timeline mode from viewing video
as individual clips to viewing video by running time. When you edit
video in this mode (View Duration mode), you can adjust the timing and
duration of individual clips accordingly.
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1 Navigate throughout your video. A scroll bar across the bottom of the
Timeline will allow you to move from the beginning to the end of clips,
going back and forth as needed.

v Zoom in and out. Underneath the scroll bar is a Zoom slider that allows
you to view the project from beginning to end, or zoom in on specific
edit points.

v Scrub through video. With your playhead, you can scrub through the
video. Scrubbing is the process of viewing audio at a user-designated
speed. You scan through segments, find what you're looking for, and
make edits. With the left and right arrows, you can also advance through
a clip frame by frame.

v Make a cut. Move your playhead in the Timeline to where you want to
make an edit. Choose Edit>Split Video Clip at Playhead (or press 3+T).

1 Delete a segment. Click the segment you want to remove and press
Delete to remove the unwanted video.

v Create a cutaway. Sometimes, you want video that breaks the monotony
of a single shot, more commonly known as a cutaway.

1~ Assemble you episode. Using either View Clip or View Duration mode,
assemble your episode.

v+~ Drop in a transition. Click the Editing tab and then the Transitions tab.
A transition is a cool way to get from one clip to the next (a crossfade,
wipe, or some interesting bridge), unlike a cutaway or jump cut where
one video source switches to another. Click and drag the desired transi-
tion between two clips to apply it.

To see a preview of a transition, simply click it.
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v Place a title at the beginning of your podcast. Click the opening clip,
click the Editing tab, and then click the Titles tab in the iMovie interface.
With the iMovie Title Interface, design your opening title and then click
the Add button (see Figure 8-4). The Titles Pane is the feature of iMovie
where you can place animated or static text at the beginning, middle, or

W end of your movie, giving your podcast a polished Hollywood touch.
Click an offered title template, and iMovie renders a preview of that title.
You can either have the title appear over one of your video clips or over
black video by selecting or deselecting the Over Black feature.
iMovie renders the title and then incorporates it into the project. If your
title needs to change, return to the clip marked with the Title icon (a
small T icon next to its duration), edit the title, and click the Update
button.
My Great Video Podcast (DV-NTSC)
|
Figure 8-4:
With the
iMovie
Titles Pane,
you can
come up
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When you have your video how you want it, follow these steps to finish your
podcast:

1. Choose Filer>Save Project or press 88+S to save your video.
2. To export your video, choose Share~iPod.

A dialog box opens, giving you the codec settings (the particular video
compression format you've selected) that your movie will be saved as.
The dialog box also lets you know what you can do with the video and
what device(s) it can be best played back on. You select iPod as it is
using the codec optimized for podcasting purposes.
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3. After reviewing the dialog box, click the Share button.

Your video opens in iTunes.

4. Select your video and then choose File~>Get Info or press 88+I. Click
the Info tab to add in your ID3 Tags (see Figure 8-5). When your tags

are completed, click OK.

For more on ID3 Tags and why these are important to your podcast, take

a look at Chapter 9.
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Congratulations, you have just edited and output your first video podcast.

It’s just that easy! With upgrades to Leopard and various incarnations of
iMovie, your interface and your results may vary. You may also find iMovie
has a lot of features we haven’t even touched. That’s because we're keeping
it quick and easy, fast and furious, and above all, to the basics. If you want to
find out more about editing with iMovie, there are many books on the market
that will take you deeper into the power of this application. You may also
pick up a few cool tips from Videoblogging For Dummies, Digital Video For
Dummies, 4th Edition, or Ear]l Newton’s video episodes on the Podcasting For

Dummies: Season Two enhanced feed.
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DU on the PC: Podcasting with
Windows Movie Maker

Attempting to keep up with iMovie is its Microsoft equivalent, Windows
Movie Maker (www.microsoft.com/windowsxp/using/moviemaker).
This application comes with your Windows OS and offers nonlinear editing
goodness similar to what iMovie offers its Mac users.

Capturing video with Movie Maker

Getting your footage from your camera or hard drive to Windows Movie
Maker differs slightly from what you have to do with iMovie. You need to go
through a setup process so Movie Maker knows what kind of video you want
to make:

1.

Make sure your video camera or DV playback device is connected to
your PC. Then launch Windows Movie Maker.

. Under the Movie Task window on the left side, click the Capture from

Video Device option.

. Give a name for your Collection — your video — and a destination

folder for your captured footage. Then click the Next button.

The Video Settings page of the wizard appears.

. Select one of the three offered codecs from Windows Movie Maker, as

shown in Figure 8-6.

Windows Movie Maker gives you an approximation of how much data is
needed to capture and save your video in the desired format.

. Click the Next button.

Under Other Settings, a variety of optional formats are offered. We rec-
ommend sticking with one of the first two offered:

¢ Best Quality for Playback on My Computer: Your video is captured at
320 x 240 pixels, which is less than half of full-screen video (720 x
480). This will limit the output options for your project.

e DV-AVI for Full Screen: Choose this option if you want to be able
to output to DVD or show off your video podcasts to people who
aren’t quite up to speed with podcasting.
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Because you’re video podcasting, it would seem common sense to select
the recommended Best Quality for Playback on My Computer option,
but before jumping to that option, consider the DV-AVI option.

. Decide on how you want to capture your clips and make sure you

have the Preview Clips while Capturing option selected.

. In the final window for capturing video, click the Play button under-

neath the Preview window to play the video in your camera or DV
device.

. Use the Fast Forward and Rewind buttons to visually search (also

called jog) through the footage to find what you want. Click Start
Capture to begin capturing a clip. (See Figure 8-7.)

. Click Stop Capture when the clip is captured.
10.

Repeat Steps 7 through 9 for all clips on this DV cassette (also referred
to as a reel) and then eject the reel. Insert any additional reels and
capture your footage.

This is known as logging in the video-editing industry. You go through
your footage (be it one reel or numerous ones) and capture what is
needed for your podcast.

When your footage is logged and captured, click the Finish button.

Go through your clips and custom name them something easier to
identify (such as Wide Angle A or Close-Up: Guest Name) by double-
clicking the clip’s default names.

Custom-naming makes it easier to organize your clips when you’re ready
to edit your podcast together.
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Windows Movie Maker stores your video in Collections and when you repeat
Steps 2 through 10, you create a new collection that can be accessed for a
single project. The actual editing process in Windows Movie Maker is similar
to iMovie, and if you want to find out more about how this PC option works
(and maybe solve a few odd obstacles it might throw your way), refer to the
Windows Movie Maker Web site on Microsoft.com or pick up a copy of Digital
Video For Dummies, 4th Edition.

Creating a video podcast with Movie
Maker and QuickTime Pro

When you work your way through the Windows Movie Maker video-editing
process, you have an AVI or MPEG file ready to go for playback on your
computer. Not for podcasting. Although Microsoft is doing its best to keep
up with the medium, it still has yet to include a one-click option in Windows
Movie Maker for podcasting.

Fortunately, Apple has an option that plays on Windows, and it costs approx-
imately $30. It’s QuickTime Pro (www.quicktime.com), and unlike the free
player you can download, QuickTime Pro comes with a handy Export feature
that makes the final steps for your video podcast on a PC a piece of cake.

1. After reviewing your movie in Movie Maker, go under the Movie Task
window on the left side and click the Save to My Computer option
under Finish Movie.
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Make sure you know where on your computer Windows Movie Maker is
saving the final file.

2. In the offered pane, select from the list of formats DV-AVI and then click
the Next button. Then in the final window, click the Finish button.

Exporting your movie may take some time, so walk away from the com-
puter and give yourself a well-earned break.

3. Close Windows Movie Maker and then launch QuickTime Pro.

4. Choose Filez>Open File or Ctrl+O to open your newly produced
AVI file.

5. Choose Filec>Export or Ctrl+E and from the Export drop-down menu,
select the Movie to iPod option.

Although you may think the Export for Web would be the option to
choose, Export provides you everything you need for podcasting. By
selecting Movie to iPod, everything (the codec, screen resolution, audio
compression) is set.

6. Click Save.

Again, this may take a few minutes as you're processing the video a
second time. When the processing is done, you have a M4V file, ready
for ID3 tagging.

7. Open your video in iTunes. Choose File=>Get Info or Ctrl+I.

8. Click the Info tab to add in your ID3 Tags (refer to Figure 8-5). When
your tags are completed, click OK.

This method takes a few more steps than iMovie, but it’s still very easy, pro-
vided you're willing to make the investment for QuickTime Pro. When you
consider the mistakes, the hassles, and the time in reprocessing a file if the
codecs aren’t exactly right, the simplicity and ability to select a format opti-
mized for iPod makes video podcasting stress-free.

Although programs like iMovie and Movie Maker have simplified video editing
dramatically, as mentioned before, this isn’t a quick-and-easy process. When
the video is done, it must be processed, and that can take anywhere from a
few minutes to a few hours. You want to give yourself that time to edit and
time to process the video you're creating. Before announcing your video pod-
cast, try to find out how those first few episodes will progress in production
and finally what the processing time will be for a single episode. You may find
that a missed mistake can cost you hours. Always preview and then preview
again before processing.
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Screencasting: What's on your desktop?

Taking both enhanced and video podcasting to
new applications, screencastingis emerging as
a new delivery method of an established teach-
ing tool: recording actions of your desktop.

In a screencast, a podcaster is usually show-
ing off features of a computer application (like
InDesign, Final Cut Pro, Word, and so on); but
instead of using screen captures that show
drop-down menus already deployed or attempt-
ing to film your monitor and sacrificing clarity of
image, a third-party application like Ambrosia
Software’s SnapzProX (www . ambrosiasw.
com/utilities/snapzprox)captures all
actions taken on your desktop in a live record-
ing and then saves them as video footage. Now,
you can edit your various desktop actions in
your video editor of choice. Subscribers can

follow along with the video, cursor, menus, and
actions all happening clearly and vividly on your
media player.

The Digital Media Dude podcast (www . pixel
headsnetwork . com) takes full advantage
of programs like SnapzProX and Final Cut Pro
and produces Digital Media Quick Tips, an
impressive, user-friendly, and downright slick
screencastthat can easily teach you something
new in your favorite application, be it Mac or
Windows software. So, if you're learning an
application for the first time, are interested in
learning a new trick on an old favorite, or if
you have a question about software, check out
Digital Media Quick Tips and see just what you
can do with screencasting.
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In this part . . .

For every would-be podcaster who salivates at the
thought of creating a recording, ten more faint at the
thought of the technical hurdles involved in getting their
work online. This part shows you how easy the technol-
ogy really is and how to make it work for you, and it
guides you through the (elementary) process of launching
your show into the podosphere.




Chapter 9

Shrink That Puppy and
Slap a Label on It

In This Chapter

Downsizing audio files with MP3 compression
Understanding bitrates and sample rates
Dissecting ID3 tags: They're not just for music anymore

ou've finished your final edit (and if you think we’re skirting blasphemy

whenever we use the E word, trust us — creativity sometimes demands
a sacrifice). At last you're ready to compress your mondo-super-sized AIFF or
WAV file down to the format that inspires terror and indigestion in RIAA rep-
resentatives everywhere: MP3.

The MP3 format was designed to reduce the amount of data (via compres-
sion) required for digitized audio while still retaining the quality of the origi-
nal recording. MP3 files are the best way to keep the audio small enough in
size to make it a quick-and-easy download, and it’s this format that podcast-
ing uses to get content efficiently from podcaster to podcatching client.
Although creating MP3s is a simple enough process, you do need to make
some tradeoffs between quality and compression.

A Kilobit of Me, and a Whole Lot
of You: Understanding Kbps

The compression process begins with proper bitrate settings, measured in
Kbps (kilobits per second). Bitrate is a method of measuring data transmis-
sion from one point to the next. The higher the Kbps value, the more data
being transferred between two points. The more data being transferred per
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second, the better the quality of information. With each rate of data transfer
offered by recording applications, you can digitally reproduce the various
qualities of audio:

+* 8 Kbps, matching the vocal quality of a telephone conversation
v 32 Kbps, yielding audio quality similar to AM radio
1 96 Kbps, yielding audio quality similar to FM radio

v 128 Kbps, matching audio CD quality, and the most common Kbps used
for MP3 compression of music

v 192 Kbps, a “Higher Quality” setting Kbps used for MP3 compression of
music; better audio sound, but higher data files

You aren’t married to this listing of Kbps by any stretch of imagination.
Figure 9-1 shows that Audacity offers in its Preferences plenty of variations
from the five common settings. Tweak till you find the Kbps best suited for
your podcast.

8 kbps

16 kbps
24 kbps
32 kbps
40 kbps
48 kbps
=~~~ | 56kbps T
67 64 kbps —
MP3 Export Setup | 80 khpS

L i 96 kbps
Bit Rate Mode 112 kbps

[sJER v 128 kbps 3

144 kbps E
160 kbps |
Channel Mode: 192 kbps
224 kbps
256 kbps
320 kbps

Variable Speed:

It’s a tradeoff: The higher the bitrate, the larger your file size is — but the
smaller your bitrate, the lower your audio quality is. A good idea is to experi-
ment: Compress your podcast using one bitrate, save it that way, and then
change your bitrate to something higher (or lower), save it, and play back
each clip to compare how they load and how they sound. Note any changes

in sound quality and file size. When you find that happy medium between
quality and compression, stick with that number for your current and future
podcasts. If you want to skip experimentation, refer to the suggested compres-
sion settings we have outlined on the included Cheat Sheet at the front of this
book.
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In the following sections, you find out how to change bitrates using Audacity
and iTunes. If you're using applications like Audition or Soundtrack, you

can find out more about what they offer in Expert Podcasting Practices For
Dummies.

Setting bitrates in Audacity

Changing bitrates in Audacity (version 1.3.3 featured here) is a multistep pro-
cess. The first step is to get your editor all set for creating MP3 files:

1. Choose Audacity=>Preferences (Mac OS X) or choose Edit~>Preferences
(Windows).
The Preferences window opens.

2. Choose the File Formats option in the left column (see Figure 9-2).

3. Click the Download Free Copy of LAME button in the MP3 Export
Setup section or point your browser directly to http://audacity.
sourceforge.net/download/lame.

Audacity Preferences
Audio 1/0 When importing uncompressed audio files into Audacity

Quality
File Formats
Spectrograms

() Make a copy of the file before editing (safer)
® Read directly from the original file (faster)

Directories When saving a project that depends on other audio files
Interface

Theme @ Ask user
Batch O Always copy all audio (safest)
Keyboard ) Never copy any audio

Mouse
When exparting tracks

® Always mix all tracks down to Sterea or Mono channel(s).
) Use Advanced Mixing Options

MP3 Export Setup

MP3 Library Version: MP3 exporting plugin not found (_Find Library ) (Download free copy of LAME )

(Cancel ) EEOKED

4. Follow the steps for your OS as outlined on the Web page to download
the proper files.

5. Open the archive file (no need to worry — it’s a safe download) and
drop it into your Audacity folder.
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6. Return to Audacity and click the Find Library button.

7. Choose Applications=>Audacity (Mac) or My Computer—>(Main
Drive)=>Program Files=>Audacity (Windows) to navigate to the libm-
p3lame file.

8. Select the libmp3lame file and click Open.

This step in setting up the LAME Library is a one-time thing. You won’t have
to repeat this process again unless you move the library to another location.

Now you’ve come to the point where you set the bitrate. When you have a
file, follow these steps to export it as an MP3 file:

1. Choose File=>Export.
2. From the Format menu, select MP3 Files.
3. Next to the Format: MP3 Files menu, click Options.
The Specify MP3 Options dialog box opens, as shown in Figure 9-3.

|
Figure 9-3:
Under e ' " Specify MP3 Options
the M P3 MP3 Export Setup
options, Bit Rate Mode: () Praset () Variable () Average (@ Constant
y(-)U can Quality 128khos _:]
set bitrates
and other
variables
foryour Ij: Cancel ) ¢ ok )
compressed S—
audio.
|

Variable Speed:

Channel Mode: () Joint Stereo (@) Stereo

4. Choose your desired bitrate from the Quality drop-down menu.

If you're following our recommendation from the Cheat Sheet at the
front of this book, you would set the bitrate to 128.

You can also set up your Bit Rate Mode (Constant) and your Channel
Mode (Joint Stereo). Constant bitrate ensures the bits are output at a
steady (constant) rate despite the audio that is being used (including
silence). Variable bitrate attempts to do a bit of compression — for
example, the bitrate of a complex music sample would take more space
than that of the same length of time in a spoken piece with several
pauses. Although variable length audio sounds good on the surface, it
can present problems to the listener — actual playback times may not
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be correct, causing problems when people pause a long podcast. Joint
Stereo refers to a technique that saves some space when your record-

ing includes mono channels or tracks. Rather than using the space of a
stereo track (left and right) to save that information, joint stereo tech-

niques recognize it and save space by only using half the space.

5. Click OK to return to the Export window.
6. Name your file and then click OK.
After you set the bitrate for this one file, your settings are automatically

applied to other MP3 files created from this point. Only when you go into the
Options for MP3 files will you change bitrates.

Changing bitrates in iTunes

It doesn’t matter how your audio files get in to iTunes, be it from Audacity,
GarageBand, or anywhere else. When you get the files in to iTunes, you can
easily convert them to a different bitrate, change the file format, or make any
number of other changes to the file.

You can’t get better quality out of a file by changing it from a lower bitrate to a
higher bitrate. For example, once a file has been saved at 32 Kbps, converting
it to 128 Kbps won’t make it sound any better.

To set the bitrate in iTunes, follow these steps:
1. Choose iTunes~>Preferences (Mac OS) or choose Edit~>Preferences
(Windows).
The Preferences window opens.
2. In the Preferences window, choose Advanced=’Importing.
3. Choose Custom from the Setting drop-down menu.
The MP3 Encoder dialog box opens.

4. Select your desired bitrate from the Stereo Bit Rate drop-down menu
(shown in Figure 9-4).

You can also choose to make your channels mono, stereo, or Joint
Stereo and what your sampling rate is. (See the following section for
more about sampling rates.)

5. Click OK.

You return to the Importing tab. The default settings for your MP3 com-
pressions are now in the Details area.
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When you have a grasp of bitrates, you're ready to move on to sample rates.
This may strike you as a tad redundant, particularly when you see the list of
common audio-sample rates. A strange déja vu makes you wonder whether
you're in the real world or exist merely as part of The Matrix. No biggie —
sometimes technology is redundant.

As we discuss in the previous section, bitrate is a measurement of how much
audio data is transferred between two points, such as the computer and your
headset. The sampling rate is a measurement of audio samples taken from

a continuous signal (a signal of a varying quantity, defined over a period of
time) in order to create a discrete signal (a signal made up of samples from a
continuous signal).

Very simply, the sample rate determines the maximum sound frequency
that can be reproduced — the value you set is twice the frequency value.
For example, a 44.1 kHz sample rate can reproduce sounds up to 22.05 kHz,
which is slightly above the range of human hearing.

The most common audio sampling rates found in MP3 encoders are

v 8,000 Hz / 8 kHz, telephone-quality recording or lo-fi
v 22,050 Hz / 22 kHz, equal to AM radio transmission
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v 32,000 Hz / 32 kHz, equal to FM radio transmission, minimum sound
quality on miniDV digital video camcorder

v 44,100 Hz / 44 kHz, audio-CD quality

v 48,000 Hz / 48 kHz, digital TV, DVD, films, maximum sound quality on
miniDV digital video camcorder, and professional-grade audio recording

As with your audio-recording applications, you have a range of bitrates
available — and you can type in your own custom sampling rates.

Using different sample rates in compressed audio files does not affect the file
size — only the bitrate and duration affect file size. A high sample rate at a low
bitrate can result in poor signal representation and thus poor quality, but if
you’re using at least 64 Kbps (bitrate), there’s no good reason to ever use any-
thing except 44.1 kHz as the sample rate.

WMBER
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Setting the standard for a new kind of book,
a new kind of podcast

When Evo Terra, Chris Miller, and Tee Morris
launched Podiobooks.com in October 2005,
they knew setting an audio standard for cur-
rent and future podcasters would be important.
The challenge was in establishing standards
that podcasters could easily follow, but that
listeners would find comfortable. In the end,
they looked to The Dragon Page (now known
as Cover-to-Cover) and its podcast (that, at the
time, was syndicated on XM Satellite Radio
and AM/FM radio stations) as a benchmark.
Now, Podiobooks.com asks for the following
parameters:

v~ 64 (voice only), 96 (voice with intro/outro
music), or 128 (voice, music, SFX) Kbps

v 44.100 kHz / 44,100 Hz
v Joint Stereo

We haven't discussed the difference between
stereo and joint stereo output in this chapter,
for one reason: It all depends on the method
you use for recording — and on how you're
listening:

v~ Stereo: By default, many applications that
exportto MP3 also export as Stereo. Stereo
encoding takes the left and right audio
separately and divides the selected bitrate
for each. The drawback to (plain) stereo is
that the channels are equal width, so a 128
Kbps encoding of a mono signal is really
two identical 64 Kbps channels, resulting in
a 50 percent inefficiency.

v Joint Stereo: With this option, one channel
carries sound that is identical in both the
left and right stereo tracks, and the other
channel carries the difference. Both chan-
nels are only as big as they need to be, so
if your podcast is mostly mono — with just
one microphone — you’ll get more out of
your bitrate than you would with a plain
stereo file, but without the reliability issues
of a mono file.

With these parameters in place, Podiobooks.
com ensures consistency between the numer-
ous titles featured. Something to consider
when setting standards for yourself and your
podcasts.

169
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Be careful when using a sample rate other than a multiple of 11. Many Web
sites use Flash players that don’t work well with other sample rates. Choosing
a sample rate other than 11.025 kHz, 22.5 kHz, or 44.1 kHz can produce an
effect similar to the voices of Alvin and the Chipmunks. It might be funny at
first, but most listeners won'’t stick around to hear your entire message.

Changing sample rates in Audacity

Sample rates are located in the Preferences window and extremely simple to
either change or customize to your podcast’s personal needs. Follow these
steps to customize sample rates in Audacity:

1. Choose Audacity~>Preferences (Mac OS) or File~>Preferences
(Windows).
The Preferences window appears.

2. Click the Quality option in the left column.

3. Select your desired bitrate from the Default Sample Rate drop-down
menu (as shown in Figure 9-5), or enter your own custom sampling
rate by selecting the Other option and entering a number.

If you're entering a custom sampling rate, make sure you enter the rate
in hertz (Hz) and not kilohertz (kHz). For example, if you decide your
sampling rate is 44.1 kHz, you have to enter 44100, not 44.

4. Click OK.

. 8000 Hz B
16000 Hz
Audio /0 Sampling 1 L
— / 22050 Hz
e Y . Default Sample Rate: [FARRBUIIEE 5 44100
ile Formats
48000 Hz = =
Spectrograms Default Sample Format: 96000 Hz s
Directories Eorveiimn Other...
Interface 3
Theme Sample Rate Converter Dither
Batch Real-time: | Fast Sinc Interpolation |3 | None 4]
Keyboard High-quality: | High-quality Sinc In ﬂ Shaped ﬂ

Mouse

A
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Changing sample rates in iTunes

iTunes makes the process of changing the sample rate easy — what else
would you expect from Apple?

To get an idea of what a good sampling rate is, take a look at the podcasts
your aggregator is pulling down and check the settings. Press 8+I (Mac) or
Ctrl+I (Windows) to see the MP3 Summaries. Settings may vary from file to file.
As you work out the final technical details of your podcast, make sure that one
of them is the setting that best suits your needs and (of course) your ear.

Follow these steps to change the sample rate in iTunes:

1. Choose iTunes=>Preferences (Mac OS X) or Edit~>Preferences
(Windows).
The Preferences window appears.

2. Choose Advanced=Importing.

3. Select the Custom option from the Settings drop-down menu.
The iTunes MP3 Encoder dialog box opens.

4. Select your desired sampling rate from the Sample Rate menu.

Apple loves to make things easy for its users, and we love that. However,
Apple sometimes takes out the “I did it MY WAY!” alternative and does
not allow for custom settings. Here, iTunes keeps this sampling to the
common settings, so you're given no leeway.

Note that iTunes offers your sampling rates at kilohertz (kHz), a more
common, recognizable presentation of a sampling rate. Again, this is
Apple looking out for you, keeping it to the basics.

5. Click OK.

You return to the Importing tab. The default settings for your MP3 com-
pressions are now visible in the Details area.

ID3 Tags: They're Not Just
for Music Anymore

Is it soup yet? Not quite yet. Adding ID3 tags is the final step before you can
upload the podcast to your Web site. This is the final detail (okay, batch of
details) that not only tells other podcasters who you are, but also tells listen-
ers what your podcast is all about, and which episode they’re listening to.

171
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Because this is a final detail, we find that some podcasters either skip it or
just don’t care how they tag their podcasts. And there goes any hope for
their listeners to effectively organize podcasts in a computer’s MP3 player.
Maybe some podcasters are unaware of where or how to identify their
podcasts — or want to get their content out to the fans ASAP without taking
the time to implement these tags.

Whatever the case, we entreat you: Stop the madness, stop the insanity,
and stop the monkeys. Proclaim your true self for the sake of MP3 players
everywhere — implement your ID3 tags!

Tell me about yourself: All about ID3 tags

First created in 1996, ID3 tags were designed to be added to audio files in
order to have the artist, album, and track title displayed in a computer’s MP3
player when the file is played back. The current ID3 tags now include com-
poser, bitrate, and even genre.

Of course, another question that comes to mind is why would a podcaster
want to even bother with ID3 tags?

Take a look at a podcast you're listening to, regardless of whether it’s on
your portable MP3 player or the player on your desktop. Your podcatch-

ing client probably organizes your various feeds by the date downloaded,
either with the most recent show at the bottom or at the top of your playlist,
depending on the player’s preferences. Each individual podcast has an epi-
sode title, an artist, and a podcast title. If your MP3 player and the podcaster
working with the ID3 tags are particularly savvy, artwork associated with
your show is also displayed.

Now hop from podcast to podcast in your MP3 player, and you can tell which
people care — or don’t — about identifying their shows. Some podcasts
simply use obscure numbers that could be a date, but when you hear two
episodes of the podcast back to back, you find out the number and the date
read at the intro of the show (provided there is one) don’t match up (confus-
ing). With ID3 tags in place, you can now look at your portable MP3 player or
your desktop player to get an idea of what you're listening to.

When you add ID3 tags to your podcast, you set apart individual podcasts
from one another, making each one unique but keeping it grouped with your
podcast show.
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IDentity crisis: Making ID3
tags work for podcasting

Some ID3 tags really don’t work for podcasting. Album? Track number?
Composer? You're podcasting, not producing music. Your responsibility (as
a podcaster) is to redefine the following tags we have found useful for the
podcasting medium:

1+ Name: This should be the name or number of your podcasting episode.
Examples are Show #19, Episode 3: One of Those Faces,
BOOK THREE: Chapters 39 & 40.

v~ Artist: This one is pretty self-explanatory. You're the artist behind this
podcast, so let people know who you and your group are. Put in your
name (or at least the pseudonym you’re using as a podcaster) or the
name of your podcasting team. For example, Philippa Ballantine,
Earl Newton,and J.C. Hutchins.

v Album Artist: Many times left blank, this tag can be a bit tricky for users.
The Album Artist usually refers to the Artist, but you can also use it to
refer to the artwork artist, the production studio, or the creator of the
podcast. Examples are Philippa Ballantine, Stranger RSS LLC,
and Carrie Seidman (artist for Tee's MOREVI: Remastered
artwork, used for the podcast).

v Album: In most instances it is the name of your show or your show’s
Web site. Good examples are Whispers at the Edge, Stranger
Things - iPod (640 x 480),and 7th Son Podcast Novel
Trilogy.

v Track Number: Purely optional, this ID3 tag allows you to make sure

your podcasts remain in some kind of sequential order. For podcast nov-

elists, the track numbers coincide with the chapter numbers. If podcasts
follow a season of multiple episodes, the Track Number coincides with
the episode in that season.

v Year: The year this podcast episode was produced.

v BPM: If you are into staying fit and are listening to or producing a
workout podcast, you want to fill in this ID3 tag as BPM is for Beats Per
Minute. BPM is also good if your podcast is a house music-dance mix
podcast. A good example of a podcast showing off BPM is any one mixed
by D.J. Steveboy (Podrunner).

v Grouping: This tag may remain blank until you're affiliated with
a network or distribution hub of some kind. Good examples are
Podiobooks.comand Farpoint Media.
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v Composer: If Album Artist already sports the name of your cover artist,
this tag can be used to host the name of your producer. You can enter
your engineer’s name, or the studio where the show is produced. For
example, MOREVI’s artist is listed as Tee Morris but the composers
are Tee Morris & Lisa Lee as the original work was co-written.

v Genre: The genre “Podcast” wasn’t offered in drop-down menus of MP3
creators, but with the growing popularity of the medium, it’s becoming
more and more common.

If you're using iTunes and don’t see the Podcast genre, you can manually
type Podcast into the field.

1+ Comments: Similar to comments you leave in XML, you can give a quick
two or three lines of show notes for your podcasts. It’s also a great place
to put in any Creative Commons notices, Web sites for more information
of the show and its hosts, and special dedications.

v Album art: Don’t forget, a big piece of successful podcasting is
marketing — and a big part of marketing is branding. Your podcast
logo (or album art) is very important to help set you apart. Although
not all MP3 players have this feature, don’t discount its importance.
A large percentage of podcast listeners use iTunes and listen at their
computers — where the album art may be prominently displayed.

Reminiscent of John Cleese’s aside in a Monty Python robbery sketch (“Adapt,
and improve. That’s the motto of the Round Table”), we podcasters must
adapt these ID3 tags to our podcasts to improve how they appear in our play-
ers. On playback, the ID3 tags appear on the listeners’ interfaces, offering a
quick glance at the content of the podcast (as shown in Figure 9-6).

If you're using iTunes as your podcatching software, be aware that it doesn’t
use most of the information supplied in ID3 tags. iTunes picks up much of
the information from the RSS feed and retags your files. We cover more RSS
details in Chapter 12.

A peril in working with ID3 Tags is spelling errors. There is no spell check in
Audacity, iTunes, or any other tag editor. Because many directories, search
engines, and players rely on the ID3 tags to organize and properly display
your show, make sure to double-check the spelling of your show title, names
of people involved, and any other text you're putting in place. Also, some edi-
tors like iTunes create “quick fill” databases that help you fill in your File Info
quickly. This database also includes the misspellings. So when filling in your
ID3 tags, take your time and check your spelling.
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Creating and editing 1D3 tags in Audacity

Unlike iTunes where you tag individual files after they are created, Audacity
lets you set up a template for the ID3 tags that gets applied when MP3 files
are created. To create this template, open Audacity and follow these steps:

1. Choose File=>Open Metadata Editor.

The Edit ID3 Tags (for MP3 Exporting) window opens (shown in Figure
9-7). The ID3v2 option is already selected by default.

2. Fill in these fields:

e Title: The episode name or number

e Artist: The podcaster or name of the podcasting crew

e Album: The show’s name or Web site

e Track Number: The field is optional, unless numerical order is a pri-

ority in your podcast

e Year: The podcast publication’s year

3. From the Genres drop-down menu, select the option best suited to

your podcast.

Audacity on version 1.3.3 doesn’t offer “Podcast” as an option. You can
3 always select Speech to indicate this is a non-musical podcast.

Click the More button to add a customized tag (refer to Figure 9-7). You
can also add additional ID3 tags and save your tags as a template.
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4. Give a brief description of your podcast in the Comments field.
Don’t make your comments a long, detailed description of your pod-
cast’s content. Keep it simple and brief. For example, if the creators of
The Dragon Page: Cover-to-Cover were to write comments for Show #174,
it wouldn’t say “On this show we interview Brandon Sanderson about his
debut novel Elantris and then turn our attention to Steve Alten’s latest
novel, The Loch.” Instead, the creators would boil down this description
to “Show 174 — Interviews with Brandon Sanderson and Steve Alten.”
5. Click Done.
And that’s it! When Audacity generates your MP3, your show is tagged and
ready for uploading.
WNG/ Audacity’s ID3 tagger does have its limitations. It cannot, in the version

covered in this edition, embed artwork into your audio metadata. For that
extra touch, use an ID3 Tag editor such as ID3X (www . three-2-one.
com/32lapps/main/global/indexl.htm) or iTunes.

Creating and editing I1D3 tags in iTunes

Using iTunes to tag your files offers more flexibility in customizing genres
and even incorporating artwork than Audacity does. Apple’s MP3 player,
encoder, and podcatcher also make adding and editing ID3 tags extremely
easy. Follow these steps:
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1. Single click your newly created MP3 in iTunes. Choose File=>Get Info
or press 3+I (Mac) or Ctrl+I (Windows).

The Info window appears, which gives you a summary of your MP3 file.
2. Fill in the following fields:
e Title: The episode name or number.
e Artist: The name of the podcaster or podcasting crew.

e Album Artist: This would be a good spot to give credit to the art-
work artist or show producer.

e Album: The show’s name or Web site.

e Track Number: This is optional, unless numerical order is a priority
in your podcast.

e Year: The podcast publication’s year.

* BPM: If you'’re doing an exercise show or a music podcast featuring
original house mixes, give your Beats Per Minute here. Listeners
will dig that.

¢ Grouping: If you're part of a group or network like Farpoint Media,
or FriendsInTech, give credit here.

e Composer: Fill in this field if you have a separate sound engineer, a
tech guru handling the editing, or if you’re doing the work yourself.

¢ Genre: Select one of the offered genres from the drop-down menu,
or you can select the genre in the field and type Podcast (or what-
ever genre you want to use to classify your work).

One of the cool bonuses of iTunes is how you can create custom
genres. Choose Filer>Get Infor>Info and enter your own genre here.
Or go to the song in your iTunes Library and click in the Genre
column and edit the genre name. When you return to the Info
window later, you can see your custom genre offered as an option
on the Genre drop-down menu.

e Comments: A brief version of show notes.

3. Take a last look at your ID3 tags to make sure everything is spelled
properly and listed the way you want it, and then click the Artwork tab.

4. Drag and drop a desired piece of artwork into the Artwork field or
click the Add button and, using the window that appears, navigate to
the artwork you want to have associated with your podcast.

If your logo is in a format that iTunes recognizes, it appears in the
Artwork field, as shown in Figure 9-8. See the sidebar “Art for art’s sake”
to make sure your logo has the appropriate format.

5. Click OK.
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Artwork by Carrie Seidman

Album artwork, commonly seen in many desk-
top MP3 players and now in iPods that display
photos, is a nice option for podcasters who want
to brand a podcast with a logo. Mur Lafferty’s
Parsec-winning / Should Be Writing logo is a
classic broadcast microphone with a sticky
note slapped on it and a pencil, sharpened and
ready for use. Then you have The Onion Radio
News's trademark onion with a globe ghosted
behind it, the stamp of quality journalism at its
funniest. These are icons associated with their
shows, and this kind of branding is becoming
more and more common in podcasting, espe-
cially with the iTunes Store becoming podcast
friendly.

But what is the best way to make sure iTunes
(and for that matter, the iTunes Store’s Podcast

Art for art’s sake

Catalog) recognizes your artwork? Just make
sure that your logo fits the following param-
eters:

v 300 x 300 pixels, both in width and height,
or 600 x 600 if you anticipate listeners/view-
ers on Apple TV. This isn’t required, just an
Apple recommendation that has become a
de facto standard.

v JPEG (. jpg) format

Keep in mind that when you compress your art-
work, overcompression can distort and dete-
riorate its visual quality. Some JPEG settings
work in numbers 1-10 or 0-100. As a rule, if you
compress your logos no more than “50”, your
artwork should retain visual quality.




Chapter 10

Move It on Up (To Your
Web Server)

In This Chapter

Moving podcast media files to your Web server
Naming your files appropriately
Keeping your FTP space neat and tidy

ou've managed to figure out what it is you want to say (or show), you've

gone through the trials and tribulations of the editing process (or not),
and you’ve faithfully employed correct ID3 tagging (nonnegotiable). That’s
great, but no one is going to hear your contribution to the podcasting world
until you put your files up on the World Wide Web.

In Chapter 1, we cover the hosting provider selection process. In this
chapter, we take an extensive look at the mechanics of the process, including
how to appropriately name and organize your files.

Podcasters have a variety of options when it comes to moving files. Many
people employ specialized software, and some podcast-specific hosting
companies make moving your files to the Web as simple as point and click.
And for the “old school” folks, text-based applications baked right in to the
operating system might be the preferred method.

Although the methods for uploading files are all different, they all help you

accomplish the same job: moving files from your personal computer to their
new home on the World Wide Web.

Adopting an Effective Filenaming
Convention

In Chapter 9, we talk about the importance of “the little things,” such as ID3
tags. Equally important is how you decide to name your podcast media files.
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In this section, we illustrate the importance, not only to you as a podcaster,
but also to your listening audience. Although no hard and fast rules for
naming files exist, following some common conventions allows everyone to
easily find your podcasts.

A good naming convention of a podcast accomplishes the following:

1~ Easy sequential ordering: Files should not appear at random in your
directory. They should line up — first, second, third, and so on.

1 “At a glance” recognition for your listeners: Calling a podcast media
filemy media file doesn’t help very much. Calling it Bob's Fencing
Podcast certainly does.

Here’s an example of a well-named podcast media file, if we do say so
ourselves:

Tech_Ep200_080102.mp3

Although the structure may not be obvious, this filename adheres to both
rules and even adds one more:

v Tech: This abbreviation stands for Technorama, one of the many pod-
casts Chuck produces each week. Starting the filename with these four
letters organizes the files together in the media folder. For listeners
who can see only the filename on their MP3 players, they can quickly
recognize that files starting with these four letters belong to his show.

v Ep200: This is Episode 200 of the show. Referring to each show with a
sequential number is a good idea, giving you and your fans a common
reference point that is easier than “remember when you did that one
show with that one guy who said that funny thing? Man that was great!”
Having the episode number right after the name also ensures that the
files “stack up” right in the media folder, as well as in your listeners’ MP3
players. You may want to consider adding some leading zeroes to the
number so episode 3 (003) comes before 200. Add more zeroes if you
plan on doing more than 999 shows.

v 080102: The date Chuck posted the live file. The order he uses here is
year-month-day. He uses 08 instead of 8 so that dates from October
(10), November (11), and December (12) don’t intermingle with January
(which would happen if he used 1 instead of 01). True, in this case the
files were already sorted by episode number, but you may choose to go
with the date first.

Between each element, he adds an underscore (_) simply to provide a
clear distinction of each part for his eye, or anyone else’s eye looking at
the filename.
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Don’t use any spaces or special characters in your filenames. Stick with A-Z,
0-9, dashes, and underscores. Slashes (/, \), octothorpes (#), ampersands (&),
and others can and do cause problems when creating RSS 2.0 files or when
clients are handling the file. Also, leaving a space in the filename might mess
up a URL, so if you want to space things out, use underscores or dashes (for
example, use My_Podcast .mp3 instead of My Podcast.mp3).

The following examples are from well-respected podcasters who all follow
the guidelines we set forth earlier:

¥ JimmyJett-2007-12-17 .mp3

¥ Gmail-063-Security.mp3

V¥ VF_Ep060_paidinfull-120407.mp3
V¥ DSC-704-2007-12-27 .mp3

Note how each of them identifies the name of the podcast and provides a
sequential way of ordering the files. If you leave out the episode number,
as in the case of the JimmylJett file, the year of the podcast ahead of month
and day also ensures that 2007 files are always grouped together. If the
podcaster had used the month first, as people traditionally think of dates
in the United States, files would be mixed based on the month they were
released, regardless of the year.

If thinking about the date that way seems a little too strange for you, do what
Chuck does — stick a sequential episode number in front of your date, and
don’t worry about it.

Understanding How FTP Works

\\3

FTP (File Transfer Protocol) is the method by which you can transfer files
from one destination to another over the Internet. You likely transfer

files every day, from your desktop to your documents folder, from an e-mail
to your desktop, or even MP3 files from your podcatching client to your
MP3 player.

Transferring files to and from the Internet isn’t much different, at least on the
surface and even at any depth necessary for podcasters to ply their trade.
Lucky for you, specialty software exists to make this process even more
simple. FTPing files has become as simple as dragging and dropping.

Some podcast hosting services, such as Liberated Syndication (http://
libsyn.com) make this simple process even simpler by providing a Web
form to handle the uploading of podcast files, as described later in the chapter
in the “Uploading to a Podcast-Specific Host” section. Browser-based systems
certainly remove the complexity for many, but it doesn’t hurt to understand
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the processes outlined in this chapter. Many experienced podcasters need
more flexibility than the limited functionality a browser-based upload
process allows.

Regardless of what software, forms, or other assistance you use to move files
around, the concept of FTP is the same.

FTP has been around for quite a while now. As such, archaic and seemingly
nonintuitive names abound from the start — such as the following two
computer systems involved:

+ Local host: The local host is the computer you are sitting in front of
and initiating the file transfer from. If you’re using a laptop to connect
to your Web server, your laptop is the local host. If you're at work and
logged in from a workstation, your office computer is the local host.

The local directory or local path is the folder on your local host that con-
tains the files you want to transfer. You can change local directories at
will, but most FTP programs have a default starting place. Feel free to
move around after that.

1 Remote host: The remote host is the computer or Web server to which
you’ve connected. It’s likely the spot where you’re trying to get your
MP3 files to go so you can start podcasting.

Not surprisingly, the remote host has its own remote directory (the folder
on the remote system where you drop your files). Again, you can change
or navigate through remote directories just as you can change the file
folders on your computer.

Making Your Connection
with an FTP Application

You need three pieces of information to initiate an FTP connection:

v The IP address or hostname of your Web server
v Login name
v Password

Your hosting company should have provided this information to you. If you
don’t have it handy, find it. You're not going any farther without it.

All FTP programs do the same job but have slightly different methods of
going about it. After you grasp the concept, using just about any FTP
client is a simple process. Here are the general steps you follow to set up
a connection in any FTP client:
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1. Launch your FTP client and create a new connection.

Because this step is what FTP clients are designed to do, they usually
make this process very simple.

2. Enter the hostname of your Web server, username, and password.

This step identifies the remote system and shows you have access to
the files and folders it contains.

3. Connect using either a button or a menu option.

Depending on the speed of your connection, the connection is
established in a matter of seconds.

The following sections show you how to use Cyberduck (http://
cyberduck. ch), a free and handy FTP program for the Macintosh system,
and FileZilla (http://filezilla-project.org), a similar program

for the PC. You can find many FTP programs as freeware, shareware, and
shrink-wrapped software, for every brand of modern day operating system.
We picked these two for their ease of use and streamlined approach to
getting the job done, but you can use the FTP program of your choice.

Step by step (or quack by quack)
setup for Cyberduck

After you download the Cyberduck program from http: //cyberduck.ch
onto your Mac, you can follow these steps to set up an FTP connection in
Cyberduck:

1. Click the New Connection button in the upper-left corner.
The Connect dialog box appears, as shown in Figure 10-1.
2. In the Server text box, enter the name of your server.

Depending on the requirements of your ISP, this name can be in the
format of £tp.mydomainname.com or perhaps simply my_domain_
name.com. And of course, you need to be sure and use the name of your
Web server. Chances are good that you don’t really own the domain
my_domain_name.com, right?

3. Leave the Path text box blank.

Every Web server is configured differently, and most ISPs have things
configured to put you in the appropriate place. Later, you may want to
add something to this line so you don’t have to move around file folders
each time you connect.
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Figure 10-1:
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configured
Cyberduck
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connection.
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4. Enter your Username and Password in the text boxes.

The hosting company should have provided this information. If your
hosting company is the same company that is supplying your connec-
tion to the Internet, it might be the same information you use to check
your e-mail. But if you toss some additional money each week at a host-
ing provider, it’s likely something completely different.

Select the Add to Keychain option to store your username and password
for the next time you connect.

5. Click the Connect button in the lower-right corner.

If you entered things properly, you now see the file folders on your
remote Web server. If you didn’t, you get an error message or a login
failed dialog box. Correct what’s wrong and try it again.

When your connection is established, choose Bookmarks=>New Bookmark.
Give your newly created connection a catchy name and simply double-click
the given name the next time you need to connect.

Server.
Path
Username

Password

Connect Mode

Encoding
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v | ©
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FTP (File Transfer Protocol)
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ftp:/ fchuckehat@ftp.chuckehat.com:21/
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chuckchat

@ Add to Keychain
] Anonymous Login
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No Private Key selected

Passive

UTF-8

[ Cancel I { Connect )

Step by step setup for FileZilla

FileZilla (http://filezilla-project.org) operates much the same as
Windows Explorer, allowing you to drag and drop files between your PC
and your FTP server. When you’ve downloaded the FileZilla program, follow
these steps:

1. On the Login toolbar (shown in Figure 10-2), enter your server name,
username, and password.

Leave the port blank. (It defaults to 21.)
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Figure 10-2:
A properly
configured

Filezilla
connection.
|

2. Press the Quickconnect button.

If you did things right, you see a lot of text scroll by in the upper-most
window and content from your Web server appears in the right win-
dows, labeled Remote Site.

Congratulations; you're now connected to your Web server. If you
entered something wrong, you get an error message in red text in the
upper window. Correct your mistakes and try it again.

From here, you can navigate through the folders on your Web server much

as you do on your computer’s hard drive. You can move up or down the file
system, finding the spot where you want to drop your podcast files.

Login toolbar

[A Filezilla ==
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@) Gmal Podcast
) Ios e
Filename / Filesize | Filetype Last modified Al | Fiename / Filesize | Filetype Last modified Permissions Owner [ Gr...
2.
[)BedMusic File Folder 12{13(2007 5:15:2. ..
)Commercials File Folder 12/13}2007 5:15:3.... <Not connected to any servers
[D)Drap Ins File Folder 12{14/2007 3191,
Email File Folder 12{13(2007 5:15:5. ..
[C2)Endings File Folder 12/14j2007 2:48:4...
[)Freestyle File Folder 12{13/2007 5:18:5... v
Server [ Local file Direction | Remate file Size | Priority Status
Queuedfiles | Faledtransfers | Successful transfers
Queus: 0 bytes X

A place on your Web server for your stuff

Logging in to your Web server for the first time can be an intimidating pro-
cess. In this section, we show you how to place your files in a location so you
can easily create links to your podcast files.

Don’t be intimidated by the odd directory names on your Web server. The
only one you really need to know is Public_html. Other hosts may call it
www or simply html. If you don’t have one of those three, poke around until
you find one that has a bunch of files in it that end in . html.
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Unmetered and unlimited explained

Okay, we can't throw out terms like that without
saying something about them:

Unmetered bandwidth refers to the policies
of certain hosting companies, like Liberated
Syndication (http://1libsyn.com),
that don’t base their monthly charges on
the amount of files transferred (podcasts
downloaded) each month.

v+~ Unlimited server space means you can host

1 or 1,000 different podcast media files on
the Web server and be charged the same
flat fee. We don’t know of any hosting com-
pany offering unlimited server space cur-
rently, but you can get close. Many hosts
offer gigabytes for a cheap price — some-
times even hundreds of gigabytes — which

is effectively unlimited.

WING/

Look, but don’t touch. Going into folders doesn’t hurt anything, but doing silly
things such as deleting, renaming, and moving files you know nothing about is
a bad idea. All those strangely named folders do something, and they’re likely

necessary to make your Web site work right. Remember the proverb “Tis best
to leave functioning Web servers lie. . ..”

You may see lots of different files and a few folders. We show you how to
add even more files to this system, so now is a good time to think about
organizing and housekeeping.

Start by creating a special place to keep your podcast files. Making a new
folder exclusively for your podcast media files not only separates your
podcasts from your other critical Web server files, but it also allows you to
quickly see what is currently live and what needs to be cleaned up.

In your root directory (the top level folder usually denoted with a forward
slash), create a new folder called media. With Cyberduck, choose File=> New
Folder, followed by entering the name in the resulting dialog box. On FileZilla,
right-click the window with the details (date, size, permissions) on the
remote file server and choose Create Directory.

After you create the new media folder, double-click the name of the folder to
open it. You're now inside your totally empty media folder, and ready to load
it with your podcast media files.

Uploading your files

After you set up a folder for your podcast media files and decide on a
filenaming convention, you're ready to move your freshly named files to
the Web server.
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Using your blogging software to upload

Many popular blogging tools allow podcasters
to upload files without the need for special FTP
software, much like the HTTP process.

However, podcast media files often exceed
the file size requirements for these services.
For this reason, we recommend not using your
conventional blogging software to handle your
podcast media file uploads.

Consider that blogs are primarily used to com-
municate text. Although you can easily extend
the functionality of a blog to support a podcast,
the site managementtools are designed for text
and images.

WordPress (http://wordpress.org)
does allow file uploads, but the file size

depends on system parameters that are often
set by the Web host and can’t be changed by
the individual. You can upload, but it does take
a significant amount of work that exceeds the
scope of this book.

Instead, we recommend using blogging
software to manage the posting of your con-
tent after your file is uploaded to the server.
In WordPress, this is easily done with a plug-
in called PodPress. For more detailed infor-
mation about PodPress, be sure to pick up a
copy of Expert Podcasting Practices For
Dummies, by Tee Morris, Evo Terra, and
Ryan Williams.

Both Cyberduck and FileZilla support drag-and-drop file transfers. If you're
new to FTP, the FTP program interface may be easier for you to use.

For Cyberduck, follow these steps:

1. Choose File=>Upload.

2. Browse your system to find the podcast media file you want to upload.

3. Click the Upload button.

For FileZilla, here’s what you do:

1. Navigate to the desired folder using the Local Site window on the left.

2. Select one or more files and/or folders from the window directly

below.

3. Drag the selected files to the Remote Site window on the left.

Depending on the size of your file and the speed of your Internet connection,

the file may transfer in a matter of seconds or a matter of minutes. When
completed, the file appears in your FTP client and is ready to be linked in
your show notes and RSS 2.0 feed, as we discuss in Chapters 11 and 12.

187
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Uploading with Command-Line FTP
(Speaking of Old School . . .)

Earlier in this chapter, we talk about FTP clients that handle the uploading
process for your podcast media files. Each option requires you to either
download some specialty software or make a selection of a hosting company
that offers HTTP transfers. But there’s another way. . . .

Each PC and Mac has a built-in FTP program, but the programs are neither
elegant nor pretty, and they’re the antithesis of simplicity at first glance.
But these built-in tools are handy to know about, especially if you can’t
install new programs (library or shared-school computers may have this
restriction) and/or your hosting provider doesn’t provide a Web-based
HTTP transfer option.

We talk about command-line FTP in this section, and it comes with none of
the conveniences and assurances of the other options we covered earlier
in this chapter. But it’s a sure-fire way to get your files uploaded no matter
where you are. (Almost.)

Before you get into the program itself, you need to move the podcast media
file to a staging area on your desktop. Follow these steps:
1. Create a new folder on your desktop.

We recommend naming your folder something like media or
media staging.

2. Move your podcast media files to this folder.

Drag and drop the files from a new Finder window, My Documents,
or wherever you may have them stored.

Accessing Terminal on a Mac

If you're a Mac user, follow these steps to use Terminal to access the podcast
files you want to upload:

1. From Applications, open the Utilities folder and activate Terminal.

A small window appears, reminiscent of old-time computers where
unstyled black text appeared on a white background, or vice versa. Your
graphical interface is gone, and you might as well move the mouse out of
your way for a bit; you won’t be using it.
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2. Type cd Desktop/media at the flashing cursor prompt.

Your local directory changes to the media file staging area that contains
the podcast files you're about to upload.

Be sure to substitute the name of your folder if you've named it
something else beside media.

Jump ahead to the section “Uploading your files” to find out how to finish the
uploading process.

Accessing the command prompt on a PC

If you're a PC user, follow these steps to use the command prompt to access
your podcast files:
1. Choose Start=>Run, type cmd, and click OK.

A small window appears, reminiscent of old-time computers where
unstyled white text appeared on a black background, or vice versa. Your
graphical interface is gone, and you might as well get your hand off the
mouse for a bit; you won’t be using it.

2. Type cd Desktop\media at the flashing cursor prompt.

Your local directory changes to the media file staging area that contains
the podcast files you're about to upload.

Be sure to substitute the name of your folder if you’ve named it some-
thing else beside media.

Be sure to use the backwards slash (\) located above the Enter key on
most keyboards. Using a forward slash (/) doesn’t work on a PC.

Now you’re ready to upload your files as described in the following section.

Uploading your files

After you access the podcast files you want to load (see the two preced-
ing sections), the uploading process is the same on a Mac or a PC. (Bet you
never thought you’d see that happen, huh?)

Follow these steps to upload your files:

1. Type ftp my_domain_name and press Enter.
For example, we typed ftp ftp.chuckchat.com and then pressed Enter.

A variety of text appears in this window, followed by a prompt to enter
your name.
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2. Type your username and press Enter.

If your username is accepted, you get some positively reaffirming text
followed by another prompt.

3. Type your password and press Enter.

If you've typed your password correctly, several more lines of text
describing the server appears, followed by a new prompt. You're now
connected to (and controlling) the remote server.

4. Type cd www and press Enter.

That step takes you to the root directory where your files are accessible
to Web browsers and podcatching clients. Depending on your server
configuration, it may be public_html or simply html. If you try chang-
ing to a directory that doesn’t exist, you get an error message indicating
as much. You may need to check with your ISP if neither of these works
for your situation.

5. Create a media folder for your podcast media files. Type mkdir media
at the prompt, press Enter, and then type cd media and press Enter to
move to that folder.

You've just created a connection between your local media folder and
your remote media folder.

6. Type bin to ensure the files are transferred accurately as binary files.

This is a safety step. To the FTP protocol, there are two types of files:
ASCII (or text) and binary. Some command-line FTP programs default to
ASCII, which does a translation on certain characters. Because your MP3
file is not a text file, you want to ensure the contents are transferred
exactly byte-for-byte.

7. Type put my_podcast_file.mp3 at the prompt.
Replace my_podcast_file with the name of your file.

Type the name exactly as it appears, with proper capitalization, because
case is important. If you want feedback that your file is transferring, type
hash (before the put command) to see hash marks (#) print as the file
copies. For large files, it can be a bit discomforting to just see a blinking
cursor for several minutes. When the file is done transferring, you see a
status message stating “File Successfully Transferred” and some statis-
tics about how much data and how long it took, and you are pleasantly
returned to the FTP command prompt.

That’s it! If you've done things properly, you've now placed your podcast
media files on the server and are ready to create your show notes and/or
create your RSS 2.0 file. You can exit the command line by typing quit, exit,
or close, depending on the application.
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Uploading to a Podcast-Specific Host

Podcast-specific hosting companies significantly simplify the uploading
process; many include Web-based forms that take the place of additional
computer programs to handle the uploading process. They also take care of
archiving, RSS 2.0 creation, and even ID3 tagging.
N Although this Web-based uploading process is simple, we prefer the flexibility
of using an FTP client — or better yet a command line interface. Or maybe
we’re old school. . . .

For the purposes of illustration, we use an account with Liberated
Syndication (http://1libsyn.com) in this section. If you haven’t already,
you need to sign up with LibSyn and create your own account. Then follow
these steps:

1. Begin at LibSyn’s home page. Enter your username and password and
press the Login button.
2. Click the Settings tab to access your blog and podcast settings.

3. Enter the information for your blog and/or podcast. When you finish,
click the Save Changes button.

The blog settings are very simple; things like the name of your blog,
your e-mail address, and what category you want it placed in. Nothing
here is mission critical, so fill it out however you want to see it listed.
You can always come back and change it later.

4. Click the Media Files tab.

If you've never uploaded any media files, no media files are listed.
5. Click the bright green button labeled Upload a File.

You're taken to the upload page, as shown in Figure 10-3.
6. Click the Browse button.

The File Upload dialog box opens.

Note: HTTP upload is another name for form-based transfers.

7. Find the podcast media file you want to upload and either
double-click the file or select it and click Open.

8. Click the Load File button.

Depending on the size of your file and the speed of your Internet connec-
tion, the page may refresh in a matter of seconds or a few minutes. After
completion, the screen refreshes, and your podcast media file displays.
Note also that the text box under Advanced Users contains a string of
RSS 2.0 code. Remember this Web page and text box because we revisit
it in Chapters 11 and 12.
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Done

N LibSyn offers an FTP interface if you prefer to use an FTP client or command

line interface. Your login and password are the same as through the Web
interface.

<P If you like to try it before you buy it, LibSyn lets you log in to a demo account,
move files around, and generally get a feel for how it works before you sign up.
Not that the very inexpensive monthly fees will break you or anything, but it’s
nice to know how your future home might work.



Chapter 11
Providing Show Notes

In This Chapter

Understanding good show note etiquette
Planning your show notes

Deciding on your level of detail

Using images effectively

Posting with searchers in mind

Show notes are brief summaries of each podcast episode. Show notes can
take the form of an outline, a bulleted list, or just a few sentences of text.
In this chapter, we show you how to effectively use show notes to enhance
the listener experience of your show and bring in additional traffic to your
podcast through search engines.

And where do you find these show notes? Simply enough, on the podcast’s
Web site.

Getting additional traffic means additional bandwidth consumption, which
can cause issues. Flip to Chapter 10 for tips on ways to reduce the load on
your servers and for info about optional hosting plans that don’t charge for
additional bandwidth.

Show Note Etiquette

Several schools of thought exist on how to approach show notes. Some say
you should be very brief, using notes only to hold URLs and other pieces
of important offline data that your listeners may not have had time to write
down as the show was playing. Others suggest show notes should be filled
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with information on each and every concept touched upon in the show. We
prefer a more moderate approach, and your personal tastes and style go a
long way in determining what is right for you.

Regardless of the length of your prose and the level of detail you want to
explain, you need to follow some basic rules of etiquette:

v Use intriguing and informative titles. In general, and to keep things
simple, the title of your show notes should match your episode title.
Your title is your pitch; you're a huckster competing for the attention of
listeners. Some listeners may know all about you; others could be seeing
something from you for the first time. Include keywords in your title that
accurately and specifically represent the contents of this episode. Your
keywords should also generate some excitement and make the episode
sound interesting and intriguing to potential listeners.

+ Include links to all the locations mentioned in the podcast. If you're
talking about a trip to the local museum, provide a link to the museum’s
Web site in your show notes. If you mention another podcast, link to it.
Good linking brings good karma, and it may provide some interesting
and potentially helpful “Hey, you linked to me!” comments (and back-
links) from others.

v Concise or complete? Show notes can be as simple as a bullet list of
topics or as detailed as a word-for-word transcript of your show. It’s
up to you. The advantage to the bullet list is that it’s quicker to put
together, obviously. If you're already scripting your podcast, it’s no
extra trouble to post the script, but be aware of the length. A transcript
for a 3-minute show is pretty easy for someone to read from their
browser; however a 45-minute transcript — yes, there are 45-minute
shows that are completely scripted — may be something you don’t want
the reader to go through.

Figure 11-1 displays how Phil Clark and Mike (Lingo) Lingafelter of The Brit
and Yankee Pubcast (http: //thebritandyankee.com) use show notes.
The notes include plenty of backlinks, time marks, and a brief discussion
about the topics covered. A thing of beauty, to be sure.

When we think of show note etiquette, we're reminded of a commercial that
aired years ago for a small car company. The premise was “if everyone drove
one of our tiny cars, traffic congestion would vanish, the demand for fossil
fuels would drop, and the world would be a generally nicer place.” We’re con-
vinced that if every podcaster followed the preceding three simple show note
guidelines, the podcasting world would be a better place. The impact on traf-
fic jams and oil consumption remains questionable, but one can dream. . . .
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Planning the Post

The amount of time you spend planning your show notes is inversely propor-
tional to the amount of time you spend during your show prep (see Chapter
4). If you forgot everything from your high school Algebra Il class, allow us

to paraphrase: The more you prepare for your show, the less time you spend
working on the show notes — and vice versa.

Examine the notes you used when you recorded your podcast. Did you talk
about any Web sites? Find the URLs and make sure you spell them right. We
highly recommend the copy-and-paste technique for URLs, rather than rely-
ing on your typing skills, especially for lengthy URLs.

If you recorded and/or edited your show hours or days before you started
this notation process, replaying the media file with pen and paper at the
ready is a good idea. Look for need-to-know moments and jot them down
as the show plays. After it finishes, use a search engine to find additional,
relevant URLs you may want to provide to your listeners.

The following sections help you create powerful show notes that benefit you,
the listener, and potential listeners.
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It’s all in the details

Now is a good time to figure out what level of detail you're going to employ in
your show notes. Several factors can influence your decision, and audience
expectation and personal choice are among the more important.

Here’s a good rule: The deeper you dive in to a single topic, the less detailed
your notes need to be. That may sound counterintuitive, and please keep in
mind this is only a general rule and not a law. For example, if your podcast
episode features a 20-minute interview with Theoretical Physicist Dr. Michio
Kaku on his book Physics of the Impossible and how applicable those ideas are
to the Star Wars Universe, you likely won’t have much more than a link to buy
the book and/or rent the movie.

Show note details serve several primary purposes:

v To act as a table of contents for the episode

v To allow listeners to skip ahead if they so choose

As the podcaster, you can decide how much or how little you embrace
these purposes. Here are some approaches that other podcasters
have adopted:

1 Add a time stamp. Some podcasters put the exact time stamp of when
they change topics, which is quite frequently. Time stamps can be quite
helpful to your listeners if you cover a wide range of topics in a given
episode and want to assist possible listeners in jumping around.

v Write in complete sentences and paragraphs. Taking cues from the
world of blogging, many podcasters follow a similar approach to Kris
Smith of The Croncast (http://croncast.com). Kris writes his show
notes in prose, using complete sentences and paragraphs in place of
bullet points and time stamps. This approach feels better to poten-
tial readers, giving them a flavor of the show without having to listen.
However, we’ve also heard listeners complain that key elements are
difficult to find in this format.

1 Create more than a one-line summary. Some podcasters, such as
Dave Winer (http://morningcoffeenotes.com) take the opposite
approach and post a simple one-liner that isn’t much more than a title.
We suggest new podcasters not follow his lead because it doesn’t do
much for helping attract new listeners. Dave is a seminal figure in the
world of podcasting and gets most of his listeners because he’s Dave
Winer, not because he posts great show notes.
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Detailed show notes are also useful for attracting new listeners. Show notes
improve your search engine rankings, and they enable Web surfers to deter-
mine the value of an episode before listening. For his Gmail Podcast, Chuck
started with a synopsis of each show (for example, “Learn how to be more
effective using labels”). After seeing little increase in listenership for 18
months, he started including the full transcript to the 5 minute show, and
listenership doubled — that’s how powerful show notes can be.

A picture is worth a thousand words

Some podcasters include a representative image or two in their show
notes. Although random graphics serve only to increase your bandwidth
consumption and clutter your page, well-selected images can add flavor
and dimension to your show notes. In some cases, these are the same
images used as album art in the episode files.

Before you add an image to your post, keep in mind these three
considerations:

1~ Is the image protected by copyright? Posting someone else’s creative
work without first securing permission (which may include royalties
and fees) is stealing, pure and simple, and can land even the most
well-meaning podcaster in a heap of legal trouble.

v Can you link directly to the image, or do you need to copy it to your
server? Some sites, such as Amazon.com, allow you to link directly to
images as they sit on the Web site. These sites have a huge technology
infrastructure and can handle remote hosting images that appear on
other sites. But many smaller and personal sites can’t handle the load
a popular podcast can put on their systems if they allowed direct link-
ing to their stored images. In these cases, copy the image to your own
server before adding it to your page. If you're going to do this, it’s good
karma to provide an “image courtesy of . . .” link to the original site.
Again, this assumes you’ve received the appropriate permissions to
copy the file. When in doubt, don’t.

1+ Does the image fit on your page? Images too small or too large aren’t
doing your listeners any favors. Make sure the image you select is the
right size. You can add width="x" height="x" declarations to your
image tags to control the size, but keep in mind that this distorts the
image. Previewing your post with resized images is a must. If your HTML
is a little rusty, check out HTML 4 For Dummies, by Ed Tittel and Mary
Burmeister (Wiley Publishing, Inc.), for additional help.
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We can'’t stress enough how important it is that you not take, post, modify,
or use any image without the express permission of the copyright owners.
The act of someone posting an image to a Web site does not give you carte
blanche to use it as you see fit. When in doubt, leave it out.

Posting Your Show Notes

If you've planned and prepared, posting your show notes is easy. And if
you've decided for the minimalist approach or don’t really care to use show
notes, this process can go quickly as well because there’s nothing to do.

In this section, we show you how to enter your show notes by using
WordPress and Libsyn as examples. If you use another tool to make your
posts, or if you create your notes by hand, you still get value out of these
examples as we show you things to consider along the way.

Posting in WordPress

WordPress is free, easy-to-use blogging software that also works well for
podcasters. Follow these steps to post show notes in WordPress (www .
wordpress.org):

1. Log in to your Web site’s site administration page.

By default, you typically can find a Login link on WordPress pages. If
you've already provided credentials, the link may say Site Admin. In
most instances, the URL looks something like: www . your_domain_

here.com/wp-admin

2. Click Write from the menu along the top to start a new posting.

A new posting page opens. Here’s where you fill in the details of your
new posting. Although this screen displays a lot of items, you don’t need
to use them all to get started.

3. Select the appropriate category for your podcast from the Categories
section.

Though not critical, categories help keep things more organized. It’s
not uncommon to have one category for text/blog entries and another
for podcasts.

4. Enter the title of your podcast in the Title text box.

Label your show with a short descriptive tag, Classic Car Auction, for
example. For more titling help, see the “Loading up your titles” section,
later in this chapter. To make the reader’s life easier, we recommend
using the same title on your show and your show notes.
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a podcast
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5.

In the large text area below, type your show notes.

Follow a chronological order and list the various topics covered in your
show, one on each line.

. Be sure to add URLs to any Web sites you mention.

To create a link, highlight the text you want to link and then click the
Link button. Copy and paste the full URL — including the http://
part — you want to link to in the pop-up box (see Figure 11-2). Click OK.

The page at http:/Awww.chuckchat.com says:

?)
bDo

Enter the URL

http: fimedia Farpointmedia. net/technaorama/ Tech-E

10.

11.

. Create a link to your podcast file.

Enter text like Listen Now or Download MP3. Just as you create a link
to a URL in Step 6, you can add a link to your podcast file. If the file is on
your server, use the pathname on your server. If your file in on another
server, use the entire URL — for example, http: //servername/path_
to_myfile.mp3.

. When you’re done entering your show notes, click the Save button.

You can see a preview of your posting by clicking the Preview button —
it’s not a bad idea to verify the format and ensure links will work before
releasing it to the public.

. Scroll down to preview your post.

Make sure the links work properly — including your podcast file. Few
things are more embarrassing than releasing that long-awaited podcast
only to find that a link in your show notes doesn’t work. When you’re
just starting out, you likely won’t have a lot of people letting you know
of technical issues. It’s up to you to test as much as you can before
releasing a new podcast.

Make any adjustments necessary.

If you notice links that don’t work or typos, you still have an opportunity
to fix them by scrolling back up, making the edits, saving your work, and
repeating Step 9 until you're satisfied.

When you’re satisfied with your show notes, click Publish.

The system takes care of generating the RSS 2.0 feed. We discuss RSS in
more detail in Chapter 12.

199
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12. Click View Site link at the top of the page to see how your entry looks.

Visiting your Web page is a good idea to make sure everything looks
as you expected it to. If it doesn’t, simply edit the post and resave
your changes.

We’ve only scratched the surface of what WordPress can do. If you really
want to take advantage of the software, we suggest WordPress For Dummies,
by Lisa Sabin-Wilson. You can also listen to The WordPress Podcast with
Charles Stricklin to keep up on plug-ins, software changes, and security
updates.

Many podcasters with detailed show notes use the <More> tag in their
WordPress postings, as shown in Figure 11-3. Any text above the More link is
displayed on the main page. Those with interest to view the detailed content
can click the link. If you have lots of show notes to include in your post, this is
a good way to keep your front page tidy with a few bullet items for each show,
and then you can “hide” the longer list.

In the next chapter, you find out about creating the RSS 2.0 feed so that people
can subscribe to your podcast. Assuming you’ve installed the PodPress plug-
in, WordPress makes RSS feeds easy. Don’t worry about it for now because we
cover it in detail in Chapter 12.
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Posting on LibSyn

Because LibSyn (www.libsyn.com) is a dedicated podcast hosting provider,
the steps are quite intuitive and a bit different than those used by folks who
work with blogging software.

Follow these steps to post your show notes on LibSyn:

1.

To create a new post, click the Publish tab or the link of the same
name from the main page.

. Click the New Post option button.

LibSyn also allows text-only posts to the site, which is great for times
when you want to post some text without a media file, such as to say
“I'm on vacation for the next two weeks.”

. Enter a title for this episode.

We cover some titling tips later in this section. For now, simply enter a
basic description of what this episode is about — “Classic Car Auction”
for example.

. Choose a category for your podcast from the Category drop-down list.

Categories on LibSyn work like they do with most blogging applications.
To keep this simple, choose Podcast from the list.

. Skip the Post Image drop-down list for now.

Yes, you can put something in there if you must. But it’s not required.
See our earlier comments on using images in this chapter if you decide
you can'’t live without one (but you probably could).

. Enter the detailed show notes in the Show Notes text box.

This is the appropriate place for your detailed show notes. Follow a
chronological order and list the various topics covered in your show,
one on each line. Be sure to add URLs to any Web sites you mention.

Typing the URL in this section isn’t quite as effective as providing a true
hyperlink. Making a hyperlink isn’t difficult, though it may look that way
if you aren’t familiar with the mysteries of HTML.

Hyperlinks follow this convention:
<a href="link/to/website/or/web/page">Name of link</a>

Basically, you fill out what’s between the quotes, replace the name of
the link, and you’re done. Here are a few real-world examples:

<a href="http://www.chuckchat.com/gmail">Gmail Podcast</a>

<a href="http://morevi.net">Morevi podcast</a>

<a href="http://marsrovers.nasa.gov/gallery/images.html">Pictures from
Mars</a>
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7. Chose your podcast media file from the drop-down list.

If you haven’t uploaded the show yet, LibSyn makes it easy. Simply click
the Browse button and navigate to the appropriate file in your media
folder (which we show how to set up in Chapter 10).

Because LibSyn doesn’t allow you to preview your post first, we highly
recommend checking your spelling and double-checking your links
before you proceed. An ounce of prevention and all that.

Figure 11-4 shows how your post looks on LibSyn before it is posted.
8. Click the Publish button.

LibSyn makes it hard to screw up, requiring you to fill out the appropri-
ate fields before allowing you to continue. If you're successful, you see a
green check box next to your new post.

9. Check your page.

Click the link to your show name and see how it looks in the real world.
Check your links, spelling, and layout. If it’s not the way you want, close
the window and click the name of your post to edit it.

It never hurts to mention that you have show notes. You can do so as part
of the running dialog — for example, “. . . We found a great deal on those at
Frobozco. We'll have a link in the show notes on our Web site . . .” or mention
it at the end of the show with contact information, as in “Don’t forget to stop
by our Web site, where you'll find links to everything we mentioned in the
show notes, information on how to contact us, and much more at www. . . .

”

) libsyn // podcasting made easy - Mozilla Firefos =18
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<DIV>  Remove Tag
iPod screen width = 32000 (36 characters)
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nt:

Files in your

Mofile selected =
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Additional Options
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Using a wiki for your show notes

A wiki is a Web site that allows your listeners to contribute to your show
notes. This may sound rather scary — “let others modify MY Web site? Are
you crazy?” Before you dismiss the idea, consider sites like Wikipedia (www .
wikipedia.org), one of the foremost reference sites built entirely by volun-
teer public efforts. Now imagine the power of your listener community
helping you build and maintain your show notes.

One method of using the wiki is to post a framework, or bullet list for your
show notes, and let the users contribute. Another way is to just start writing
and let the user community come along and do the clean up.

Note that wikis won’t work for every podcast. It takes a certain level of
listener loyalty — something the podosphere has no shortage of.

You can employ a wiki in two basic ways: Build one yourself or use a wiki
someone else has built. We discuss each way in this section.

Using MediaWiki

MediaWiki (www.mediawiki . org) is the software that runs the popular
Wikipedia. The software is freely available to anyone who wants to set up a
wiki. It does require you to maintain a database with your Web hosting pro-
vider. Check the Web site to install the software.

Installing MediaWiki is similar to installing WordPress in that it requires you to
have a Web host that allows you to upload and install software and access to a
MySQL database.

When it’s installed, you can create pages specifically for show notes.
MediaWiki does use special formatting characters to create links, bulleted
lists, numbered lists, and more; however, using the wiki formatting charac-
ters is simpler than trying to teach yourself HTML. An example of your show
notes in a MediaWiki page might look something like this:

=Show 15: HP Laptops and me=

* Introduction

* The week in review

* [http://www.microsoft.com Software troubles]

In this example, the line flanked with one or more equal signs (=) indicates
a section heading. The more equal signs, the further the indent. The lines
starting with asterisks (*) are a bulleted list. The last line enclosed with the
single square brackets ([ ]) is a link to another site, everything after the site
is the text displayed. In this example, the Web browser displays a link that
says Software troubles, which takes users to the Microsoft home page.

The following steps show you how to create a new page of show notes. We
assume the top level page is at http: //www.mysite.com/wiki.
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1. Click the Log In/Create Account link in the upper-right corner.
2. Log in to your wiki with your username and password.

Assuming you set up the wiki, you already have an account. New visitors
have to use the link Create an Account.

3. Click the Edit tab.

The page will change to “edit mode” allowing you to enter text in a large
text area.

4. Create a page link.

Enter the formatting code [[Some Text]], where Some Text is the name
of your page. For example, [[April 30, 2008]].

5. Click the Save Page button.

MediaWiki goes back to browse mode. You now see a link with the text
of your new page link. Note that the link is in red, which means there’s
no actual page for this link — yet.

6. Click the newly created link.

You're taken to the same page editor as before, but there’s no content.
This is where you enter your show notes using the formatting codes for
headers, bullet lists, and so on.

7. Click the Save Page button.

Congratulations! You've created your first set of show notes using
MediaWiki.

In very little time, you can create fairly extensive show notes and then link to
them from your blog post. Other listeners can them come along (and set up
accounts if necessary) and make changes.

You can use the wiki for more than show notes. You can create almost any
Web content to support your show from listener show suggestions to results
to a contest — there’s practically no limit to the ideas.

Most wikis feature revision control — meaning you can roll-back changes in
the event something goes wrong. With multiple people editing the same infor-
mation, it happens from time to time.

Using Wetpaint

If you don’t have the ability to install software on your hosting server (which
MediaWiki requires), or setting up your own wiki just isn’t your thing, you
can still take advantage of a wiki’s features with a site like Wetpaint (www .
wetpaint.com).

Wetpaint is a free site to manage wikis. Begin by going to the site and creat-
ing a login ID. You can create a personalized wiki and give it your own host-
name — for example, http: //technorama.wetpaint.com.
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Spend the time to watch the video that takes you on a demo to get a tutorial of
the system.

Updating your wiki is as simple as running a word processor. Just click the
Easy Edit button at the top of any page. The graphical toolbar makes it easy
to create headings, bulleted lists, and even insert widgets like an RSS feed so
visitors to your wiki know your recent postings to your Web page. And the
best part for you is that no HTML is required!

Figure 11-5 shows what your show notes look like in Wetpaint.
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Boosting Search Engine Rankings
with Good Show Notes

One tangible benefit of quality show notes is the impact they can have on
your listings within search engines. Traditional search engines cannot (yet)
scan and index the contents of your podcast media files. As such, you need
to provide text for the search engine spiders and bots to examine and evalu-
ate for index inclusion.

Chapter 11: Providing Show Notes 205
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We go into more detail about spiders and bots in Chapter 13. For now, you
just need to know that they are tools that search engines use to find interest-
ing information when people search for a particular topic.

Podcasters can pick up a lot of tips and tricks from bloggers and other Web
site owners on how to boost search engine rankings. Many include page-level
changes to positioning of elements, correct usage of headings, meta and image
tags, and back-linking techniques. All of that conversation is far beyond the
scope of this book. Grab a copy of Search Engine Optimization For Dummies by
Peter Kent (published by Wiley) and break out your code editor if you want to
make a bigger splash.

In the following sections, we show you some best practices you can imple-
ment right away that can make your notes (and podcast) more accessible to
search engines — and ultimately search engine users.

Loading up your titles

Search engines (and searchers) pay close attention to titles. You should con-
sider the title of your individual podcast episodes every bit as important as
the title of a given Web page.

Important as they are, most podcasters struggle with effective titles. The
biggest problem comes from confusing titles with descriptions. If your title
starts with “In this episode,” stop right there. You're writing the description,
not the title. A title is a string of well-chosen and crafted words that has no
room for superfluous baggage.

We find that the best titles come from a re-examination of your show notes.
If you haven’t made your notes yet, you may find coming up with a solid title
quite tough. Here’s the process we suggest:

1. Read your show notes and pull out the key elements, thoughts, or
themes covered on the show.

For example, for the Classic Car Auction we’ve been using throughout
this chapter, we’ve come up with the following completely made-up
topics and themes from an imaginary show:

¢ Sleeping in the Seattle airport while the flight was delayed

¢ Interesting discussion during the flight with an 80-year-old man
who is a car restorer

e Under the hood of the 1965 Ford Mustang
e Custom headers and exhaust systems

¢ A short interview with the owner of a 1972 Chevy Nova
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¢ Taking a 1957 Chevy Belair for a cruise
e Listener feedback request: What’s your favorite classic car
2. Boil down each element to a single word or phrase, if possible.

Think about the people who might be interested in the contents of your
show and pick common words they’re likely to search for.

For example, if you're a comedian, the airport delay and the old man
on the plane might be good places to start. If this is a more serious car
show, the experience with the 65 Mustang and the Belair might be a
good place to start.

If your show is a relatively serious collector/restoration show, you're
trying to entertain and attract like-minded listeners. Getting rid of the
fluff is a good idea. You can select the key points and condense them to
the following:

“Experienced restorer, a peek at a Mustang, and driving a true classic.”

That’s a solid title, giving searchers a good tease about what they
can expect.

Notice how the title doesn’t cover everything, and it shouldn’t try. That’s the
job of the description where you can go into even greater detail on those three
elements, plus the many other things you talk about on the show.

The title also carries good keywords likely to be of interest to car buffs or
admirers considering a purchase, looking to get in to restoration, and those
who may already own a classic.

Chances are good that you know your audience much better than we do.
Think about how people are likely to search and write your titles for that.
Keep them short, don’t try to cover everything, and employ more detailed
descriptions to carry the rest of your story.

Soliciting backlinks

Backlinks are the Holy Grail of search engine optimization. A backlink is
simply a link from someone else’s Web site to yours — whereas a regular
link is from your site to another. Sites that have a lot of backlinks pointing to
them are considered “more important” to the computers that control where
your site shows up on a search engine. To get backlinks from others, you
have to create links to their Web sites in your show notes.

When you're soliciting backlinks from sources, make each e-mail personal,
provide the exact link you want them to use, and tell them why you think it’s
important for them to link it.
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In the highly suspect classic car auction we’ve been using as an example, you
could link to several things, and you really should link to a few things. For
example, you could provide a link to the airline that messed up the flight, but
what’s the point? On the other hand, you most certainly want to create a link
to a place to buy or read more about sources of parts, and you likely would
want to link to the auction site.

Before you post the show, it may be a good idea to contact other podcasters,
bloggers, and perhaps notable Web sites to see whether they’re interested

in linking to you (and you to them) to generate interest in your podcast,
rather than a specific show. Many sites have a section somewhere for related
sites. This can be a very effective tool for drawing people to your site and
your podcast. Then you can also find folks who might want to backlink to
particular episodes.

So, you've posted your show and got your show notes online. It’s time to
start soliciting backlinks to individual episodes:

v Company backlinks: Write to the company who manufactures the
custom headers to tell them you’re posting a review of one of their
products. Getting big companies to link to you doesn’t always happen,
but sometimes it does. And getting backlinks from big popular sites
is very beneficial to your rankings.

v Courtesy backlinks: If someone helped you with a part of your podcast
and you mention it in your episode, let that source know. Send an e-mail
to the agency you booked the trip with and maybe even the hotel.

+* Backlinks from fellow podcasters: If other podcasters cover topics
related to your episode, let them know about it because they might
be willing to spare you a backlink. Notify various car bloggers and
podcasters about the new episode. It takes only a few moments of your
time and is information they would or should welcome.

A fine line exists between asking for backlinks and spamming someone. If you
can’t think of a good reason why that site should link to you, then you don’t
ask for it; otherwise, just mention what your show is and what you’ve covered
that might be of interest and let them decide whether they want to provide a
backlink.
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Geeking Out on RSS

In This Chapter
Understanding RSS
Creating good introductions
Handling multi-format podcasts

ou’ve entered the dark and murky waters of the RSS generation — a

region of the podcasting sea that strikes fear into the hearts of the unini-
tiated, causes mild-mannered podcasting preachers to break out into curse
words that would make a sailor blush, and has soured more than one would
be independent media producer on the whole prospect of podcasting.

Relax. For the most part, the trials and tribulations you might have heard others
had to go through are overblown. If it were as hard as some have made it out
to be, there wouldn’t be as many podcasts as there are available today. The
RSS step wasn’t designed to be complicated; it’s just quirky, and it’s been
tainted by the experiences of a few who jumped in a little too fast, without a
trusty guide to show them the path.

This chapter shines a big bright spotlight on RSS elements, showing you that
they aren’t as mean and scary as they’'ve been made out to be. After reading
this chapter, you'll have a solid strategy for generating your podcast’s RSS 2.0
file, some options for dealing with multiple media files, and the confidence to
tweak your RSS file as you see fit.

You're probably asking yourself: “Do I need to know all that”? Well, yes and
no. Granted, you'll likely be using blogging software or some podcast-hosting
company that takes care of the RSS 2.0 feed for you. It’s still a good idea to
know what goes on under the hood, in our opinion.

Elements That Make the RSS Go 'Round

The main function of your RSS 2.0 file is to distribute your media files to
people who have subscribed to your podcast. RSS is nothing more than
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Getting a handle on TLAs (three-letter acronyms)

XML stands for eXtensible Markup Language.
“Markup” is a lot like what your teacher used to
do to your homework, only more useful: “mark-
ing up” a text file with some special tags that
control how the text is used by various appli-
cations, like a podcatching client. This is good
news if you're without an advanced degree in
computer science: It's text (in this case, English
or something a lot like it) that tells other text
how to present itself.

“Extensible” means developers can add
other tags beyond the original “set” that was
designed for XML. In other words, a developer
can add to the code base of XML, adapting it to
individual needs. Okay, feel free to forget that
if you want — you won't have to worry about
creating new tags, thanks to RSS 2.0.

RSS is a flavor (modified version) of XML, and it
stands for Really Simple Syndication. (Syndication
is the process of getting the goods — whether a
Web site update, news bulletin, or podcast — to
the intended audience.) Lucky for us podcast-
ers, XML was extended to RSS, which was fur-
ther extended to create RSS 2.0. And inside RSS
2.0 is where you find the appropriate tags and
elements that make podcasts work.

You'll hear podcasters use the terms XML and
RSS interchangeably. Sometimes people say
the version number (2.0) out loud and in print,
other times it's simply implied. There's at least
one other version of XML that works with pod-
casting: Atom. No, it's not a TLA, because it has
four letters and it doesn't stand for anything, but
itis a version of XML. The differences between
Atom and RSS 2.0 are beyond the scope of this
book. The good news is that most podcatch-
ing clients read either Atom or RSS 2.0 files. In
fact, advanced RSS 2.0 feeds often incorporate
Atom elements, further blurring the differences
between the two formats. To minimize head-
aches, this chapter focuses on RSS 2.0 as the
preferred method of syndicating your podcast
to podcatching clients. And yes, iTunes fans,
we do cover the extra tags your podcatcher of
choice has made us all deal with.

If you want an even deeper dive into the world
of RSS syndication — because you can do
some really cool stuff with it — we highly rec-
ommend Ellen Finkelstein’s Syndicating Web
Sites with RSS Feeds For Dummies (Wiley
Publishing, Inc.).

“marked up” text with special tags. (For more about the technical aspects of
RSS, check out the nearby sidebar.) Here’s a sample RSS 2.0 feed:

<?xml version="1.0"?>

<rss xmlns:content="http://purl.org/rss/1.0/modules/content/"
xmlns:itunes="http://www.itunes.com/DTDs/Podcast-1.0.dtd"

version="2.0">
<channel>

<title>The Car Collector Podcast</title>
<link>http://www.mypodcast.com/</link>
<description>The best podcast on the planet. Period. With your host, me!</

description>

<webMaster>chuck@mypodcast .com</webMaster>
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<managingEditor>chuck@mypodcast.com (Chuck Tomasi)</managingEditor>
<pubDate>Sat, 31 May 2008 12:02:28 -0800</pubDate>
<category>Automotive</category>
<image>
<url>http://mypodcast.com/images/logos/ccpl00x86.jpg</url>
<width>100</width>
<height>86</height>
<title>The Car Collector Podcast</title>
<link>http://mypodcast.com</link>
</image>
<copyright>Creative Commons Attribution 2.5 License</copyright>
<language>en-us</language>
<docs>http://blogs.law.harvard.edu/tech/rss</docs>

<!-- iTunes specific namespace channel elements -->
<itunes:subtitle>The best podcast on the planet. Period. With your host, me!</
itunes:subtitle>
<itunes:summary>This podcast blows the doors off all other automotive
podcasts. Listen to this and leave the others in the dust.</
itunes:summary>
<itunes:owner>
<itunes:email>chuck@mypodcast.com</itunes:email>
<itunes:name>Chuck Tomasi </itunes:name>
</itunes:owner>
<itunes:author>Chuck Tomasi</itunes:author>
<itunes:category text="Games & Hobbies:Automotive">
<itunes:category text="Automotive" />
</itunes:category>
<itunes:category text="Society & Culture:History" />
<itunes:link rel="image" type="video/jpeg" href="http://mypodcast.com/images/
logos/tDPWI300x300.jpg">The Car Collector Podcast</itunes:link>
<itunes:explicit>no</itunes:explicit>

<item>

<title>TCCP 013 - Experienced restorer, a peek at a Mustang, and driving a
true classic.</title>

<link>http://www.mypodcast.com/tccp.html</link>

<comments>http://www.mypodcast.com/tgopl3.html#comments</comments>

<description>Synopsis: Steel Headers are the people who made this trip
possible. I appreciate it and can't recommend them enough. Take
off with me to LA California for the fifth annual Classic Car
Auction. A little trouble with the travel, a great discussion
on the flight with a man who has been restoring classic cars
for decades, a look under the hood of a 65 Mustang, and you
get to join me for the experience of a lifetime - driving a 57
Chevy Belair. Download The Car Collector Podcast Episode #13</
description>

<guid isPermaLink="false">1808@http://www.mypodcast.com/</guid>

<pubDate>Sat, 31 May 2008 12:02:28 -0800</pubDate>

<category>Outdoors</category>

<author>editor@mypodcast.com</author>
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<enclosure url=" http://mypodcast.com/media/TCCP013_20080531.mp3"
length="24849394" type="audio/mpeg" />

<!-- RDF 1.0 specific namespace item attribute -->
<content:encoded><! [CDATA [<p><strong>Show Notes</strong></p>

<p><a href="http://www.steelheaders.com/">Steel Headers</a> is the company
that made this trip possible. Can't recommend them highly enough!

<p>Thanks to <a href=http://davewishfieldcars.com> Dave Wishfield</a> from
San Jose, CA for talking to me about his 1965 Ford Mustang. Listen
and find out how much he got at the auction! Special thanks to
Aiden Somerset from Sun Prairie, WI for allowing me the privilege
to drive the 1957 Chevy Belair. What a ride!</p>

<p>Download <a href="http://mypodcast.com/media/TCCP013_20080531.mp3">The
Car Collector Podcast Episode #13</a></p>]]></content:encoded>

<!-- iTunes specific namespace item attributes -->
<itunes:author>Chuck Tomasi</itunes:author>
<itunes:subtitle>My recent trip to LA's antique car auction, plus my
adventures.</itunes:subtitle>
<itunes:summary>Synopsis: Steel Headers is the company that made this trip
possible. Can't recommend them highly enough. Thanks to Dave
Wishfield from San Jose, CA for talking to me about his 1965
Ford Mustang. Listen and find out how much he got at the auction!
Special thanks to Aiden Somerset from Sun Prairie, WI for allowing
me the privilege to drive the 1957 Chevy Belair. What a ride!
Download The Car Collector Podcast Episode #13</itunes:summary>
<itunes:category text="Games & Hobbies:Automotive">
<itunes:category text="Automotive" />
</itunes:category>
<itunes:category text="Society & Culture:History" />
<itunes:duration>00:45:00</itunes:duration>
<itunes:explicit>no</itunes:explicit>
<itunes:keywords>tomassi, thomasi</itunes:keywords>
</item>
</channel>
</rss>

Okay, that’s a lot to digest in a single sitting. The next sections of the book
break it down into individual parts to show you how un-scary it really is.

If you're currently using (or planning to use) blog software or your dedicated
podcast host to generate your RSS 2.0 feed, it’ll take care of just about all this
brouhaha for you. It’s still a good idea, however, to have a solid grasp of this
section in the event you want to make some modifications to your RSS 2.0 feed
in the future. (Most podcasters do, sooner or later.)
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Well, your software may not be of much help with the iTunes-specific stuff.
iTunes burst on the podcasting scene without much (read: ANY) advanced
notice. And when it did, it came up with unique tags to extend what RSS 2.0
already provided. Take a good hard look at the tool you're using to generate
your RSS feed and see whether there are any iTunes-specific tags. If not, you
may have to break out the manual and see how you can add them yourself. In some
cases, it’s easy — for example, adding the PodPress plug-in to WordPress — and
in other cases, it’s a bit daunting.

Do you have anything to declare?

All RSS 2.0 documents start with a declaration statement. Think of this declara-
tion as working with a “Hello, my name is . . .” badge. This statement identifies
the contents of the file, allowing podcatching clients and other XML parsers
or readers to know what to expect and how to handle the contents. Some declara-
tions wear their hearts on their sleeves, some are terse, but all RSS 2.0 documents
do the initial honors with these first two lines of text:

<?xml version="1.0"?>
<rss version="2.0" xmlns:content="http://purl.org/rss/1.0/modules/content/"
xmlns:itunes="http://www.itunes.com/DTDs/Podcast-1.0.dtd">

With those two lines of text, you’ve declared that the document is written

in XML version 1.0 and is of the special flavor RSS 2.0. Additionally, it calls
out two specialized namespaces, which we get into in a bit. You might want
to write those two lines on your forehead backward (metaphorically speak-
ing, of course) so you’ll always see ’em in the mirror as a reminder: They are
what you use to start every RSS 2.0 file you create as a podcaster.

A namespace is denoted by the xmlns: statement, followed by the URL of the
“home” of the namespace. In the preceding instance, we call the namespaces
for the encoded content module as well as iTunes tags. Purists will argue that
encoded content isn’t necessary and that even the iTunes tags are optional. But
they both go a long way to getting your podcast listened to by the most people.

What's on this <channel>?

An RSS 2.0 document contains a single <channel> statement, complete with
lots of other information to help describe the channel. A channel can contain
multiple <item> statements, and each <item> can have lots of other informa-
tion to describe the individual item.
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Okay, here’s a real-world example to clarify the issue: NBC is a “channel” on
your television. Depending on the day of the week and the time of the day,
various “items” are made available for viewing. It’s not an accident that pod-
casting works the same way.

In the following sections, we examine the contents of the <channel> decla-
ration from the example at the beginning of the chapter. (We cover <item>
tags in the later section “Loading up on <items>s.”)

XML tags are case-sensitive. For example, <description> has a different
meaning than <Description> or <DESCRIPTION>. Additionally, the case of
the opening tag (the one that starts a section) must match the case of the closing
tag (the one that ends the same section). <webMaster> and </webMaster> are
okay, but <webmaster> and <Webmaster> are not.

<title> tag

You use the <title> tag to hold the title of your channel, that is to say the
title of your overall podcast. Here’s the title from the example just given:

<title>The Car Collector Podcast</title>

This line of text says, “Here’s what’s inside me.” It never changes, unless you
decide to change the name of your podcast. Don’t abbreviate or shorten the
name unless you have a very good reason for doing that.

Almost every markup language uses this format of beginning and ending tags
encapsulated in angle brackets, < and >. The ending tag uses the same name,
but it’s preceded by a / character to tell the software that the tag is now
closed. In the example just given, you can think of the code as talking to the
podcatching client, along these lines: “(The next thing you'll read is the title.)
The Car Collector Podcast (That was the end of the title.)”

<link> tag

Here’s a good place to put a link that leads back to your Web site or blog. The
beauty of RSS and podcasting is that the listeners don’t have to be looking at
your Web page to listen to your show. This link allows them (through their
podcatching clients) an easy way to find your Web site if they so desire:

<link>http://www.mypodcast.com/</link>

<description> tag

Your description, much like your title, will rarely (if ever) change. Find a good
description for what your shows are about. The following example is pretty
poor (just kidding, okay?), so try to put in some words that truly identify what
your podcast is about:



A\

\\3

Chapter 12: Geeking Out on RSS 2 ’5

<description>The best podcast on the planet. Period. With your host, me!</
description>

Technically, the RSS 2.0 specifications allow you to place images, links, and
even text formatting inside the <description> tag. However, there’s some
question as to how many of the podcatcher developers have allowed for

that. Be safe. Keep straight text in your <description> tag and use the new
<content : encoded> tag to pass HTML. See the section later in this chapter,
“<content:encoded> tag,” to find out how to use this tag.

<webMaster> and <managingEditor> tags

The webmaster is the person responsible for the technical accuracy of the infor-
mation contained in the feed. The managing editor is the person responsible for
the messaging and content contained within the tags. For most podcasters, these
both reflect the same e-mail address. Note that the <managingEditor> tag
requires a name in parentheses to follow the e-mail address:

<webMaster>chuck@mypodcast . com</webMaster>
<managingEditor>chuck@mypodcast.com (Chuck Tomasi)</managingEditor>

Okay, maybe the words webMaster and managingEditor aren’t a perfect fit
with podcasting, but including an e-mail address for the person responsible for
this feed as well as the content is an excellent idea. We’ve e-mailed the keepers

of various feeds to report problems we’ve encountered with their feeds — and
each one has been very appreciative. Although having that information can help
improve the podcasting experience for everyone, there have been (and likely will
be) many feeds that don’t provide contact information. If you make it easy for
people to help you, you're ahead of the game. Include a valid e-mail address in
your feed.

<pubDate> tag

At the <channel> level, the <pubDate> tag indicates the last time the feed
was updated. It’s very important that you follow the correct convention when
adding this element — you can’t just put any old date in here.

Getting the <pubDate> (publication date) correct is terribly important, but
it’s often overlooked by podcasters in a hurry. Don’t fall into this trap. The
publication date is used by listing sites and directories as a way to show
fresh content. Don’t be stale; use the publication date, and make sure you do
it right:

<pubDate>Sat, 31 May 2008 12:02:28 -0800</pubDate>

The <pubDate> element must follow the RFC #822 guidelines (asg.web.
cmu.edu/rfc/rfc822.html), which are simply

[day of week], [day of month] [month] [year] [24 hour time] [time zone (GMT) ]
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Simple as that may be, you have to follow the correct naming convention for
each of those elements. Table 12-1 shows how.

Table 12-1 Proper <pubDate> Elements
Day of Week Month
Mon Jan
Tue Feb
Wed Mar
Thu Apr
Fri May
Sat Jun
Sun Jul
Aug
Sep
Oct
Nov
Dec

The day of the week is always expressed in double digits, adding a zero in
front of any single-digit numbers (for example, 03 instead of 3), and the year
is always expressed in four digits. (Well, at least it will be for the next 8,000
years or so, and then we’ll just have to do something different.)

The big stumbling block with <pubDate> tends to be the time and zone:

v Military time: The time should always be expressed in 24-hour or mili-
tary time, (HH:MM:SS). Again, add zeros in front if necessary (for exam-
ple, 03:07:02 is correct).

v Time zone: The time zone isn’t represented by everyday abbreviations
such as PST. Instead, it’s referenced from GMT, or Greenwich Mean
Time. (That’s a city in England where the International Date Line passes
through, not a small village on the east coast of the United States.)
Podcasters in California are in either -0800 or -0700 (that’s 8 or 7
hours earlier than GMT, respectively) depending on whether Daylight
Saving Time is in effect.

<P Don’t sweat the timestamp too hard. You should be changing the date every
time you put up a new episode, but even if you had to hard-code the timestamp
t012:00:00 -0800, you wouldn’t have a problem with it. Chances are, your
RSS 2.0 is generated automatically, so time stamping shouldn’t be an issue.
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<category> tag

Though the original drafters of RSS 2.0 had standards in mind, the <category>
tag has become pretty much a free-for-all. If your podcast has an industry-
recognized category, use that. If not, make it up! That’s what we did in our
example:

<category>Automotive</category>

<image> tag

This optional RSS tag provides a graphical representation of your podcast. It
actually contains several elements that further describe the image. They are

v URL: The location of your image (in GIF, JPEG, or PNG format) on a Web
server.

v Width: The width of your image, up to 144 pixels.
v Height: The height of your image, up to 400 pixels.

v~ Title: This text describes the image, but most people just describe their
podcast again, because that’s what the image should do anyhow.

v Link: The link to your Web site. Just because you needed to put that in
one more place. Can you say “overkill”?

All these elements, when used together, result in something very much like this:

<image>
<url>http://mypodcast.com/images/logos/TCCP100x86.jpg</url>
<width>100</width>
<height>86</height>
<title>The Car Collector Podcast</title>
<link>http://mypodcast.com</1link>

</image>

<copyright> tag

Here’s where you can list the copyright information about your podcast. It’s
free-form text, so be sure to include all the narrative necessary to get your
copyright information across. We use Creative Commons (more on that in
Chapter 4) to retain some rights to our podcasts, yet allow for some addi-
tional freedom that’s difficult with conventional “all rights reserved” notices.

<copyright>Creative Commons Attribution 2.5 License</copyright>

<language> tag

Although the file itself is written in the RSS 2.0 flavor of the RSS language, the
“human language” should also be declared. In our example, we’ve declared
that our podcast is in English:
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<language>en-us</language>

If your podcast is not in English, see http://blogs.law.harvard.edu/
tech/stories/storyReader$15 for the appropriate code to use in this
section.

<docs> tag

This is simply a link to the document that describes what RSS 2.0 is all about.
This entry is optional, but including it is considered good form. If you do use
it, just copy the URL in the example — it’s one of the most common. In the
unlikely event your feed is picked up by a developer who hasn’t adapted his
application to accept the RSS 2.0 standard, you’re being a good global citizen
and pointing him in the right direction. Think of this as the Rosetta Stone of
your podcast feed:

<docs>http://blogs.law.harvard.edu/tech/rss</docs>

<itunes:subtitle> tag

This is what iTunes uses to populate the Description column of its applica-
tion. It should be a collection of a few choice words about your podcast. We
recommend simply mirroring the <title> tag:

<itunes:subtitle>The best podcast on the planet. Period. With your host, me!</
itunes:subtitle>

<itunes:summary> tag

Apple says you have up to 4,000 words in this entry. This content is featured
prominently when your podcast is selected by someone interested in your
show. Sounds like a repeat of the <description> tag to us:

<itunes:summary>This podcast blows the doors off all other podcasts. Have a
listen and leave the others in the dust.</itunes:summary>

<itunes:owner> and <itunes:author> tags

On the surface, it may seem we’re repeating the same thing with <webMaster>
and <managingEditor> described earlier in this chapter . . . no, wait. This
is pretty much a repeat of that.

iTunes uses the <itunes:author> tag to power the Artist listing inside of
iTunes. <itunes:owner> doesn’t publicly display anywhere and is simply

a way to identify who is responsible for the feed in the event Apple needs to
contact the party responsible for the feed — such as technical issues, non-
compliance, directory listings, and so on. <itunes: owner> has two subtags:
<itunes:name> and <itunes:email>.
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Here’s how the two tags work together:

<itunes:owner>
<itunes:email>chuck@mypodcast.com</itunes:email>
<itunes:name>Chuck Tomasi</itunes:name>

</itunes:owner>

<itunes:author>Chuck Tomasi</itunes:author>

<itunes:category> tags

Pay close attention here because this is another area that gets fouled up
more times than we care to count. You can’t make this one up — it has to
follow Apple iTunes categories.

Look at the categories inside of iTunes and find out where your podcast
belongs before adding this tag. iTunes is a free download, and you have to
install it in order to see what categories you have to choose from. Get it at
www.apple.com/itunes.

Some categories have subcategories, and both are handled a bit differently
when it comes to tagging. If you find a subcategory you belong to, you have
to identify not only the subcategory, but also the parent category. For this
bogus feed we’ve built, we've selected a category/subcategory pair (Games
& Hobbies:Automotive/Automotive) as well as a category that has no subs
(Society & Culture:History) so you can see how each is coded:

<itunes:category text="Games & Hobbies:Automotive">
<itunes:category text="Automotive" />

</itunes:category>

<itunes:category text="Society & Culture:History" />

Notice how "Automotive" is nested between the beginning and ending
tags for "Games & Hobbies:Automotive".Because "Society &
Culture:History" has no subcategory associated with it, the tag has its
ending / at the end of a tag, itself, just as you see with "Automotive".

<itunes:link> tag

Continuing to do its own thing, Apple ignored the RSS <image> tag and came
up with its own to better match the album art already used within iTunes.

This tag is made up of several different declarations, all of which you must
follow if you want your artwork to show up inside of iTunes:

v rel="image": This tells iTunes that the link in question is really an
image file. It’s not the most intuitive thing in the world, but you work
with what you have.
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V¥ type="video/jpeg": With this tag, iTunes knows that the image is
a JPEG. Bet you didn’t know that JPEG was originally used as a video
format. Neither did we. If you decide to use the PNG format, you need
to change the statement to type="1image/png". Regardless of your
format, iTunes recommends images that are 600 x 600 pixels in size.

V» href="[URL of your image]":Thisis alink to the image.

1 Yet another title-like statement: Make it easy on yourself and just use the
name of your podcast.

When it’s all over with, you should have something that looks very much like
this:

<itunes:link rel="image" type="video/jpeg" href="http://mypodcast.com/images/
logos/TCCP300x300.jpg">The Car Collector Podcast</itunes:link>

<itunes:explicit> tag

Apple has a kid-friendly reputation to uphold. And because it already has
a huge 20-million-plus subscriber base, it doesn’t want to allow any unsa-
vory podcasts to fall into the younger hands. Already having developed
the EXPLICIT tag for songs designed for mature audiences, Apple simply
extended that tag to the podcasting world.

Three possible values exist for this tag: yes, no, and clean. If you drop
the F-bomb on your show, fess up and put a yes value in this tag. If you use
language like you would with your friends, but it’s still safe enough for your
mom, go ahead and use no. If you're so squeaky clean that people could eat
off your podcasting rig, you still include the tag, but your value is clean.

<itunes:explicit>no</itunes:explicit>

Stating that your podcast uses explicit language excludes anyone under 18
years old from downloading your podcast, but we wouldn’t want our kids
using the same computer as we did for that type of podcast.

Incorrectly marking your tag with no, or clean, when in fact you drop an
F-bomb or other bad language could get you rejected or removed from the
iTunes directory listing.

Loading up on <item>s

Now that the channel has been defined, it’s time to talk about the individual
items contained within the channel. An item is (in this case) an individual
podcast episode. If you have three shows available for download on your
Web site, you have three distinct <item> declarations in your file.
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Chapter 10 sums up the pros and cons of making all your shows available. If
you have the server space and the bandwidth to handle it, go right ahead. If
not, include only the most recent podcasts in your feed. You can control that
with the items you include in your RSS 2.0 feed.
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True to form, each of your podcast episodes starts off with the item declaration:
<item>.

<title> tag

Much like your channel, each item element also has a title. In this case, it’s
the title of the episode:

<title>TCCP 013 - Experienced restorer, a peek at a Mustang, and driving a true
classic.</title>

Some podcasters prefer to put in some recurring text to identify their pod-
cast (in this case, TCCP); others choose not to. It really is a matter of choice.

<P After you decide on a naming convention for your podcast episodes, try
to stick with it. Listeners grow comfortable with seeing your show display
on their MP3 players or computer folders in a certain way. If you randomly
change how you name your episodes, your audience may no longer recognize
the files as yours. Although there’s no rule against changing, you might want
to warn your audience before you do so.

<link> tag

Earlier in the chapter, we showed you how to provide a link to your main
podcast Web site. Here you're providing a link to the specific page where lis-
teners can find your show notes and other information about this particular
episode:

<link>http://www.mypodcast.com/tccp013.html</1link>

<comments> tag

If you collect and display comments from your listeners on particular epi-
sodes of your podcast, provide a link to that specific page. For many, the
<comment> URL is the same as the <1ink> tag. In our example, it’s slightly
different:

<comments>http://www.mypodcast.com/tccpl3.html#comments</comments>

<description> tag

The <description> tag works the same way in the <item> statement as it
does in the <channel> statement. It’s used to provide detailed information
about the episode. This is the place for a teaser of what’s in your podcast —
bigger than the title, but smaller than the full show notes:
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<description>Synopsis: Steel Headers is the company that made this trip possible.
Can't recommend them highly enough. Thanks to Dave Wishfield from
San Jose, CA for talking to me about his 1965 Ford Mustang. Listen
and find out how much he got at the auction! Special thanks to
Aiden Somerset from Sun Prairie, WI for allowing me the privilege
to drive the 1957 Chevy Belair. What a ride! Download The Car
Collector Podcast Episode #13</description>

<quid> element

GUID stands for global unique identifier. Well, okay, global may not be the best
word here, but that’s what it is; don’t worry — you don’t have to pick something
that’s one-of-a-kind-in-the-entire-universe. But you should pick something that
makes this entry unique to your RSS file. Here’s an example:

<guid isPermaLink="false">1808@http://www.mypodcast.com/</guid>

In this example, a sequential, non-repeating number is added to the beginning of
the URL of the Web site. Each time a new <item> goes in the file, the number
is incremented by one. This helps the podcatching clients figure out whether
a file is new. If a podcatching client has already seen the GUID for this particular

podcast, it doesn’t download the file. If it has never seen the GUID associated
with this podcast, it downloads the show.

You can generate a GUID lots of ways. In reality, most people use a program to
help generate the RSS file, and the GUID is automatically taken care of. In the
event that it isn’t, you can just use the URL of the podcast media file for this
episode, assuming you use a good filenaming convention and you don’t plan
on repeating the filename anytime in the future.

<pubDate> tag

This tag shows when the podcast episode was published. Just like in the
<channel> statement, make sure you follow the right convention. Assuming
you have more than one <item> in your feed, each item has its own <pubDate>.

<pubDate>Sat, 31 May 2008 12:02:28 -0800</pubDate>

<author> tag

This is simply the e-mail address of the person who created the content. For
most podcasters, this is the same in each <item> in the feed. But if you're
making a compilation where you repurpose content created by others, you
may want to put their e-mail address in here. The choice is yours:

<author>editor@mypodcast.com</author>
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<enclosure> element

Chapter 3 provides a brief rundown of how the <enclosure> element makes
podcasting possible — but now (finally) we come to that sacred piece of code.
We hope you're not too disappointed when you see how simple it is:

<enclosure url="http://mypodcast.com/media/TCCP013_20080531.mp3"
length="24849394" type="audio/mpeg" />

Hardly seems worth the fuss, does it? Believe it or not, this is the main line
that makes your podcasts automatically download to your listeners’ desk-
tops and MP3 players. The enclosure tag contains three elements:

v url: Alink to the podcast media file.

v length: The length of the file. In this case, 1ength is synonymous with
file size, expressed in bytes.

v type: The standard MIME type of the media file referenced in the link.
Podcasting works with a variety of media types. This example is for
audio files saved in MP3 format. You can enclose video files (and even
BitTorrent files), but to do that successfully, first determine the appro-
priate MIME type for your preferred media file. A full list of MIME types
is available at www. iana.org/assignments/media-types. Rather
than make you wade through all that, we’ll let you know that most audio
files are either audio/mpeg (for MP3 files) or audio/m4a (for Apple’s
AAC format used in enhanced podcasts). Video files have a few different
formats to choose from. Depending on how the file is encoded, you’ll
want to look it up on the IANA site.

<content:encoded> tag

Earlier we show you how to put a synopsis in your feed by using the
<description> tag; this is just straight text, without any images, for-
matting, or hyperlinks. The best way to include these extras is to use the
<content:encoded> tag.

You want a good-quality synopsis on your Web site and in your RSS feed —
complete with URLs that lead to the various Web sites. So it’s time to do
something special (okay, sneaky) to avoid breaking any XML laws.

XML is pretty picky about which characters are allowed and which ones aren’t.
After all, a good synopsis is written to be read by a human being, not an XML
program — and human language just has a lot more stuff in it. If (for example)
you want to put in quotes, ampersands, apostrophes, and other characters
that are considered illegal inside XML, you have to use a Get Out of Jail Free
card in the form of this statement:
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<! [CDATA[]]>

The <! [CDATA[]]> statement informs the XML reader that the contents
contained within the [ ] symbols are nof XML and should not be treated as
such. Some older XML readers just skip such content altogether. But every
RSS and XML reader we’ve seen switches over to HTML mode and displays
the information properly — links, images, and all. As it should be.

So if you really want your description to read ““There’s trouble & danger
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ahead,’ said the Cap’n” — quirky, isn’t it? — you have two options:
XML-Encoded

<description>&quot ; &apos;There&apos;s trouble &amp; danger ahead&quot;, said the
Cap&apos;n&quot ; </description>

Using CDATA

<content:encoded><! [CDATA[" 'There's trouble & danger ahead', said the
Cap'n"]]></content:encoded>

Now, which way are you going to choose? Both approaches give you the
same results. One probably gives you a headache.

You can go about escaping or encoding illegal characters inside your XML in other
ways. You can find more information about that in Syndicating Web Sites with
RSS Feeds For Dummies, or at www.w3schools.com/xml/xml_encoding.asp.

For now, it’s easier to tell the XML reader to lighten up and deal with the text
as is.

<itunes:author> tag

You guessed it — yet another iTunes tag that looks amazingly like a stan-
dard RSS 2.0 tag. Hey, we didn’t write the spec. We're just telling you how
to implement it. In fact, iTunes will use the standard author tag if the
itunes:author is missing.

<itunes:author>Chuck Tomasi</itunes:author>

<itunes:subtitle> and <itunes:summary> tags

The same rules apply here as did in the <channel> section. In this case, you're
describing a single episode of your show in both short and long versions,
respectively.
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<itunes:subtitle>My recent trip to LA's antique car auction, plus my
adventures.</itunes:subtitle>

<itunes:summary>Synopsis: Steel Headers is the company that made this trip
possible. Can't recommend them highly enough. Thanks to Dave
Wishfield from San Jose, CA for talking to me about his 1965
Ford Mustang. Listen and find out how much he got at the auction!
Special thanks to Aiden Somerset from Sun Prairie, WI for allowing
me the privilege to drive the 1957 Chevy Belair. What a ride!
Download The Car Collector Podcast Episode #13</itunes:summary>

<itunes:category> tags

Just as with the <channel> section (see the earlier section “<itunes:category>
tags”), it’s important to get this right. Use the categories iTunes has available,
not just any categories. Oddly, we've learned that episode-specific catego-
ries (those within the <item> and </1item> tags) aren’t used for anything in
iTunes — yet. We include them here to be good podcast citizens.

<itunes:category text="Games & Hobbies:Automotive">
<itunes:category text="Automotive" />

</itunes:category>

<itunes:category text="Society & Culture:History" />

<itunes:duration> tag

Finally — something brand new with an iTunes-specific tag! Remember that
iTunes was originally a music-distribution system. As such, the length of a
particular song displays next to the title. Podcasters too are asked to provide
this information. It follows the HH:MM: SS format.

If you use software to help build your file, you may not be able to figure out
the exact duration of your individual podcasts. iTunes has no way to verify
this data, so you can just hard-code a ballpark figure of your average podcast
length.

<itunes:duration>00:45:00</itunes:duration>

<itunes:explicit> tag

Here’s an implementation from iTunes that makes a lot of sense. If your pod-
cast normally doesn’t include any questionable language or subject matter,
go ahead and mark the channel with an explicit tag of no. However, if a
particular episode does get a little on the raunchy side, you can use this tag
inside a particular <item> and </item> pair to mark just the single episode.

Even if you know all your podcasts episodes follow the same explicit label set
forth in the <channel>, you still need to include it here:

<itunes:explicit>no</itunes:explicit>
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<itunes:keywords> tag

One would think this tag helps people searching in iTunes find your podcast,
but in reality, iTunes gets most of that information from the title, description,
and summary information. Apple recommends minimizing the use of the key-
words tag and using it for things like common misspellings of your name or
show. To prevent keyword abuse, Apple only indexes the first 12 keywords in
this tag.

Separate keywords by commas and add in as many as you see fit:

<itunes:keywords>tomassi, thomasi</itunes:keywords>

Wrapping things up

As with any other markup language (and as indicated earlier in this chapter),
you have to close those declaration tags. The closing tag looks like this:

</item>

This tag tells the podcatching client that the end of the episode has been
reached. After you close your <item> tag, you can immediately add a
second, and a third, and so on. There is no limit to the number of <i tems>
you can have inside your RSS feed.

After you add all the episodes inside their own <item> </item> statement,
it’s time to finish the file:

</channel>
</rss>

These two lines of text bring to a close your <channel> declaration and
mark the end of the RSS 2.0 file itself.

You should have no further text after these two statements. This really is the end
of your file. If you have extra text hanging around after you close your </rss>
tag, delete it. Or better yet, figure out where you wanted to put it in one of the

elements — and put it there.

Tweaking the Contents

The main function of your RSS 2.0 file is to distribute your media files to the
various people who have subscribed to your feed. However, it’s a smart
podcaster who recognizes that a well-formed RSS feed can be employed for a
wider range of needs.
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Adding keywords and tags

Although all the elements of a well-formed RSS 2.0 file are important, it’s
the <title> and the <description> content that are the most useful
for listeners — be they current or potential. As a podcaster, it’s your job
to create descriptions and titles that are both relevant to your content and
intriguing to your listening audience.

As discussed in Chapter 11, keywords are important. Rather than making
stuff up again, this time we use real-world examples to illustrate the point. One
of your humble authors hosts several podcasts. One of the shows features
topics about tech, science, sci-fi, and other nerdy subjects. Another show
deals exclusively with a popular online mail application; yet another is really
more about . . . well, whatever fits the podcaster’s mood.

Understanding that each of these shows appeals to a completely different
audience, the podcaster employs very different strategies when providing
information about these shows. But as different as these strategies are, they
follow a similar theme: Tell listeners what they want to hear.

No, we're not suggesting you lie or stretch the truth about the content of your
podcasts. Instead, practice thinking like a listener. What do you think listeners
want to hear? Then consider why you did this episode in the first place: Who
would be interested in listening, and why? After you figure all that out, it’s
time to start writing descriptive keywords and adding them to your <title>
and <description> declarations.

Whether or not you heard it here first, the ability to change the contents of
your RSS file is critical to your success as a podcaster. Before you select a
hosting company or blogging software that manages your RSS 2.0 file for you,
ask some important questions about modifying that file. (By and large, we’d
say take a pass on companies that don’t allow do-it-yourself changes to your
RSS 2.0 file or template.)

Making newcomers feel welcome

Think back to when you were a new podcast listener or, perhaps, consider
the last time you added a podcast to your podcatching client. Did you know
what you were getting yourself into? Perhaps someone recommended the
show to you, and you already had a feel for what it was you could expect. But
maybe not.

For a lot of new people just starting out as podcast listeners, there is a large
gulf of uncertainty and concern they have to get over before subscribing to
a new podcast. By subscribing to your feed, a listener is putting a significant
amount of trust in you, the podcaster. Don’t forget that podcasting means
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your subscribers automatically receive any and all podcast media files you
make available, regardless of what’s in them or how big they are.

How large will these files be? How often will they be coming down? What can
I expect out of the content? Can I listen in front of my kids? Will the file size
overload my hard drive?

These and a slew of other questions invade the mind of every person thinking
about taking the plunge and subscribing to your podcast. And these concerns
stay on the minds of those who bit the bullet and subscribed for at least the
first few weeks. Your job, then, is to find ways to make those listeners feel
comfortable so they keep listening. Stay tuned (as it were). . ..

You have two options to address these concerns:

+* Place a short audio file or block of HTML on your Web site: Describe
what the show is, the run time, and how often you expect to offer a new
show. This is commonly referred to as “episode 0” and released as the
first show in the feed.

1 Address these same items as part of your show: “Listen every week for
an exciting hour of outdoor news, product reviews, and discussion from
the man who’s been in the business for over 30 years.” Within 10 seconds,
the listener knows exactly what to expect.

If you find your listeners still have questions, try to provide answers.
Sometimes this comes in the form of e-mail, sometimes blog or forum replies,
or adapt your show description content mentioned earlier. If you want to be
a little more proactive, you could also set up an FAQ (frequently asked ques-
tions) page for Web visitors to read and review.

Make your RSS feed easy to find

Podcast still has a “geek factor” to it. As a result of that, you're going to have
to do whatever you can to make it easy for people to find, and subscribe to,
your show.

If you want to convert casual listeners in to loyal subscribers, make it as easy
for them to subscribe to your show as possible. A little link in an obscure
place on your Web page just isn’t going to do the job. Remember, podcasting
is as much about marketing you and your podcast as it is about the technical
details. iTunes and Zune now offer a way to put an icon/link on your Web site
so that people can subscribe with a single click — once your podcast is listed
in those directories. Now that’s simple!



Make it easy to listen

One strategy used by many podcasters is to
have an audio player on the site. You can do
this in a variety of ways — plug-ins to your blog
software or Flash players. These players allow
people to listen to your material without the
bother of a podcatching client. For some pod-
casters, it's difficult to comprehend that despite
the fact that they've spent a lot of time setting

up an RSS feed, a fair percentage of listeners
are still listening straight from the Web site.
Don't be like those podcasters: Make it easy for
listeners to click and listen. One popular way is
to use the PodPress (www.podpress . org)
plug-in to WordPress. Adding the podcast file
is trivial and includes a Flash player for each
episode.
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To add a link on your Web site, follow these steps:

1. Search for your podcast in the iTunes Store or in Zune.

2. When you have the screen with just your show’s details displayed,
right-click your podcast icon and choose Copy.

What you’re copying looks kind of like this:
zune: //subscribe/?MyPodcast=http://mysite.com/myfeed.xml
3. Paste your show’s URL i.nto the HTML for your Web site.

Now, you've given listeners a simple way to find your show.

<P You can make a one-click subscription for iTunes listeners by changing your
URL slightly. After copying and pasting the URL, change the http to itpc.
Now when someone clicks the link, instead of being taken to your podcast
listing in the iTunes Music Store, your podcast will automatically be added to
their iTunes podcast list.

N For most other software packages besides iTunes or Zune, a standard RSS

badge with a link to your feed works well, but you rely on the user to copy the

URL manually in to a podcatching client.

Multiple-Show File Strategies

You may just catch the podcasting bug hard. It’s so easy to create a podcast
that you’ll want to do more. Soon you may find yourself doing three shows a
week, each with slightly different content and topics, each appealing to a
different audience.
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One possible situation might be that you have diverging content — you begin
to hear from your listeners that Monday’s show is right up their alley, but
Wednesday’s coverage of different material isn’t their cup of tea. You get plenty
of e-mail and voice mail with the opposite viewpoint, and a good many listeners
say they love everything you’re doing.

Another situation might be to offer special content. Give the listener some-
thing above and beyond your regular content for those die-hard loyal fans
who are willing to contribute a little information such as demographics or
e-mail address for your members-only newsletter list.

How can you make all these people happy? Simple. Multiple feeds.

Manager Tools (http://manager-tools.com) is one example of a podcast
with multiple feeds. Its primary feed of useful management advice is avail-
able to the public without obligation. It also offer a “members only” feed with
a monthly extra. To receive this separate feed, the subscriber needs to give
his or her e-mail address — that’s it. In addition to the members-only audio
content, the subscriber also gets a regular newsletter, pre-announcements to
conferences, and other items. Manager Tools also has something called “pre-
mium content,” which is available for an annual fee.

When you’ve figured out how to customize your feed, it should be easy to
break out a second (or third) feed, isolating the content as appropriate.
You need to check the documentation of your blogging software or RSS-
generation tool to see what steps are necessary.
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In this part . . .

hen you’ve finally managed to put your show “out

there,” you may find it’s a cold, dark place. You
need a beacon on your podcast that tells everyone you're
here — and what your show is all about. In this part, you
find the tips and tricks successful podcasters use to
attract a wider audience. Additionally, you find ways to
communicate better with your fans (yes, fans!) and keep
your show fresh.




Chapter 13
Speaking Directly to Your Peeps

In This Chapter

Encouraging listener feedback

Starting a discussion group online
Finding conversations on the Web
Handling listener feedback

‘ ommunication can be defined in a multitude of overly complex ways.
For the sake of argument (and not to copy each and every dictionary
entry we can find), we define the term as

The exchange of information between two points.

Note that last part — between two points. To us, this implies a bi-directional
flow of information, to and from both parties.

If you've had the pleasure (note how well we can say that with a straight face)
of attending any productivity or team-building seminars, the presenters really
drive the message home: Effective communication is not a one-way street.

Over the past few years, podcasting has evolved as a more effective com-
munication than traditional media (such as radio or television). We all have
same tools to communicate at our disposal — e-mail, Web sites, phone lines —
so why do podcast listeners seem to get more involved with podcasting? Two
simple reasons

v There seems to be a closer bond between podcast listener and podcast
producer. The simple fact that anyone can do this makes the producer
seem more like a real person than a personality and easier to relate to.

v The podcasters are asking for the feedback — and getting it. Audience
size doesn’t matter. We’ve seen some instances of shows with a couple
hundred loyal followers where the podcaster has to spin off a second
show just to handle the listener feedback. When was the last time you
heard of a “listener feedback show” for American Idol?
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In this chapter, we show you some real-world examples of how to foster com-
munication between you and your audience, touching on a variety of meth-
ods and venues you probably haven’t considered.

Gathering Listener Feedback

It must be a natural human reaction to fear the opinions of others. Perhaps
it’s insecurity, but we think it has more to do with our culture’s constant rein-
forcement of the “How are you?” — “I'm fine. You?” — “Fine.” meaningless
chatter that precedes most of our conversations.

That cultural crutch, however, is left next to Tiny Tim’s seat when it comes
to podcasting. Listeners, for whatever reason, are compelled to actually give
real and meaningful criticism. And podcasters, for the most part, take to
heart those responses.

Of course, we're speaking in general terms. Yes, there are flamers and jerks
out there with less than helpful answers at the ready. Podcasting can’t
change basic human nature for the ill-evolved, unfortunately.

You can foster good communication with your listening audience in a multi-
tude of ways, such as

v Allowing and responding to comments on your blog

v Creating and visiting online discussion groups and forums

1 Responding to listener e-mail

v Exploring online social networks

1 Leveraging voice mail

All of these avenues are discussed in detail in the sections that follow.

Fostering Comments on VYour Blog

In an ideal world, all communication, feedback, rants, and raves about your
show would take place in a neat little box, keeping things nice and tidy for
you. But because that won’t happen, your best bet is to build a Web site that
both enables and encourages the communication in your own backyard.



Chapter 13 Speaking Directly to Your Peeps 235

In Chapters 11 and 12, we demonstrate how much simpler adding show notes
and generating RSS files are for those podcasters who use blogging software,
rather than those who try to do everything by hand. Wel